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Foreword 

This manual describes Process Engineer operation and basic functions you 
need to be familiar with when dealing with Automatic Line Balancing module. 
Automatic Line Balancing has been developed in a cooperation of Daimler 
Chrysler AG Sindelfingen (PP/DPP) and DELMIA GmbH Fellbach. 

While developing these functions we have made every effort to create a clearly 
organized, easy-to-understand program structure. 

A user-friendly interface as well as a clear menu guide will enable you to 
quickly learn how to operate the program and to get familiar with its functions 
so that you can carry out your planning tasks in a quick and reliable way.  

 

No Liability or Guarantee 
Our programs and manuals have been compiled with great care and to the 
best of our knowledge. They have also been tested in a production setting. 
However, we assume no liability and provide no guarantee that the software 
and related descriptions are free of error or are suitable for special purposes. 

DELMIA assumes no liability for any damage that may arise from the use of 
this software. By using this software, the user acknowledges this exclusion 
from liability and shall hold DELMIA exempt from all claims. 

 

Copyright 
The information in our documents may be copied and distributed for internal 
purposes provided it is done free of charge and the contents are not altered or 
distorted. 

Any other form of usage, especially the sale on CD-ROM or in any other 
publication in whole or in part is only permitted after prior written consent by 
DELMIA. 

Some parts of this software are owned by Unigraphics Solutions Inc. and are 
copyrighted © 2011. All rights reserved. 

Some parts of this software are owned by combit® GmbH and are 
copyrighted. Report-/Print module List and Label® Version 15.0: Copyright 
combit® GmbH 1991-2011. 

 

Modifications 
Moreover, DELMIA retains the right to make modifications and improvements 
to the product described in this manual at any time without prior notification. 

DELMIA and the 3DS logo are registered trademarks of Dassault Systèmes or 
its subsidiaries, in the United States or other countries.  

This clause applies to all acquisitions of DASSAULT SYSTÈMES commercial 
computer software by or for the United States federal government, or by any 
prime contractor or subcontractor (at any tier) under any contract, grant, 
cooperative agreement, or other activity with the federal government.  By 
accepting delivery of this software, the United States government hereby 
agrees that this software qualifies as “commercial” computer software within 
the meaning of the acquisition regulation(s) applicable to this procurement.  
The terms and conditions of the DASSAULT SYSTÈMES standard commercial 
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end user license agreement shall pertain to the United States government‟s 
use and disclosure of this software, and shall supersede any conflicting 
contractual terms and conditions.  If the DASSAULT SYSTÈMES standard 
commercial license fails to meet the United States government‟s needs or is 
inconsistent in any respect with United States Federal law, the United States 
government agrees to return this software, unused, to DASSAULT 
SYSTÈMES.  The following additional statement applies only to acquisitions 
governed by DFARS Subpart 227.4 (October 1988):  “Restricted Rights – use, 
duplication, and disclosure by the Government is subject to restrictions as set 
forth in subparagraph (c)(l)(ii) of the Rights in Technical Data and Computer 
Software clause at DFARS 252-227-7013 (Oct. 1988).” 

© 2001-2011 Dassault Systèmes - All Rights Reserved 
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1. Introduction 

The Automatic Line Balancing (ALB) manual explains how to use Process 
Engineer Automatic Line Balancing for your planning purposes. 

The Automatic Line Balancing program module is used for assembly planning. 
Use this program module to specify the number of work positions included in a 
station and the number of stations that are available for assembly of particular 
product variants. 

1.1 How to Use this Manual 

This manual enables you to get familiar with the operation and functions of 
Automatic Line Balancing. This manual briefly describes: 

 Automatic Line Balancing views 

 Main menus 

 Program start 

 Use of the menu functions 

Note 

When handling the basic Automatic Line Balancing functions, please 
remember that there is a general introduction to the Process Engineer in the 
Basic Manual. 

 

Click General Introduction to access the manual. 

1.2 Documentation Conventions and Symbols 

The symbols used in this manual are intended to provide you with keys to the 
contents in an immediately understandable manner. 

This symbol is used to introduce key concepts that are covered in the sections 
immediately following this symbol. As a result, this symbol most frequently 
appears at the beginning of chapters or sections. 

Note 

This symbol is used to mark notes, which provide you with additional 
information you need to have for further work. You will either find the Note sign 
at the beginning of a chapter or in a particular text passage in the chapter. 
Texts bearing this sign are additionally marked with Note. The text is always in 
italics. 

Caution 

This symbol indicates that the text that follows describes particular 
circumstances that you must avoid to avoid potential errors with the operation 
of the program or harm to data. You will either find the Caution sign at the 
beginning of a chapter or near a particular text passage in the chapter. Texts 
that are introduced by this sign are additionally marked with Caution. The text 
is always in italics. 

file:///C:/Documents%20and%20Settings/OUM/Application%20Data/Microsoft/Word/GeneralIntroduction.pdf
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This symbol marks examples which serve to illustrate a certain situation. 

This symbol marks the individual operational steps involved in a particular 
operating instruction. Operating instructions describe operational steps, for 
example, how to open a menu or execute a function. 

This symbol marks listed subjects. The symbol for listed subjects can be either 
used to structure a continuous text or to list main subject keywords. 

This symbol marks list inside a bulleted or numbered list.  

This symbol marks cross reference information that is available in another 
manual. 

1.3 New Functions in Automatic Line Balancing 

Moving an Operation having Process Assembly Process Link 

It is not possible to move an operation having the Process Assembly 
Process link. A warning message appears if an assembly operation having 

this relation is moved. 

Reusing the Existing Balancing 

Reuse the existing balancing and save that as a new line for a different 
product variant or for a different TAKT time. 

Adding or Deleting Station 

You can add or delete a station in the line by giving confirmation in the dialog 
box. 

Open ALB in Read-only Mode 

ALB can be opened in Read only mode or No access mode depending on the 
Function and Data rights. 

Displaying Product Variants in Balancing List View and Process List View 

The Balancing List View and Process List View are enhanced to display: 

 one column for each product variant at the end.  

 Active column for Active variant. 

 X against each process of active variant in column for Active product 
variant. 

 X against each process of inactive product variant which is identical to the 
one in active product variant in corresponding column for inactive product 
variant. 

Displaying Maximum Car Time in Balancing List and Process List 

The Balancing List View and Process List View are enhanced to display the 

maximum car time for all processes. 

Displaying Line in Part Bin Group Visualization 

Additional lines or grids are added in the visualization of part bin group for all 
single part bins of the part bin group. This helps to view the number of part 
bins in that part bin group. 

 

  
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2. Overview 

The division of labor order principle was already known to Taylor. The 
production of a high number of different product variants requires clear and 
well-coordinated production sequences to yield optimal results. 

The continuous flow production principle, which is primarily used in final 
assembly of standard products, is one of the classic organization principles of 
industrial production. Production has virtually undergone a change in the last 
decades. For example, the product manufacture technique has constantly 
been improved and the degree of automation has been increased. As a result, 
the production conditions have crucially been changed. 

Moreover, customer behavior has fundamentally changed. Thus, during the 
planning of each new strategy, companies must constantly bear in mind the 
ever increasing number customer demands. Companies from the automobile 
industry, for example, produce several thousand different vehicle types that 
can vary with regards to their technical construction and their equipment 
features. Hence, the workload of each production line or station has to be well-
planned. The production systems also have to be designed so that they can be 
used in a flexible way to meet the changing demands resulting from sudden 
changes. Consequently, high demands are made on the product range even 
during the planning phase. 

New Concepts for the Production Process 
New concepts have been increasingly developed for this production process to 
meet these demands. Precisely balanced flow production processes have 
continually gained importance for production process planning and the 
demands made on production plans have increased. Manually performed 
planning cannot sufficiently meet these complex and varied requirements. 
Therefore, these manual planning methods will gradually be replaced by IT 
systems. 

Automatic Line Balancing used to balance operation times of assembly lines 
fulfils these current requirements of IT based planning systems. Assembly 
systems used for manufacturing can thus react quickly towards changes in 
production quantities by adjusting the production process to the current 
situation without a great loss of time. 

Individual computer-aided processes are based on the Operations Research 
methods thereby significantly enhancing the quality and the continuity of 
planning. There has been a constant increase in computer performance 
leading to a distinct decrease in the time required for planning. Automatic Line 
Balancing thus makes planning of assembly more efficient and flexible.  

ALB Application Areas 
Automatic Line Balancing is a procedure aiming at the interactive automatic 
balancing of manual assembly lines. You can use ALB for: 

 Optimization and efficiency of manual assembly lines. 

 Interactive and graphical balancing. 

 Selection, distribution, and arrangement of operational steps. 

 Spatial arrangement of materials along the assembly line. 

 Storage and documentation of the planning results. 
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 Yielding Planning Results: Optimized efficiency of the assembly line 

according to the following criteria: 

 Conditions of sequence 

 Takt times 

 Conditions of assignment 

 Conditions of position 

 Area restrictions 

 Comparing with Planning Alternative 

 Station assignment 

 Identification numbers (number of colleagues, number of stations, average 
balancing compensation, average station times, and maximum station 
times) 

 Quick and quality-increased assembly planning 

2.1 Computer-Assisted Automatic Balancing Procedures  

The computer-assisted automatic balancing procedures can be divided into 
four main aspects. Please refer to the Figure 1. 

 

Figure 1: Program Structure  

Assembly Data: The assembly data are entered in the PPR Navigator when 
generating the resource structure. The assembly data entry fields of the 
Process Engineer are specified by attributes. The Process Graph provides the 
balancing process with the processes used in Automatic Line Balancing. A 
Process Graph is generated in the PPR Navigator process structure. 
Automatic Balancing: Automatic Balancing in Automatic Line Balancing will 
be executed according to a priority procedure. In addition, there are evaluation 
functions for automatic balancing. 
Material Supply: After finishing the balancing process, you can arrange the 
carriers/bins individually in the material supply area and change the filling 
interval as well as the dimensions of the material supply area.  
Manual Optimization: You can edit an existing balancing process manually. 
You can move processes and assign them to another station. Error messages 
will indicate restriction violations that might occur during the manual editing of 
a balancing process. 
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3. Getting Started 

3.1 Opening Automatic Line Balancing 

Open the Automatic Line Balancing in the resource structure on the 
corresponding hierarchical level – conveyor. 

 

Figure 2: Opening Automatic Line Balancing 

To Open Automatic Line Balancing 

1) Open the PPR Navigator resource structure until you reach the conveyor 
hierarchy. 

2)  Right-click and select Balancing > Open Automatic Line Balancing. 

Please refer to the Figure 2. 
The following ALB dialog box appears. 
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Figure 3: Automatic Line Balancing Display – Including Menu and Tool Bar 

Automatic Line Balancing dialog box includes the following. 

 (1) Menu bar. Please refer to the Figure 6. 

 (2) Tool bar. Please refer to the Figure 8. 

 (3) Work area. Please refer to the Figure 61. 

 (4) Status bar  

 (5) Material supply area. Please refer to the Figure 147. 

3.2 Open ALB in Read Only Mode 

ALB supports both function rights and data rights. Data rights can be set in 
DPE on the line component. Two new function rights are added in E5 client for 
open and save of ALB and using them ALB can be opened in read only mode 
or full access mode. If ALB is opened in read only mode, Save and Save as 

commands remain disabled inside ALB and balancing cannot be saved. An 
error message appears during opening of ALB if:  

 When the function right Open under ALB is deactivated or data right on 
line is No Access. 
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 When the function right Open is only activated or the permission on line is 
set to Read and Read & Execute.  

Note 
By default, 

 for R20 and previous releases all users were able to open and save the 
modifications in ALB. Starting with R21, the support of user rights in ALB 
changes this default behavior. 

 function rights are not activated and data rights on line component are in 
No Access mode. Administrator must set the proper function rights and 
data rights for all users before they start using ALB. An error message 
appears if ALB is opened without setting the proper function and data 
rights. 

To Activate Function Rights 

1) Go to Tools > Database Utilities > User Manager. 
The User Management dialog box appears. 

2) Select User > New User or New Group. 

3) Enter Login name, password and click Rights. 

4) Select automatic line balancing, open, and save checkboxes to activate 

the ALB function rights. 

 

Figure 4: ALB Function Rights 

Activate data Rights 

1) Right-click Resource Component (Line) and select Permissions. 

2) Select the user from the list or add the user to the Data Object 
Permissions dialog box and click Show / set right value to give or edit 

the rights. 

Data rights on the Line can be one of the following options as shown below. 
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Figure 5: Access Rights 

The data rights given on the Line component are only considered and the 
rights given on the children of lines and relations are not considered. 

For a “Read Only” Access data rights, the minimal setting required in Access 
Rights dialog box is Read & Execute, when the ALB function rights Open and 
Save are given full rights.  
For a “Full Access” data rights, the minimal setting required in the Access 
Rights dialog box is Change, when the ALB function rights Open and Save 

are given full rights. 

It is recommended to restart the DPE, when there is a change in the ALB 
function rights or in data rights. 
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4. ALB Interface Description 

All main menus and their corresponding editing functions for the balancing are 
arranged in the Automatic Line Balancing menu bar. You are already familiar 
with the View menu. You will be provided with an overview of further main 

menus in the following section: 

 

Figure 6: Automatic Line Balancing Menu Bar 

Opening Menu Function 

1) Select menu name (project, edit, view...) in the menu bar. The 
corresponding menu with its functions is opened. 

2) Click menu function to open it. Either a dialog or a list will then be opened 
depending on the menu function enabled. 

3) Additional menu functions are provided in an extra menu. These menu 
functions are marked by an arrow. 

4) Use the left mouse button to open the additional menu functions. (Please 
refer to the Figure 7). 

 

Figure 7: Example of a Function with Additional Functions 

4.1  ALB Tool Bar 

If you use the buttons and icons in the tool bar, you will quickly be provided 
with information needed for the work in Automatic Line Balancing.  

 

Figure 8: Toolbar in Automatic Line Balancing 

  Save: Save processes in Automatic Line Balancing. 

 Reload Processes: Update processes without closing the ALB. After 
starting the Process reload, the changed process data is displayed in the 
Reload Processes dialog box. Only changed process data is recognized 

during loading. Any changes with products and parts bins or relations between 
processes, products and parts bins are not recognized during reloading with 
the Reload processes option. 
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Figure 9: Reload Processes Dialog 

The following changes are recognized during the reloading of processes: 

 Changes in the properties dialog of a process, such as changed process 
time or description. 

 New and deleted processes. 

 Changes in the relationship between processes – Please refer to the 
Figure 216. 

  Finder: Quickly search for processes. 

  Representing Process Length and Body Point:  These 

buttons offer several selection options. Please refer to the Displaying 
Process Length and Process Color: Displaying Work Areas. 

  Selection List: The selection list provides 
several representation options for the Automatic Balancing view. Please 
refer to the Balancing View. 

 Individual: Display individual size representation of Balancing 

 

Figure 10: Individual Size Representation of Balancing 

Use the arrow keys in Size Representation of Balancing dialog to set the 

size of the Automatic Balancing view. You cannot enter percentage directly in 
the field. 

 With Material Area: Display Balancing view with material area.  

 Without Material Area: Display Balancing view without material area. 
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 Whole width: 

 All: Display all stations of a balancing process with the material supply 

areas. 

  Display Process Duration 

Use this selection list to set the process duration display in minutes or 
percentages. The display of percentages shows the process duration in 
relation to the takt time. 

 

Figure 11: Process Duration Displayed in Percentages 
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5. ALB Menu Bar Description 

5.1 Project Menu 

Use the Project main menu to finish Automatic Line Balancing and to save 
data. Use the Save as menu function to save a balancing process as a new 
name. Use the Save as function to generate a complete saving of a balancing 

process. 

  

Figure 12: Project Main Menu 

Save as Menu Function 
Use the Save As menu function to save a balancing process under a new 

name. This generates a copy of the balancing process which can be further 
edited independently. In version PE 5.13 you can select whether the process 
graph should be stored along with it. All generated balancing processes are 
displayed in a dialog. 

1) In the menu select Save As... Type in a new name in the field Name. 

2) Click Copy Process Graph when Saving field if you want to save the 

process graph. You can edit this process graph independently. There are 
no longer any dependencies on the initial process graph. 

3) Click OK. The balancing process and all of the corresponding data will be 
saved as a new name. 

 

Figure 13: Example – Save As Dialogs 

5.2 Edit Menu 

Use the Edit main menu to copy work contents from the work area as for 
example the Balancing view or the Priority Graph view. The copied view will be 
saved to the clipboard. It then can be copied into a Word file. 
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The Redo and Undo menu functions belong together. Use the Redo function 
to return to the original situation. The Undo function can be used until all of the 

activities are undone. As a basic rule it can be said that if a particular state is 
saved in Automatic Line Balancing, both menu functions will be disabled 
unless you carry out one or several processes in Automatic Line Balancing. 

  

Figure 14: Edit Main Menu 

Quick Search for a Process 
Use the Automatic Line Balancing Finder to quickly find processes. When 
searching for processes, you can specify the attributes, comparative operators, 
and values. The AVO Search dialog size is adaptable. The processes 

resulting from the search are displayed in a black box found in the job view.  

Common attributes such as the process description, process number, or time 
are generally configured for searching processes in the ALB. However, it is 
possible to configure specific attributes for individual searches at any time. 

 

Figure 15: Common Configured Attributes 

For more information on How to configure user defined attributes, please refer 
to the Administration Manual. 

 

Figure 16: Search for the Process Dialog 

Table 1 explains attribute usage. 

Table 1: Using Attributes to Search for Processes 

Attributes for the 
Search 

Comparativ
e Operators 

Specify Values 

file:///C:/Documents%20and%20Settings/OUM/Application%20Data/Microsoft/Word/Administration.pdf
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Searching for a Process 
After you have entered the search criterion, click Search button. The result is 

displayed in the dialog. 

Showing Processes 
Processes can be displayed in the Automatic Balancing view. All of the 
processes found during the search are marked by a black box in the Automatic 
Balancing view. This marking remains as long as the AVO Search dialog is 

open. 

Process number and 
description 

None 

The process number and description can enable 
one to search for processes using a single portion 
or full description of a process - for example, if one 
enters a number or letter found in the process 
number or description, then all processes which 
contain these values will be displayed. 

Valid time is None 

The Valid time is attribute enables you to search 
for the time that is valid for the process – for 
example, the calculated time or estimated time. 

    Tip: By not entering a value in the field, all 
processes are displayed. This broad overview 
enables one to quickly determine the valid speed 
for a process. 

Time 

 

The Time attribute enables you to search for the 
estimated time. Enter the search criterion by way of 
the comparative operators. The value entered 
should be numerical. 

For example, by entering the comparative operator 
greater than with the time parameter 1, all 
processes with an estimated time value greater 
than one minute will be displayed. 

Calculated time 

 

The Calculated Time attribute settings are similar 
to the Time attribute in that it enables you to display 
processes for which the calculated time is valid. 

Station linkage from 

Station linkage to 

 

 

The Station linkage from / to attribute enables you 
to search for processes with an existing Station 
linkage. 

The comparative operators are to be used 
analogous to the time parameters. The value 
entered should be numerical. 

Work height 
None  The Work height attribute enables you to search 

for processes that have an existing working height 
value – these values can be between 1 and 5. 

Max.Car 

 

The Max.Car attribute enables you to search for 
processes using the values true or false and then 
display the corresponding processes according to 
the value chosen. 

Production Line None 

The Production Line attribute enables you to 
search for processes that have been preset for a 
particular production line. The value given must be 
numerical, in line 10 for example, the numerical 
value is 10. 
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Figure 17: Search Dialog 

Once the dialog is closed the processes are again displayed as before – for 
example, processes with a weighting of less than 100%, are once again 
marked with a red box. 

Note 

You may continue to work in ALB with an open Search dialog, in the job view.  

To Show a Process 

To highlight a process in the Automatic Balancing view, select the process in 
the AVO dialog Search. 

Click Show. Please refer to the Figure 19. 

The Automatic Balancing view automatically shows the location of the selected 
process. The selected process will be indicated by a frame with node points. 
Please refer to the Figure 18. 

 

Figure 18: Example of a Selected Process 

Another option to show a process is to double-click the selected process. 

 

Figure 19: Showing Processes 

 

555888...      



ALB Menu Bar Description 16 

Automatic Line Balancing         Version PE 5.21 

5.3 View Menu 

The display of views in Automatic Line Balancing is based on Windows 
technology. You can set all views using the View menu. 

You can use several menus, for example, the View or Extras menu, to balance 
processes in Automatic Line Balancing. The edit views you will need for the 
corresponding activity are provided in the Views menu. You can open several 
views simultaneously. When opening the Balancing menu, you automatically 
open the balancing view. 

Frequently used functions such as the Finder icon or the selection list for a 
particular display of calculated stations are arranged in the tool bar.  

There are generally two view types: 

 Information views 

 Edit views 

5.4 Balancing Main Menu 

The main data for generating a balancing process will be specified in the 
Automatic Balancing main menu.  Performance parameters are used in 
Automatic Line Balancing. Performance parameters are default values such as 
takt times, way times, and subtimes. 

This chapter will guide you through the dialogs and functions used to perform 
an automatic balancing process. The operational chapter of this manual will 
introduce you to the dialogs you use for the first balancing process of a 
conveyor only. (Please refer to the Working with Automatic Line Balancing) 

 

 

Figure 20: Automatic Balancing Main Menu 

5.4.1 Recalculating Balancing Process 

Note 

All data referred in the following dialogs are general data and valid for the 
entire balancing process of a conveyor. 

In Automatic Line Balancing, you can recalculate an already generated 
balancing process, for example, by changing process data or material supply 
area data. To generate the first balancing process for a conveyor, you can use 
the same dialogs used for the recalculation of a conveyor already balanced. 

Click Recalculate to start the process. The performance parameters are to be 

specified in the dialogs described in the following section after the start of the 
recalculation. Please refer to the Figure 20. 
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5.4.2 Body Direction 

Use this dialog to specify the position of a vehicle on the conveyor. The 
conveyor traverse direction does not change regardless of the vehicle position 
selected. This dialog is also available for the first balancing process of a 
conveyor. Please refer to the Figure 21. 

You can directly call up and edit this dialog without having to recalculate the 
balancing process. 

To Open Body Alignment Dialog 

Click Body Direction. Please refer to the Figure 20. 

Caution 

The arrangement of charge carriers/containers may change if you select 
another body position. Hence, it is advisable to ensure that the work positions 
and material supply are arranged on the right side. You should be able to 
arrange things formerly situated on the left side on this same side again 
without mixing them up unless you do want to change the arrangement. 

 

Figure 21: Specifying Body Position Dialog 

5.4.3 Base Data 

Use this dialog to specify the performance parameter for the takt time, the 
return path, the station length, and the material supply area width. This dialog 
is also available for the first balancing process of a conveyor. Please refer to 
the Figure 22. 

Reason 
As the number of vehicle variants increase, the required space for the material 
to be provided will increase, too. The material supply area is limited on the one 
hand by the station length and on the other hand by the surroundings of the 
conveyor; for example, by adjacent paths or by further production lines. For 
this reason, automatic balancing has to be dealt with in the context of material 
supply planning (Please refer to the Figure 28). Hence, the available area can 
be considered as a further restriction. In Automatic Line Balancing, you can 
arrange workplaces where processes are performed in a flexible manner. You 
can arrange a workplace at a station either on the left or on the right side. The 
number of workplaces available at a station is to be specified with the first 
balancing process. You cannot change them with recalculation. The Automatic 
Line Balancing program identifies and generates stations and work positions 
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automatically with the first balancing process of a conveyor. Please refer to the 
Working with Automatic Line Balancing. 

In Automatic Line Balancing, processes can be executed at one or several 
stations. A MultiCycle is a work pool (to be performed at two or more stations 
due to its size) assigned to a station. A work pool consists of all processes 
executed by workers or robots. What are the potential effects on the balancing 
process? As far as the planned use of Multi Cycles in the balancing process is 
concerned, this may lead to an increase in the number of workers at a manual 
station or - in case of an automatic station – to the use of robots with a higher 
performance frequency. 

This procedure will extend the spectrum of activities and the individual work 
speed will be less closely linked to a cycle or station. Work time fluctuations 
can thus be reduced. 

You can, in addition, reduce the physical strain of workers by creating process 
sequences that combine heavy and light work. 

Furthermore, MultiCycles offer a great potential for increasing utilization. The 
first balancing process in Automatic Line Balancing will only generate 
MultiCycles if the average specified time of one or more process(es) exceeds 
the difference generating from takt time and way time thereby forcing a 
parallelism. To plan MultiCycles, you have to enter a value in the Max. 
capacity field in the Parameter for Automatic Balancing dialog. The higher 

the value, the greater the number of MultiCycles permitted. Please refer to the 
Figure 22. 

Specifying Entries for Performance Parameters 
You cannot make any entries in either of the Line and Process Graph fields. 
You can enter a name for the balancing process in the Description field. You 

will need to enter a name if you carry out several conveyor balancing 
processes with different performance parameters and save the corresponding 
results as a file with another name. 

Using the Save as function in the Project menu, you can save as many 

balancing process results as you like. This function enables you to generate 
several balancing process variants for a conveyor. The different results are 
available for planning at any time and can be compared to each other. 

You can directly call up and edit this dialog without having to recalculate the 
balancing process. 

To Specify Entries for Performance Parameters 

1) Click Balancing > Base Data. 
The Parameter for Automatic Balancing dialog appears: 
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Figure 22: Specifying Parameters for Automatic Balancing 

Cycle 

2) Specify the takt time needed to transport a vehicle on the conveyor in 
the cycle area. Takt time is specified in minutes. 

3) The number of stations where a MultiCycle can be used is specified in the 
Max. capacity field. It is 2 in the example. 

Calculation Period: The calculation period enables you to adjust the 

calculated takt times to longer time periods, the duration of a shift, for example, 
by default, this field contains the pre-set takt time. The times are adjusted and 
projected according to the pre-set calculation period. 

During projection, the times described below are taken into account and 
adjusted accordingly: 



ALB Menu Bar Description 20 

Automatic Line Balancing         Version PE 5.21 

 Total time for an activity 

 Productive activity time 

 Unproductive activity time 

 Cycle compensation 

The times for the calculation period are based on this formula: 

Example of the total activity time 

Total Time for an Activity = total process times x calculation period/takt time. 

This message appears when the calculation period is larger than the takt time. 

4) If the projected times for the calculation period are to be shown, confirm 
the message by clicking No. 

 

Figure 23: Calculation Period Message  

Walk Back Times 

5) Enter the SingleTakt time 
This time corresponds to the return path of a cycle needed by a worker to 
get to the start again. 

6) Enter the Addition MultiTakt time 

The allowance is specified for the return path with MultiCycles. Normally, 
less time is set because the worker will already be moving and no 
standstill is taken into account. 

7) Enter the Idle time automatic station time 
The time specified is dependent on the robot type used at a station. It is 
the time a robot needs to reach the right work position for executing the 
processes.  

Note 

The way time is specified in minutes. 

Station Data of New Station 

8) Enter the station numberin Number of first Station you want to start as 

the first station of a balancing process. The other station numbers have to 
be entered accordingly. 

9) Enter the Default length and width 

Length and width are specified in meters. In this field you specify the width 
and length of all stations of the balancing process. The standard width 
value includes the material area width. 

10) Enter the Material Area standard width 

Width is specified in meters. In this field, you specify the material supply 
width for all stations. 

11) Enter the percentage rate for drift bound. Please refer to the Entering a 
Percentage Rate for Drift Bound. 
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12) Select the checkbox Layout fixed for Layout. 

13) Select Logistics Planning from the drop-down list. 

14) Click OK. 

Entering a Percentage Rate for Drift Bound 
The percentage rate for drift bound only affects the Automatic Line Balancing. 
The percentage rate for drift bound specifies at which percentage rate the 

subsequent station should be locked for the execution of processes. This value 
should always be higher than a 100%. 

During balancing the Automatic Line Balancing takes the corresponding 
weighting of processes into account. Under this aspect the occupancy of the 
stations is calculated. 

A high number of processes can be executed simultaneously at a 100% in 
order to be able to manufacture certain product variants. In the maximum case 
this would mean that all processes determined for a station should be 
executed simultaneously at a 100%. All processes are therefore added up.  

With regard to the occupancy of a station this means that the occupancy 
increases to 220%, for example, when taking the weighting occupancy into 
account that is utilized 100% on average. 

In example, the percentage rate for the drift bound is entered at 200%. In the 
case of occupancy 220%, this value is exceeded by 20%. Automatic Line 

Balancing automatically locks the subsequent station because of the entered 
percentage rate of 200% for the drift bound. If the occupancy is below this 
value, the subsequent station is not locked. 

Therefore, you should already consider how high the maximum occupancy for 
certain product variants could be before the planning process. Based on this 
you should determine the percentage rate for the drift bound. In the case of 
MultiCycles, i.e. processes that are executed at several stations, the 
percentage rate does not make any difference to the drift bound. 

 

Figure 24: Schematic Display – Locked Station 

Specifying Performance Parameter for Calculation 
Use this dialog to specify the method according to which you want to calculate 
the balancing process. Please refer to the Figure 25. 

The Automatic Line Balancing process logic is based on the priority relations 
specified in the Priority Graph. A priority relation describes the order of 
processes. In Automatic Line Balancing, the ranking values are calculated on 
this basis. The ranking value is an abstract value used for calculation. The 
process times serve to calculate process ranking values. 

To Specify Performance Parameter for Calculation 

1) Enter the Process Graph name 

2) Enter the balancing line 
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3) Specify the rule for processes. Please refer to the Automatic Calculation. 

Automatic Calculation 

There are two main aspects for Automatic Calculation: 

 Ranking value calculation according to the sum of successors. 

 Ranking value calculation according to the maximum of successors. This 
calculation determines the critical path. 

 

Figure 25: Specifying the Calculation Dialog 

The processes for calculating the balancing process are referred according to 
the selection made. 

 

Figure 26: Example of Ranking Value Calculation – Critical Path 

The Method 
The priority relations will be specified in the Priority Graph. Ranking values are 
determined by these relations. Ranking values are specified by the time. 

Thus, process 4 is assigned ranking value 1 because the process time lasts 
1 minute. Process 6 is assigned ranking value 2 because the process time 

lasts 2 minutes. If there are no succeeding relations with these two processes, 
the ranking value will be calculated by the precise process time. Please refer 
to the Figure 26. 

The further process ranking values will be determined by the priority relations: 
There are different ranking values for a single process depending on the 
method used. 

 

555777...      
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Ranking Value Example for Process 1: 
 Ranking value according to sum of successors: Ranking value 13 (13 

minutes). 

 Ranking value according to maximum of successors: Ranking value 9 (9 

minutes) 

The example provides a detailed description of the two methods. 

Ranking Value Calculation according to Maximum of Successors: 
The red arrows indicate this relation. Please refer to the Figure 26. 

Ranking value selection rule:  

 Process 6 = Ranking value 2 (corresponds to a process duration of 2 

minutes) 

 Process 5 = Ranking value 6 (corresponds to a process duration of 

process 6 and 5 and the sum of 6 minutes) 

 Process 2 = Ranking value 7 (corresponds to a time of 7 minutes, which 

is the sum of the two previous processes as well as its own process time). 

 The process 1 = Ranking value 9 

Ranking Value Calculation according to Sum of Successors 
Please refer to the Figure 26. 

 Process 4 = Ranking value 1 

 Process 3 = Ranking value 4 

 Process 2 = Ranking value 11: This ranking value is determined by the 

sum of the times of processes 6, 5, 4, and 3. 

 Process 1 = Ranking value 13. 

Conclusion 
In the maximum ranking value selection, processes corresponding to these 
determined values will be balanced successively. The sum ranking value 
selection will not deal with the critical path. Processes will be balanced 
successively according to the ranking values and priority relations. In addition, 
there is a further principle: Random selection Here, processes will be 
balanced. Ranking values will not be taken into account.  

4) Specify the schedule for selection areas. Please refer to the Planning of 
Station Areas. 

Planning of Station Areas 

 

Figure 27: Planning of Station Areas 

This area is the local area in which a process is to be executed.  

 Workplace with minimum utilization: This balancing process first 

concentrates on the workplaces with minimum utilization. 

 Balancing process according to Random Selection: The utilization of 

a workplace will not be considered here. 
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5) Click Run. The balancing process will be recalculated. 

5.4.4 Station Management 

Work areas (workplaces and material supply areas) which are not to be 
assigned processes or bins are blocked in the Station Management dialog. 

When work areas are blocked, current situations which may result from 
ongoing planning are considered. All stations and workplaces of the balancing 
process dialog are available for blocking workplaces and material supply 
areas. Please refer to the Figure 28. 

Note 

You cannot use the Station Management dialog unless you have executed a 
balancing process for a conveyor. 

To Open Station Management Dialog 

1) Click Station Management to open the Station Management dialog. 

Please refer to the Figure 20. 

The following items can be blocked: 

 Workplaces and material supply areas at the station. 

Work areas assigned by processes or bins cannot be blocked at all. The 
display of this dialog may change. Only work areas specified with the first 
balancing process of a conveyor will be displayed. 

 

Figure 28: Station Management Dialog 

Blocking Workplaces 
Workplaces can only be blocked if they have not yet been assigned by a 
process. Blocked workplaces are marked by a grey box in this dialog. If 
blocking is made by a MultiCycle (marked by a red rectangle, Please refer to 
the Figure 29) i.e. a process comprising at least two stations, it is marked by a 
checkmark in the grey field. Boxes next to the workplaces that are not grayed 
out can be blocked. 

2) To block a workplace, click empty box. A blocked workplace cannot be 
checkmarked. Please refer to the Figure 29. 

 
 

Figure 29: Blocked and Unassigned Workplaces 
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Locking the Material Supply Area 
You can lock  individual portions of the material supply area of a station, with 
the aid of the Locked area… menu item in the job view. The locked area of an 

occupied material supply area can only be changed, if the locked space is at 
the end of the station area. Open areas can be designated as locked space at 
any given time. Please refer to the Unlock or Lock Material Supply Area. 

 

Figure 30: Locking the Material Supply Area 

To Lock the Material Supply Area 

1) Specify the area which is to be blocked for the purpose of material supply 
at a station. 
The area is specified in meters. There are two default values to select 
from in the selection list: the station length and the zero value if the 
material area has not yet been blocked. 

 

Figure 31: Default Values 

2) Left-click the field and mark the number. The next step is to enter the 
value for the blocking. In the example, an area of 4 meter on the right side 
of the station is blocked. The grey area indicates the blocked area. Please 
refer to the Figure 32. 

 

Figure 32: Example for a Blocked Area 

5.4.5 Displaying Process Length 

Use the Process Length menu item to display processes differently in the 

Automatic Balancing view. The processes can either be displayed with priority 
relations or with weighted times – depending on the usage. Use the tool bar 
buttons to select the views. 

 

Figure 33: Process Length Menu Item 

Displaying Process Length with Equal Length 
This display corresponds to the Fixed menu item. This display includes all 

processes with equal length and priority relations independently of the process 
duration. This display offers you a quick overview of all processes and priority 
relations of a balancing process. 

Displaying Process Length with Weighted Time 
This display corresponds to the Weighted Time Fix menu item. This display 

contains all processes according to the weighted process duration without 
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priority relations. In addition, potential waiting times between processes due to 
a priority relation or to the station linkage are displayed. You can use this 
display to view the actual assignments of the processes to the stations that 
can then be edited manually for example, to reduce waiting times. 

 

Figure 34: Displaying Waiting Times between Buffers 

Between processes 002700 and 003100 (workplace rear) there is an actual 
waiting time due to the priority relation between both processes 080410 
(workplace on the left) and process 003100. 

Left-click the process to display the priority relation. 

Each balancing process aims at the avoidance of waiting times between 
processes. If, nevertheless, you cannot avoid waiting times, you will be able to 
quickly correct the waiting time in this display. For example, by assigning the 
workplace processes manually. Please refer to the Figure 34. 

Marking Processes for Max. Car – 100% Display 
This display corresponds to the Maximum Time menu item. Please refer to 

the Figure 33. 

In this display, all processes are represented with the actual process duration. 
The weighting is 100% here. This display does not consider waiting times. 

Note 

If for a balancing process you use processes of which none have been marked 
as Max. Car, no processes are shown in the 100% display. 

 In this display only the processes marked as Max. Car in the properties 

dialog of a process are displayed. 

 As of Version R16 the processes are marked as Maximum Vehicle 
only in the balancing in the properties dialog of the process. In 
contrast to previous versions, the mark applies only to this balancing. In 
the standard configuration, the processes are marked as Maximum 
Vehicle after the balancing has been started. Changes to this mark must 

therefore be made directly in every balancing. 

 Marked processes as Max. Car of such processes are used for the 
vehicle which has the highest percentage of process time volume. 

 

Figure 35: Marking Process in the Properties Dialog as Max. Car 

 

666000...      
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For the planning of alternative processes Please refer to the Planning 
Alternative Processes in the Process Graph. 

5.4.6 Process Color: Displaying Work Areas and Work 
Heights 

Using the Process Color menu item, you can, by highlighting, display the 

processes either according to the working height or the work position at the 
vehicle. Working height data and the work position of a process are to be 
specified in the Properties dialog. You can change the display according to the 
corresponding usages. You can also select the views using the tool bar 
buttons. 

 

Figure 36 : Process Color Menu Item 

Displaying Processes according to Working Height 
According to the slightly altered rule: Automatic Line Balancing offers menu by 
providing optical process tracking. With coloring of processes, you will be 
provided with a quick overview of the height at which a process is carried out 
at a workplace. You will see this display using the Priority Graph and 
Automatic Balancing views. 

 

Figure 37: Displaying Working Height Colors 

Displaying Processes according to Work Area 
Processes will be displayed here according to the work position on the car 
body. There are two main types: 

 Processes executed out at a single workplace only. 

 Processes positioned in an intersection – i.e. processes that can be 
executed at two workplaces. Each vehicle workplace is marked by a color. 

Processes only carried out at a single workplace have the same color as the 
workplace. Processes in an intersection are colored grey. 

Processes carried out at single workplaces are marked by a circle with the 
respective color. 
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Figure 38: Example for Assignments of Colors to Body Point  

5.5 Extras Main Menu 

Use the Extras main menu to print the valuations of a station assignment, 

process list, and Group overview in an Excel table. The three Automatic Line 
Balancing valuation options will provide you with a quick overview of the 
important performance data of a balancing process. The Consistency Check 

dialog displays the processes which caused an error in the balancing process 
and provides an error description. Following that description, an error might 
result by disregarding priority relations. 

 

Figure 39: Extras Main Menu 

5.5.1 Excel Evaluation 

There are three valuation types: 

 Station assignment, Please refer to the Figure 40 and Figure 41. 

 Process list, Please refer to the Figure 42. 

 Group overview: You will be provided with each field of the valuation list in 
chapter: Group Overview View. 

Station Assignment Valuation 

 

555666...      
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Figure 40: Station Assignment for a Balancing Process – Part 1 of the List 

Station 
This table column area shows the station and workplace which are assigned 
processes. The table description starts at the left. It includes the following: 

 Station number, process type: manual process (manu) or an automatic 

station (auto). 

 Process type: There are two possible entries: manu which designates a 

manual process and auto which designates an automatic process (robot). 

 Name of the workplace where the car body process is executed (on the 

left, rear, etc.). 

 Number of workers (MA) and operating equipment required for the 

execution of this process. 

Process Number - Description 
 Process number with a short description of the execution type of the 

process. Please refer to the Figure 40 and Figure 41. 
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Figure 41: Station Assignment for a Balancing Process – Part 2 of the List 

Average Process Duration 
These two columns display the weighted time in minutes. The percentage 
corresponds to the percentage share of weighted process time in the takt time. 

Maximum Process Duration 
The maximum process time corresponds to the actual process duration without 
weighting. The percentage corresponds to the actual percentage share of 
weighted process time in takt time. 

MultiCycles 
The percentage shares are calculated according to the number of cycles in the 
case of MultiCycles. 

Process List Evaluation 
Designation of columns and lines are fixed in Automatic Line Balancing and 
therefore cannot be changed. 

Note 

You will find a description of the evaluation list fields in the Process list view 
chapter. Please refer to the Process List View. 
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Figure 42: Process List Evaluation Example 

5.5.2 Setting the Balancing Options 

General data for the display of a balancing process are to be specified in the 
Options dialog. The Settings dialog is divided into General, Balancing, 

Load/Save, and Display. 

General 

1) Select the Checkbox Enable Undo to enable Undo function. 
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Figure 43: Dialog for Setting Options  

Show Restriction Violations on Moving 

This function is activated in the standard configuration. If you deactivate Show 
restriction violations on moving, the violation of restrictions will no longer be 
displayed in the performance view of the work load balancing when the 
processes are moved. 

Show Consistency Check after doing an Automatic Balancing 

This function is active in the standard configuration. If you deactivate Show 
consistency check after doing an automatic balancing, consistency checks 

will no longer be displayed after starting or re-starting the work load balancing. 
Please refer to the Figure 50. 

Balancing 

2) Select the checkbox Manage unassigned stations automatically to 

enable the functions described below that option. 

Manage Shelves Automatically 

If you enable Automatically manage shelves: 

 Empty shelves are removed in the balancing processes. 

 When moving a process to another station to which part bins placed in a 
shelf are assigned, a new shelf is generated in this station as long as no 

appropriate shelf is available in this station. 

Manage undefined station heights automatically 

This function is active in the standard configuration. If you have activated 
Manage undefined station heights automatically, the previously defined 
working height of the first process is applied to the station when the process is 
inserted. Please refer to the Figure 45. 

Merge Tools Automatically 
When you assign tools to processes, ALB instantiate such tools in the 
respective stations. If a tool is required by two different processes in one 
workplace, the software should instantiate only one single tool.  
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The DPE calculates the right number of necessary tools at the line. When 
saving the data to the hub, it create instances of the tools. The tool information 
is used by ALB to instantiate the right number of tools at the right place in the 
line. That means, if Tool 1 is required by Process 1 in Station 1/Workplace1 
(S1/WP1), and another Tool 1 is required by Process 2 in the same workplace, 
the algorithm has to put only one tool in S1/WP1. 

If the Process 2 is moved to another workplace, such a Tool 1 needs to be 
instantiated in this workplace too, if not already existing there.  

In ALB if Tools < Options < Settings < Automatically merge tools mode 
ON, the tools view (ALB < Tools < View) is visible and Station tool nodes are 
available in DPE. 

In ALB if Tools < Options < Settings < Automatically merge tools mode 

OFF, the tools view is not visible and Station tool nodes are not available in 
DPE. 

In ALB, if you move process from one workplace to another. The 
corresponding changes appear in tools view, the process get listed in 
workplace to which it has moved. 

In ALB, if you delete a tool process relation in DPE for which a station tool 
node exists. The corresponding ALB tool node is removed in DPE also. 

Show individual tools for each workplace 
 Tools View: There is a view showing the individual tools for each 

workplace. The view is shown on all workplaces with tools. For each 
workplace it shows the tool instances. For each of these tools it show its 
processes performed at that workplace. 
1) Select View from Contextual menu in Workplace. 
2) Select View menu > Tools. 

3) Select Tools in the contextual menu of the Balancing List View 
4) For tools list, Main Menu > View Balancinglist >Right-click contextual 
menu > Balancing List View. 
All these commands are enabled only if “Merge tools automatically” is 

checked in ALB settings. 

 Different Behaviors 

 From OFF to ON: The tool instances are calculated immediately. When 

saved, the instances are saved too. 

 From ON to OFF: The tool instances are removed immediately. When 

saved, the instances are removed in the E5 hub too. 

 From ON to OFF to ON, then save changes: The tool instances are 
removed immediately. Then they are created again, but with different 
object IDs. So when saving, the existing instances are deleted and new 
instances are created. 

Default setting for Merge Tools 
 You can change the default setting for “Merge tools automatically” by doing 

a customization at the project level. 

 By default, the option “Merge Tools automatically” is unchecked. You can 
confirm this by clicking the “Load Default Values” option in the left corner 
of the ALB Customization dialog box. If this check box is checked, then 

the default setting for new balancing will be checked in ALB Settings. You 
can change this in ALB under Options > Settings. 
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Pre-Requisites: Configuration in the DPE Global Library  
 Before starting ALB, check if plantypes are properly configured. The plan 

type of the Tool should be properly configured and it should be a child of 

the Plan type Station. 

Pre-Requisites: Relation between the Tools and Processes 
 Before starting ALB, ensure for valid Wokplan and all the processes in the 

work plan should be properly related to the Tool in the Project Library. 
Tools are created in the Project Library and then it is linked (Drag & Drop) 

to the Processes. 

 Process Uses Resource is the relation used for linking a tool to process. 

Note 

The correct calculation of tools is not available for tools that are used by two 
parallel workers e.g. in two “Multi-Man“ processes. The software does not 
distinguish between movable (e.g. screw driver) and immovable(e.g. welding 
robot) tools The software does not show the graphical representation of the 
tool in ALB 2D/3D View. It does not recognize the objects that were created 
outside the ALB and does not allow to load them. 

Logistics Planning Mode 
The Enhanced logistics planning mode is set in the configuration dialog of 
ALB. 

It is basically set globally at the project level: Contextual menu of the Project < 
Extras < Balancing ALB Configuration > ALB Customization 

OR 
It can be overwritten locally for the specific user in the ALB application 
menu: ALB Main Menu > Tools > Options > Setting 

The default value for Logistics Planning > Model Mix is No duplicate parts 
bins for same Parts inside material area. 

Load/Save 
3) Select the checkbox Lock Process on Startup. 

Enabling this field, the processes used for the balancing process cannot 
be edited in the PPR-Navigator. Therefore enabling this field ensures, for 
example, that process times can be changed while working with the 
balancing process. 

Parts and Containers are linked by Parent Object 

Enable this field only if you want to plan different product variants (Parts A...Z) 
using a so-called organizational position variant. In this type of planning the 
relations (process and part bins) are formed exclusively via the parent object.  

You must first take into consideration the method you will use to plan the 
individual variants (Part A…Z) in the structure; for example, using temporal 
effectivities for the variants. 
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Figure 44: Use Parent Object for Planning Schema 

Calculate Number of Parts by Number of Part Relations at a Process 

 

Figure 45: Calculate the Number of Parts by the Number of Part Relations at a  
Process Checkbox 

3) If you activate the Calculate the number of parts by the number of part 
relations at a process option, all identical parts must be linked individually 
with a process – structural model. 

4) By deactivating the Calculate the number of parts by the number of 
part relations at a process option, all parts can be linked with a process 

at the same time – reference model. 

Display 

 

Figure 46: Display 

5) Select the Checkbox Show option-dependent processes highlighted to 
optically display processes which are assigned special equipment parts. 
Processes are assigned special equipment parts according to a code rule. 

Material Surface 
6) If you activate Show parts bin number, the corresponding parts bin 

number for a loading unit is shown. 

7) If you activate Show part number, the corresponding part number of the 

part for the loading unit that is assigned to this loading unit is shown. 

 

Figure 47: Example of a Palette with Parts Number  

2D View Scaled Display 
Select the option for 2D View in other scale modes. By default, the option is 
Only workplace width. 

By default, the 2D View is not displayed scaled. With the help of the two 
options (Only Workplace Width, All) you can display the 2D View in other 
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scale modes. This might be helpful if the width of the workplace is too small so 
that the process cannot be displayed within the workplace. 

Scaling will scale workplace width depending upon how small the actual 
workplace width is given in settings so that all processes are visible. In this 
regard, if the effective workplace width as is specified in the balancing settings 
is too small, the scaling will be done large. For a minimal workplace width, 
scaling will be large. 

Option Only Workplace Width 

With this option you can scale the width of a workplace, so that all assigned 
processes of the workplace can be shown. You should be aware that as a 
result of this, the length and width of the station has not the same scale. 

Option All 

With this option you can scale the whole view in a larger scale. The view is 
scaled in that way that the workplace width is so big that the processes can be 
displayed within the station. Because the station length and the material area 
geometries are also scaled with this factor, this can lead to an unhandy size of 
the material areas or stations. 

Activate 8-bit Color Mode 
Activate this mode only if you can display the graphics on the computer in 8-bit 
color mode. 

Priority Graph 
This area specifies data for the display of processes in the Priority Graph view.  

 

Figure 48: Priority Graph  

8) Select the Checkbox Show process number and Show process name 

to display the processes with the corresponding names and numbers in 
the Priority Graph view. 

9) The Node width and Node height fields are both used to specify the size 

for displaying the process in the Priority Graph view. Node width and node 
height are to be specified in pixels. 

10) Click Load Default Values button in ALB Customization dialog box to 

load the default values. 

Note 
Changes in defualt settings are are effective from R20 only. Projects upgraded 
from R19 or previous versions, have some changes in default settings and you 
have to change them manually. 

Show Options for Walkways 
In the Walkways dialog you can determine the generally valid base data for 
viewing the walkways. These settings apply to all stations and workplaces of 
the balancing which is currently to be edited. Please refer to the Figure 49. 

The Base data determine: 

 Over which length the body should be viewed in millimeters 

 Over which width the body should be viewed in millimeters 
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 How the start position of a body should be and how the viewing of the 

walkways should be started. 

 At what walking speed an employee should cover the walkways.  

 

Figure 49: Entering Base Data for Walkways Viewing Dialog 

By determining the start position of the body the position for the first process is 
defined, in addition, the viewing of all further walkways for the workplace 
should be shown. The walkways are shown between the processes as well as 
between processes and material containers. 

5.5.3 Executing Consistency Check 

In the Consistency Check dialog the consistency of a balancing process is 
checked. In case of a recalculation of a balancing process, Automatic Line 
Balancing will automatically execute the consistency check. Please refer to the 
Figure 50. 

 

Figure 50: Consistency Test Dialog 

You can execute a consistency check at any time during the manual editing of 
a balancing process. The dialog will display the violations. Each displayed 
violation of consistency will briefly be described. 



ALB Menu Bar Description 38 

Automatic Line Balancing         Version PE 5.21 

Violations of consistency may occur if: 

 Material planning has not been completed. 

 Priority relations have been violated; for example, a station has manually 

been assigned a wrong process. 

1) Click Refresh to display the current violations of consistency. 

Quick Search for Processes that Violate Consistency 
You can display consistency violating processes in the Consistency Check 
dialog. 

2) Select a process from the dialog. Click Show to display the selected 

process in both of the Automatic Balancing and Priority Graph views. 

3) Alternatively, you can select a process by double-clicking on it to display it 
in both views. Please refer to the Figure 50. 

Expanding 
All violations of consistency are opened and displayed with the Expand button. 
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6. Display of Views 

The various views are described below: 

6.1 Precedence Graph View 

The Precedence Graph view displays the processes and priority relations 

between the processes. The displayed process order is based on the Process 
Graph used for the balancing process. The priority relations will be specified in 
the Process Graph. This view cannot be edited. Changes will have to be made 
in the Process Graph. Double-click a process to open the Properties dialog 

that displays the process performance data. 

 

Figure 51: Example of a Priority Graph View Display 

6.2 Process List View 

In the Process List view you can display all processes for the Automatic Line 
Balancing (All Processes button). Double-click a process to open the 
Properties dialog that displays the process performance data. 

All three pages of the Process List that are available display the only 
processes belonging to the active Automatic Line Balancing – you may for 
instance balance the workload according to the model mix mode. In this mode 

you can balance the workload of several variants. 

Upon start of the Automatic Line Balancing, you can decide whether you wish 
to calculate the work load from processes for individual stations automatically, 
as previously, or if you wish to add the processes manually to the Automatic 
Line Balancing (Please refer to the Manually Balancing Processes). 

In the title bar of the Process List, three buttons are provided for selection of 
pages: 

 All Processes: Show all process 



Display of Views 40 

Automatic Line Balancing         Version PE 5.21 

 Balanced Processes: Show all balanced process 

 Unbalanced Processes: Show all unbalanced process 

The All Processes page displays all balanced and unbalanced processes. On 
the two pages Balanced Processes and Unbalanced Processes the 

processes are displayed on the basis of their assignment. 

On the next few pages you will learn how to control the display features of the 
new Process List – please refer to the Efficient use of the Process List for 
Automatic Line Balancing. 

To display a page, click the respective button. When the page is activated, the 
label appears in bold type – in the Figure 52 the page All Processes is 
highlighted and therefore activated. 

 

Figure 52: Process List Example 

If unbalanced processes exist, the view display the unbalanced processes if 
the view is opened. Otherwise it is opened in Mode “All Processes”. 

Process can be highlighed in all open windows either by clicking/selecting a 
process. You can select process in any open view and it will get higlighted in 
other opened view. 

Assign processes from the unbalanced processes pool to a workplace: 

Process List Window 

 Drag and Drop from Process List window to Balancing2D View. 

 Drag and Drop from Process List window to BalancingList View. 

 By contextual menu on one or more unbalanced process(es): the 
contextual menu shows a list with all stations/workplaces that exist in the 

balancing. 

Unbalance a process 

Balancing2D View 

 By contextual menu on a process: The contextual menu has an entry 

called Unbalance. 
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 By Drag and Drop to the process List window. Drag and Drop is possible if 
the Process List shows the unbalanced processes, otherwise the mouse 

pointer icon shows that drag and drop is not possible.  

BalancingList View 

 By contextual menu on a process: The contextual menu has an entry 
called Unbalance. 

 By Drag and Drop to the process List window. Drag and Drop is possible if 
the Process List shows the unbalanced processes, otherwise the mouse 
pointer icon shows that drag and drop is not possible.  

For a new balancing all processes are put to the unbalanced process pool. 
After you run the automatic balancing, all processes have been balanced (the 
unbalanced process list must be empty), 

Process can be moved from the unbalanced pool to the balancinglist:  

 If the process is moved on another process, the moved process must be 
inserted behind the destination process. 

 If a process is moved on a workplace, the moved process must be inserted 
as first process if the original station number is smaller than the destination 
station number; otherwise the moved process has to be inserted as last 

process. 

Process can be moved from the balancing list to the unbalanced process pool 
by contextual menu or drag and drop. 

Column Information of Displayed Processes 
The single Process List processes are arranged in lines and given a serial 
number. The Process List structure corresponds to an Excel sheet. Important 
process information will be displayed in the assigned columns. 

 By clicking the column header with the mouse, you can sort respective 
column of the Process List. 

Station and Workplace 
In the Stations column, the stations and workplaces for already balanced 
processes are displayed. If the process is still unbalanced, the line in this 
column remains empty. 

 

Figure 53: Station and Workplace Column 
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Description 
This column displays the name of the process. 

Type 
This column describes the process type. If the process is performed by 
workers, it will be described as manual. If the process is performed by 
machines, it will be described as automatic. 

Value Added (VA) 
This column displays the value-added process share in percentages. If the 
value is 90%, the value-added share will amount to 90% and the non-value 
share will be 10%. The non-value added share of a process indicates the 
share that still needs to be optimized. Please refer to the Figure 52. 

MaxCar 
Processes, which are displayed in the Automatic Line Balancing on the basis 
of the MaxCar option, are indicated by an “X” in this column. 

This display corresponds to the menu entry Maximum process duration. 

Maximum Process Duration 
The column displays the actual process time of the processes, i.e. weighted 
100%. Idle times are not taken into account. 

Variant Loading 
This column displays the process usage frequency with a product variant in 
percentages. 

Process Duration 
This column displays the weighted process time of a process in minutes. The 
weighted time always depends on percentage of the variant weighting: for 
example, if the process variant weighting is 50%, the weighted process time is 
50% of the actual process duration. The weighted time indicates how often a 
process is used for a product variant i.e. in a layer. 

Area 
This column indicates the local area where the process is performed on the 
product. 

Station Linkage 
This column indicates whether the process can only be performed at particular 
stations. A 5-10 entry would mean that this process was linked to stations 5-10 
and was therefore only performed at these stations. The data of this column 
correspond to the station numbers. 

Number Material 
This column indicates whether additional material is used to perform the 
process. For example, assemble a windshield wiper. The number in this field 
indicates the number of additional parts needed for the process: number 1 
indicates that 1 additional part is needed, which is a windshield wiper.  

Amount of Operating Equipment 
This column indicates whether additional operating equipment is used to 
perform the process. The number in this field indicates the amount of 
additional operating equipment still needed for the process. Please refer to the 
Figure 52. 

Product Variant 
The column Product Variant displays the process graphs on which the 
planning of the processes for the Automatic Line Balancing of the product 
variant is based. Only the processes of the active variant are displayed.  
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Reordering of Columns 
1) Open ALB in a New Line. Please refer to the Figure 2. 

2) Go to ALB Main Menu > View > click Process List/ Balancing List/ 
Workplace. 

You can sort\re-order the columns by drag and drop to different position. Yiou 
can drag and drop only one column at a time. 

The position of the columns are retained as the same on re-opening the ALB. 

The position of columns after reordering is retained: 

 When the list view window is opened again in the same session of ALB.  

 When ALB is closed and opened on the same or another line & list views 

are opened. 

 When ALB and DPE are closed and launched again and list views are 

opened. 

The sorting\re-order of the columns can also be done to the user defined 
attributes. 

Efficient use of the Process List for Automatic Line Balancing  
To balance processes manually, use the Unbalanced Processes page in the 
Process List. The two pages for All Processes and Balanced Processes 

essentially serve to provide information concerning the processes. With the aid 
of the Recalculate option you can later automatically balance the processes. 
Please refer to the Manually Balancing Processes. 

For balancing of processes, the Unbalanced Processes page has special 

meaning. Only from this page you can assign processes to the line balancing 
by drag and drop. 

All Processes Page 
The All Processes page displays all processes that may be used for the 

Automatic Line Balancing. Processes which have already been planned for 
Automatic Line Balancing, are marked in the Stations column, the name of the 

station and the workplace are indicated. 

Balanced Processes Page 
The Balanced Processes page displays all processes already used for the 
Automatic Line Balancing. In the Stations column, the station and workplace 

to which the process has been assigned are shown. Additionally, this page, as 
the other two pages, displays further information concerning process 
properties. 

The Figure 54 shows an example of an activated page for already balanced 
processes with all available data. 
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Figure 54: Balanced Processes Page  

Assigning Processes to the Automatic Line Balancing using Drag 

and Drop 
By drag and drop from the Process List, processes are assigned exclusively to 
the Balancinglist. Assigned processes are displayed in the Balancinglist and in 
the Balancing view. 

As in automatic calculation, the stations are automatically created when 
processes are manually assigned. The number of stations created, on the one 
hand depends on the takt time, and on the other on the number of processes 
planned for Automatic Line Balancing – the basis for the number of processes 
is the Precedence Graph. 

The stations are created in both views – Balancinglist and Balancing view. 

Processes can only be assigned from the Unbalanced Processes page to the 

Balancinglist. Processes which have been assigned to the Automatic Line 
Balancing can be removed from the balancing list and the balancing view by 
means of the contextual menu item Unbalance or with the delete key on the 

keyboard. Please refer to the Removing Processes. 

Different ways of Assigning Processes 

To Assign Processes to the Balancinglist 

1) Press the left mouse button and pull the processes onto the station in the 
Balancinglist. 

 Several processes that directly follow one another can be selected by 

using the shift key. 

The Figure 55 shows processes that have been selected using the shift key.  

 

Figure 55: Processes which have been selected with the shift key  

2) Use Ctrl key to select several individual processes. 
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The Figure 56 shows processes that have been selected using the Ctrl key.  

 

Figure 56: Processes which have been selected with the Ctrl key 

Displaying Balanced Processes 

Balanced processes are displayed in the Balancinglist, the Balancing view, 
and Balanced Processes page. 

Some sample displays: 

 Balancinglist: The Balancinglist shows the assigned processes alongside 

the stations. For editing Balancinglist, Please refer to the Display of Views.  

 

Figure 57: Example 1 – Balancinglist 

The Figure 57 and Figure 58 show processes that have been assigned to 
different stations. 
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Figure 58: Example 2 – Balancinglist 

 Balancing View: Processes that have been assigned to the Balancinglist, 

are immediately created with stations and workplaces and are then shown 

in the Balancing view. Please refer to the Figure 59. 

 

Figure 59: Example – Balancing 

 Balanced Processes View: On this page, too, the balanced processes 

are displayed without delay upon their assignment – as is the case in the 
other two views, this includes display of stations and workplaces. Please 

refer to the Figure 60. 
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Figure 60: Example – Process List – Balanced Processes Page 

6.3 Balancing View 

All calculated stations, work positions, and assigned processes will be 
displayed in the Balancing view. Use this view to perform manual balancing. 
This means that you can assign processes to new work positions using drag 
and drop in this view. (Please refer to the Working with Automatic Line 
Balancing). There are two different kinds of stations: manual stations (Please 
refer to the Figure 61) and automatic stations (Please refer to the Figure 62). 
The Balancing view can be displayed either with or without the Material Area. 
Please refer to the Balancing Work Areas. 

 

Figure 61: Example – Station Balancing Conveyor Display 
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Display of an automatic balancing station: Automatic stations use handling 
robots to insert car windshields or to perform similar activities. With automatic 
stations, activities are mainly performed by the machines used. An automatic 
station is marked by the Auto sign in the rhomb. 

 

Figure 62: Example – Automatic Station Display 

Balancing Work Areas 
The balancing view consists of two main work areas. On the one hand, there 
are the areas for the material supply that are usually on the left or right side of 
the displayed stations. On the other hand, there are work areas with the 
assigned processes. All work areas are highlighted. All displayed work area 
performance data are specified when generating the balancing process. 
Please refer to the Balancing Main Menu. 

Performance Data 

 

Figure 63: Performance Data of the Balancing Process 

This line displays all performance data. The green arrow indicates the transfer 
direction specified. Please refer to the Body Alignment Dialog, Figure 63 and 
Summarized Group Overview. 

Operating time (Opr.time) 
The operating time is the sum of all process times at a workplace. 

Compensation (min) 
The displayed result for the compensation is calculated based on the following 
formula: 

Compensation = takt time – net time - idle time 

Work Position with Assigned Processes 

 

222...      
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Figure 64: Example – Work Position with Assigned Processes 

All work positions are equally described. A work position is identified by the 
descriptions below: 

 The description of the position indicates the place where processes are 
performed – for example, Left. This means that processes will be 
performed on the left side of the station. The work position display 
changes according to the local performance of processes: for example, 

Rear, engine compartment, or Right. 

 The process duration. The process duration is the sum of all work position 
process times. It is the 9,681 minutes in the example (this value can also 

be displayed in percentages). 

 The number of workers (1WP) calculated for this work position. The 

example in Figure 64 refers to one worker. 

 The processes are displayed by the process number in the Balancing 
view. Processes can either be displayed by a rectangle (against a grey 
background as shown in the example) or by a rhomb. The display size 
depends on the duration of each process. The longer the process 
duration, the greater is the size of the process display. Processes with a 
station linkage are displayed by a rhomb. The process station linkage may 
refer to one or several stations. Please refer to the Displaying Processes 

and Figure 61. 

Material Provision Area 

 

Figure 65: Example - Material Supply Area 

The material supply area indicates the space required for a station. The 
assigned bins will be displayed in this area. This is the blue colored area with 
the number 820720 in the example. Please refer to the Figure 65. 

Show Loading Units of the Material Provision Area 
You can show the number of loading units of a material provision area with 
specific data of the loading unit via the contextual menu entry Info. 
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Figure 66: Loading Units are shown with Specific Data 

Station Description 

 

Figure 67: Example – Station Description 

Balancing process stations are marked by a station number. Station numbers 
are sequence numbers. Normally, the first station is numbered station 
number 1. Station numbers in Automatic Line Balancing may be handled in a 
flexible manner according to business requirements: for example, if you view 
several linked conveyors in the balancing process, you will be able to specify 
overall station numbers for these conveyors. You will specify the number for 
the first station when generating the balancing process in the duration dialog. 

Thus, the first station at conveyor 1 would be numbered station number 1 

whereas the first station at conveyor 2, according to the stations calculated for 
conveyor 1, would be numbered station number 10. As a conclusion, the last 
station of conveyor 1 would be numbered station number 9. Please refer to the 
Figure 62 and Figure 67. 

6.4 Balancing Process List View 

All calculated stations, work positions and assigned processes are displayed in 
the Balancinglist view. You can manually edit the balancing process both in 
this view and in the Balancing view: 

 Processes can be moved either by drag and drop or in the popup menu. 

 

444...      



Display of Views 51 

Automatic Line Balancing         Version PE 5.21 

 New stations can be inserted in the right mouse button's popup menu. 

 Free stations which have not been assigned any processes or material 

containers can be deleted in the popup menu. 

 Free station areas can be locked and unlocked in the popup menu. 

 Drift areas can be set up for free station areas. 

 Selected lines of the Balancinglist can be unlocked in the popup menu. 

 Processes selected in the Balancinglist are also selected (cross-

highlighted) in the Balancing view. 

The Balancinglist is an additional opportunity to the Balancing view to manually 
edit the balancing process. The display of the station and the assigned 
processes provides an individual free space for editing the balancing process. 
Material provision surfaces and load containers cannot be edited in this view. 

This chapter will show you how to edit the Balancinglist. Popup functions 
previously described in the chapter on balancing are not described in this 
chapter. Pease refer to the Contextual Functions in Automatic Balancing and 
Table 4. 

 

Figure 68: Balancinglist View 

Popup Menu Functions 
You can edit processes with the help of the popup functions. Processes can 
either be assigned to a new station or placed at another location within a 
station. The same restrictions as those in the Balancing view apply to editing 
the Balancinglist. Messages indicate possible restriction violations. Please 
refer to the Restriction Violations during Manual Editing. 

 

Figure 69: Selected Process Popup Menu 

Moving Processes 
You can move processes either by drag and drop or in the popup menu, or you 
can directly assign them to a new workplace. 
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Moving Processes by Drag and Drop 
You can also select and move multiple processes simultaneously. Processes 
cannot be assigned to a locked area. 

1) To select a process, click corresponding line with the left mouse button. 
To select several processes in the Balancinglist at the same time, click 
successively in the respective lines of the Balancinglist and also keep the 
control key pressed. 

 

Figure 70: Selecting Processes in the Balancinglist 

2) With the left mouse button pressed, drag the process (or several 
selected processes) to the new station, and insert the process in the 
corresponding location. The process is inserted immediately as long as there 
is no restriction violation. If there is a restriction violation, this is indicated by a 
message. 

 

Figure 71: Inserting a Process in a New Station 

Resetting the Selection 
Selected processes must always be reset again with the popup function Reset 
Selection. 

 

Figure 72: Reset Selection Popup Function 

3) Open the popup menu in the Balancinglist. Then click menu item Reset 
Selection. 

Assigning Processes to a New Station in the Popup Menu 
Processes must always be selected in the Balancinglist first if they are to be 
assigned to a new workplace with the popup function Move Selected 
Processes To…; multiple and single selections are both possible. 

 

Figure 73: Move to Popup Function 

1) Select at least one process so that the popup menu entry Move Selected 
Processes To… is active. 

2) To open the dialog, open the popup menu and click Move Selected 
Processes To…. Please refer to the Figure 74. 

3) In the selection list under New Workplace select the workplace to which 

the new processes are to be assigned. 
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4) The previously assigned processes are displayed in the selected 
workplace. Select the process before which the new processes are to be 
inserted. The newly inserted processes are always inserted in front of the 
selected process. 

 

Figure 74: Move Processes to Dialog – Stations Selection List 

Two new processes have been assigned to Station 2 – left. Please refer to 
the Figure 75. 

 

Figure 75: Two New Processes assigned to Station 2 – left 

Move Selected Processes Here... 
As an alternative to the function Move Selected Processes To..., you can add 

selected processes directly to the balancing process list. 

 

Figure 76: Function Move Selected Process 

Proceed as follows: 

1) Select the processes which are to be added to another location. Single – 
multiple selection is possible here. 

2) Move the mouse pointer to the line in the Balancinglist where you want to 
insert the processes. 

3) Open the contextual menu by right clicking the mouse. Select Move 
Selected Processes To Here. The processes are then inserted. 

Cross-Highlighting for Processes 
Processes selected in the balancinglist are highlighted by cross-highlighting in 
the Balancing view, and vice-versa; processes selected in the Balancing view 
are displayed in the balancinglist as well as in the Precedence Graph view. 

To Show Cross-Highlight for Processes 

 

666...      
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1) Arrange both views on your screen (perhaps horizontally or vertically to 
each other). 

2) Select the process in the balancinglist. The selected process is displayed 
in the Balancing view. The example shows that additional information on 
the process, such as the process name, are highlighted in the 
balancinglist. 

 

Figure 77: Display of Selected Processes – Cross-Highlighting  

Removing Processes 
By means of the Unbalance menu item and the delete key on the keyboard, 

you can remove processes from the Balancinglist and the Balancing view.  

Processes that have been removed from these two views are assigned to the 
Process List and are shown on the Unbalanced Processes page as the last 

in the list of existing processes. 

To Remove a Process 

Select the process and open the contextual menu or press the delete key 
directly. In the contextual menu select the Unbalance entry. 

The Figure 78 shows removing of processes from the Balancinglist by means 
of the Unbalance menu item. 
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Figure 78: Unbalance Processes – Use of the Unbalance Menu Item 

6.5 Bar Graph View 

In the Bar Graph view, the balanced processes are represented as bars per 
station and workplace. 

This view does not allow editing; the Bar Graph view simply is a further display 
option for the Automatic Line Balancing function. 

If you plan several variants in one Automatic Line Balancing, all processes of 
the variants are shown side by side for each workplace. 

If you add new processes to the balancing list or move processes with this list, 
these changes in the bar chart will be automatically reconstructed. The 
columns indicate the processes. The column height corresponds to the 
process time and the continuous line corresponds to the defined takt time. 

This view is a read-only view. You cannot move a process directly in the bar 
graph view. When you selects a process in the Balancing 2D view, the same 
process get highlighted in the bar graph view. When processes are moved in 
other views, the bar graph view gets updated. No of workes in bargraph view is 
named “No. of Multi-cylces” in the workplace-view. 
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Figure 79: Bar Graph View 

Operation Time (min) 
The sum of all process times for a workplace is displayed in this field. Please 
refer to the Figure 79. 

Utilization (%) 
The utilization (%) for a workplace is displayed in this field. Please refer to the 
Figure 79. 

Idle Time (min) – Waiting Time 
The idle time for a workplace is displayed in this field. Please refer to the 
Figure 79. 

Number of Workers 
The calculated number of workers for a workplace is displayed in this field. The 
calculated result is rounded up to the next integer. Please refer to the Figure 
79. 

Takt time (min) 
The takt time is displayed in this field. Please refer to the Figure 79. 

6.6 Statistics View 

The Statistics view provides you with a statistical evaluation of the balancing. 
To evaluate balancing, you can use two information windows in the Statistics 

dialog. Please refer to the Figure 80. 

When balancing an entire system, you compare the minimal work load position 
to the maximum work load position. The scatter of the entire balancing will be 
specified and the result will be displayed with a standard deviation. Thus, you 
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will be offered another option to compare the results of different balancing 
processes. The Statistics dialog cannot be edited. 

 

Figure 80: Example – Statistics Dialog 

Information on the Statistics Dialog Boxes 
Project Data 
The project data line provides you with the following information, Please refer 
to the Figure 80. 

 Project: Project name in the Project field. 

 Balancing: Balancing prompt in the Balancing field. Automatic Line 
Balancing allows you to generate copies of a balancing. When you 
recalculate this copy and have thus generated a changed balancing with 
different performance data, you can save this balancing to a different 
prompt. Use the basic data tab in the performance data menu to change 

the prompt. 

 Takt time: This field displays the balancing process takt time in minutes. 

Workstations 
This field displays the number of specified stations of the entire balancing – 
divided up into automatic stations, manual stations, number of workers, and 
average utilization of a station. 

Utilization 
These two fields display either the minimum or the maximum utilization of a 
station. The workstation with the minimum utilization will be compared to the 
workstation with the maximum utilization. 

6.7 Workplacelist View 

In the Workplacelist view all stations are displayed, which have been 
determined during balancing, for example the station of a conveyor or a line. 
All process times, the efficiency of workplaces and the walkways of employees 
are displayed. The workplace list cannot be edited; corrections have to be 
made directly in the Automatic Line Balancing, for example in the Automatic 
Balancing view or in the process and resource structures Properties dialogs. 

Use the workplace list, for example, to recognize time portions that are not 
optimal or are too high with regard to walkways of a workplace or optimize 
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these time proportions or walkways according to the workplace list. When 
viewing the individual time portions, the actual working time is compared to the 
planned gross working time. When determining the efficiency, product variants 
are taken into consideration and are displayed in relation to their weighting. 

 

Figure 81: Example: Workplace List for a Line 

Every workplace list column can be sorted in ascending or descending order.  

Column Information of Displayed Workplaces 

Station 
When opening the workplace list, all stations are displayed in ascending order 
with their station name. Under Station all planned workplaces of a station are 

displayed, such as engine compartment/rear or workplace left. Please refer to 
the Figure 81. 

Time and Net Time 
The entry in the Time column corresponds to the sum of all resulting process 
times plus waiting times of a workplace. The entry in the Net Time column 

corresponds to the sum of all process times of a workplace that actually result. 
The time is specified in minutes. 

Efficiency and Efficiency at 100% 
The entry in the Efficiency column corresponds to the sum of all weighted 

process shares of a workplace. The weighted time is used to express how high 
the process share is at a workplace in order to be able to manufacture certain 
product variants. If, for example, a variant weighting of the process shares is 
50%, the weighted process shares would be 50% of the process time actually 
needed for a workplace on average. As a conclusion, this would mean that 
these processes could only be used with every second vehicle. As a rule this 
type of viewing is used for further planning in Automatic Balancing. 

 

Figure 82: Example: Variant Weighting for Product Variants 

The Efficiency 100% entry corresponds to the sum of the process times that 

actually result if they are executed. 

Walkway (m, min) 

In the workplace 
list all stations are 

displayed with 
workplaces, 
efficiency and 

specifications of 
the walkways in 

meters. 

Processes for variant V-
A would approximately 
correspond to that of a 

basic model. 

Processes for variant V-
B w ould approximately 

correspond to that of a 

certain product 
variant.  
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The walkways are specified in meters and minutes and correspond to the sum 
of walkways in meters and minutes for this workplace. 

Balancing Compensation (min) 
The displayed result for the balancing compensation is calculated based on 
the following formula: 

Formula: Balancing compensation = Net Time – Idle Time 

6.8 Workplace View 

The Workplace view displays all of the assigned processes. The header view 
displays the corresponding performance data, for example, takt time, 
utilization, and way time for the selected workplace. You can edit the 
workplace list (Please refer to the Figure 83). 

 Use the selection list to display any work station. (Please refer to the 

Figure 84). 

 Use the left mouse button to reassign processes in the work list. (Please 

refer to the Figure 85). 

The way time is the time a worker needs to get back to the starting point of the 
workplace after having executed the process. 

 In addition, the times of the value adding processes ((opr.timeVA(min)) 
and the non-value adding processes ((Opr. NVA (min)) are displayed 

along with the percent of their workload at the selected workplace.  

 

Figure 83: Example of a Workplace List 

Editing Selection List 

 

Figure 84: Workplace Selection List 

1) Use the left mouse button to open the selection list.  

2) Select the workplace from the selection list. 

Editing Workplace List 

 

Figure 85: Editing Workplace List – Reassigning Processes 

3) To reassign a process, left click the line of the process to be reassigned. 
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4) Use the left mouse button to move this selected process to the new line 
of the workplace list. 

Open Workplace View with the Info Button 
Every workplace has been assigned an additional button in the Balancing view 
which can be used to open the Workplace view directly. All functions are 
available for editing. 

5) Click Info button with the left mouse button to open the workplace view. 

 

Figure 86: Info Button for Workplace – Balancing View 

Moving Processes via the Contextual Menu 
You can directly move processes via the contextual menu of a selected 
process in the workplace list and assign them to a new workplace. This 
function is useful, for example, if the process to be moved is assigned to a 
station which at the moment cannot be displayed on the screen. Moving via 
the contextual menu works exactly the same way as when a process is 
manually moved in the job coordination view. 

1) Click Info button with the left mouse button to open the workplace view. 

2) Select the process to be moved and click the right mouse button.  

3) Select Move to.... 

 

Figure 87: Opening the Contextual Menu – Move to ... 

4) In the dialog Move Processes To you can select the station and 
workplace to which processes are moved under New workplace. 

5) Processes are always inserted in front of the selected process. If there are 
processes on the selected workplace already, you can select where the 
process is inserted. You have to select the process in order to do this.  

 

Figure 88: Dialog Move Processes to – Select Workplace 
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6.9 Group Overview View 

In the Group overview view, either all of the workplaces are displayed or each 
workplace is displayed separately. The workstations are displayed in a bar 
chart. The utilization of the individual workplaces is highlighted according to 
the resulting needs. The display of shares is divided up into value-added, non-
value added, and special equipment shares. In addition, the way time share 
will be displayed above each bar. 

If a large amount of special equipment is needed at workstations, the actual 
variant station time will vary considerably. The group overview offers you quick 
access to the balancing process data. You can use the group overview in 
workshops as a valuable aid or use it for local new planning in order to 
compare this with the previous balancing process. 

Starting Group Overview 
Before starting the group view, you have to decide whether or not to 
summarize the Group overview. 

1) Click Yes if you want to summarize the group overview. 

2) Click No if you do not want to summarize the group overview. 

  

Figure 89: Group Overview Selection Dialog 

Summarized Group Overview 
In the summarized Group overview, bars display the process shares of the 

respective workstations. Times are displayed on the Y-axis and workstations 
on the X-axis. The upper limit of the Y-axis represents the cycle time. The 
colored bars correspond to the time process shares of a work station. Time is 
displayed in minutes and corresponds to the sum of all process shares of a 
work station. 
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Figure 90: Example of a Diagram Summarized Group Overview 

Process Shares of a Work Station 
All times in the corresponding columns refer to the respective work station and 
the process share. 

 The way time is the time needed for the return path. 

 The NVA share corresponds to the non-value added process share time. 

 The VA-SA share corresponds to special equipment process share time. 

 The VA share corresponds to the value added process share time. 

Non-Summarized Group Overview 
In the non-summarized Group overview, bars display the process shares of 

the respective workstations. To print the result of the group overview in a 
station assignment table, use the Print button and the Automatic Line 

Balancing interface. 

 

777...      
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Figure 91: Example of a Diagram Non-Summarized Group Overview 

 

 

999...      
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7. Working with Automatic Line Balancing 

To work with fine balancing, you have to generate a process and resource 
structure in the Process Engineer PPR Navigator. Process and resource 
properties will be specified when these structures are generated. Use the 
Process Properties dialog to specify whether a process is to be linked to one 
or several stations. Moreover, you can use this Process Properties dialog 

(Body field) to specify where the processes will have to be executed on the 
vehicle. In Automatic Line Balancing only the workplace work areas are 
specified. In Automatic Line Balancing, you can specify a maximum of five 
workplaces. The work areas are assigned processes during the balancing 
process according to the definition in the Properties dialog. If the process body 
field is defined on the left, the process can also only be executed and assigned 
on the left side for the balancing. 

7.1 Supplying Data for Automatic Line Balancing 

Process Engineer structures and data described in the following section are 
needed for the work in Automatic Line Balancing. The structures are generated 
in the PPR Navigator. 

For more information, Please refer to the PPR Navigator Manual. 

Process Engineer Structures 
The following structures will have to be generated in the PPR Navigator: 

Resource Structure: The conveyor for which the stations are determined in 
Automatic Line Balancing is generated in the resource structure. The stations 
are determined and then displayed in the PPR Navigator.  
Product Structure: Products processed at the conveyors and stations are 
produced in the product structure. Transport bins are assigned products. 
Process Structure: Processes used to process products at conveyors and 
stations are generated in the product structure. A Process Graph, which is the 
basis for the Automatic Line Balancing Priority Graph, is created in the process 
structure. 
Specifying Links 
 Linking processes to products: according to process edited first product. 

 Linking products to bins: Resource provides product. 

Specifying Number of Pieces 
 Specifying number of pieces per bin. 

 Specifying number of pieces per process. 

Showing the Balancing Process with Filtered Objects 
You can use filters when opening projects. The structures of a project are 
displayed in accordance with the filters set. Filters also take effect on 
previously calculated or newly calculated balancing processes. 

Use filters to show a certain planning status. Filters in this case refer to code 
numbers, line numbers, effectivity, or label. Filters can be assigned, for 
example, to processes and stations. 

Potential Effects on a Balancing Process 

file:///C:/Documents%20and%20Settings/OUM/Application%20Data/Microsoft/Word/PPRNavigator.pdf
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 Processes which do not meet filter criteria are ignored in the balancing 

process, just as are stations which have an effectivity filter. 

 A filtered balancing process can only be saved anew with the Save As 

function - this corresponds to a new balancing process with another name, 
one which can be edited independently. Normal saving is possible only if 
the balancing process is unfiltered. 

Multi-Man Tasks in ALB 
Normally, multi-man tasks are used for manual tasks that cannot be handled 
alone, such as lifting and carrying heavy loads. 

A multi-man task is understood to mean a task needing at least two individuals 
to carry out. The relation for a multi-man task is planned in E5 by means of the 
Process Graph. A process is planned for each worker. All of the processes 
making up a multi-man task must start and end at the same time. 

An Example of a Multi-Man Task – Displayed in the Process Graph 
The following example shows the process relation of a multi-man task. In this 
example, two activities can be observed – gluing and setting a windshield. Two 
workers are needed to set the windshield. This task will be assigned as a 
multi-man task. 

 

Figure 92: Multi-Man Task – Displayed in the Process Graph 

Calculating the Start Time 
The calculation of the starting time for processes has changed as of the PE 
5.17 release. When changes were made to the process time in the old version, 
you were asked if the start time should be recalculated first. If recalculating 
was not carried out, a later recalculation was not possible.  

Starting with the PE 5.17 release, the prompt for recalculating start times has 
been removed. For instance, as the ALB is opened, the start time is 
automatically calculated when changes have been made to the process or 
stand-by time. These new calculations are made exclusively for all processes 
that follow. The processes in the foregoing stations are logically disregarded – 
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due to the fact that nothing has changed with regards to the start time for those 
processes. 

Selecting Process Graph 
To Select Process Graph 

1) Once the first balancing process has been created, a process graph 
should be selected from the Automatic Balancing - New dialog. The 

balancing of processes in ALB for stations and work stations is now 
carried out through the selected process graph. 

You can use the ALB-configurations to determine which process graphs 
should be displayed, so only the process graphs for a particular balancing 
process are displayed. The same applies for selecting a process graph, when 
adding product variants to an opened balancing process. Please refer to the 
Figure 93. 

For more information, Please refer to the Administration Manual and Process 
Graph Manual. 

 

Figure 93: Select the Process Graph Dialog 

2) Confirm the entries with OK. 

7.2 Creating a New Balancing Process 

To generate a balancing process, you can either use: user-defined or default 
settings. You have already become familiarized with the description of the 
Automatic Balancing dialogs that you have to edit when generating a balancing 
process. Please refer to the Balancing Main Menu. 

Note 

All workplace entries refer to all of the workplaces and stations determined for 
the balancing process. In Automatic Line Balancing, a maximum of 50 
workplaces per station can be generated. 

Manually Balancing Processes 
When creating the Automatic Line Balancing, you can decide whether the 
processes are to be balanced automatically, as previously, or if you wish to 
balance the processes manually. The following settings are not dependent on 

Restriction 

violations with 
the balancing 
process  

222555...      

file:///C:/Documents%20and%20Settings/OUM/Application%20Data/Microsoft/Word/Administration.pdf
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the procedure chosen – you can additionally determine whether the processes 
are to be balanced on the basis of user definitions or with the standard 
settings. Please refer to the Efficient use of the Process List for Automatic Line 
Balancing. 

To Balance the Process 

1) Click No if you wish to balance the processes manually. 

2) Click Yes if you want to balance the processes automatically. 

 

Figure 94: Message – Balance Processes Automatically or Manually 

Generating Workplaces using the Default Setting 
With the Default setting selection, you do not have to specify each workplace. 
In Automatic Line Balancing, workplaces and stations are determined 
automatically by the program. Please refer to the Balancing Main Menu. 

 

Figure 95: Selecting Standard Default Setting of Balancing Process 

To Generate Workspace using the Default Setting 

1) Click the Default setting field in the dialog. 

2) Select the number of workplaces. Workplaces are highlighted. Please refer 
to the Figure 95. 

Note 

There are default configurations available for 1 to 5 and 1 to 50 workplaces. 
These standard configurations apply to general automotive and aerospace 
applications. 

3) Enter the performance criteria and click Run in the dialog. Please refer to 
the Figure 25. 

Generating User-Defined Workplaces 
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With a user-defined balancing process, each generated workplace specified in 
Number of workplaces in the dialog must be defined individually i.e. the 

workplace with all work positions must be specified exactly. In Fine Balancing, 
you can define a maximum of five workplaces. Each specified workplace is 
highlighted, too. 

 

Figure 96: Example of a User-Defined Balancing Process 

To Generate User Defined Workplaces 

1) Specify the number of workplaces in the Number of workplaces dialog. 

There are three workplaces in the example. Please refer to the Figure 96. 

2) Click User-defined field. 

3) Confirm the entry with OK. After that you can specify the first workplace. 

Specifying Workplaces one after Another 
In the Work areas dialog, each workplace is defined. You have to specify work 

positions (there are three in the example) for each workplace. A balancing 
process cannot be calculated unless each work position offered (Please refer 
to the Figure 97) has been enabled at the last workplace at the latest. 

Work positions of single workplaces may overlap. This means in practice that 
work positions on the vehicle can be executed from different workplaces. 

The work area for the vehicle workplace is defined by the number of work 
positions. 

Note 

You do not necessarily have to select the “car body” example used in the 
dialog (picture of car body for specification of work positions). Thus, you can 
profit from the variety of products used in Automatic Line Balancing.  

For more information on replacing pictures, Please refer to the Administration 
Manual. 

Specifying First Workplace 

Use checkmarks to specify the work area. Please refer to the Figure 97. 

 

 

222999...      
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Figure 97: Example of First Workplace 

Work positions are specified in the car body figure with the definition of a 
workplace. 

1) To specify the work positions, checkmark the fields in Select body points. 

(Please refer to the Figure 97). 

2) Enter a name for the workplace so that the workplace can be assigned 
in t he balancing process. 

3) Each workplace will be highlighted in the Automatic Balancing view. Use 
the Color button to select the workplace color. 

 

Figure 98: Selecting Workplace Color 

4) Click Continue in the dialog to define the next workplace. Please refer to 

the Figure 97. 

Specifying Second Workplace 
Proceed as with workplace 1. 

5) After clicking Continue, you can make your entries for Workplace 2. 

In the example, the rear area is defined as Workplace 2 The initial work 

position specification view is empty and therefore does not contain the work 
positions specified for workplace 1. 

This is due to potential overlapping of work positions. Continuing with this 
example, you could also now assign work positions to workplace 2 that had 
previously been assigned to workplace 1 (Please refer to the Figure 97). 
Workplaces that have not yet been assigned a work position will not be 
displayed until the last work position has been reached. Please refer to the 
Figure 100. 

Specifying the 
first user defined 
workstation 

333111...      
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Figure 99: Example of Second Workplace 

6)  To make changes at this stage, click Back to return to the previous  

workplace. 

Specifying the Third Workplace 
The three checkmarks indicate work positions not yet enabled. 

7) You will have to assign these three unassigned work positions. 
Workplace 3, Front area, is assigned these positions. Please refer to the 

Figure 100. 

 

Figure 100: Example of Third Workplace 

Third Workplace with Overlapping 
This example shows an overlapping of work positions. Work positions marked 
in the red box can be executed at workplace 1 and workplace 3. Please refer 

to the Figure 101. 

 

333555...      
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Figure 101: Example of Overlapping 

Error Messages in Automatic Line Balancing 
When automatically calculating a balancing process, Automatic Line Balancing 
accesses process structure data stored in a database. During the calculation, 
data are checked for potential restriction violations. 

Automatic Calculation Completed 
This message appears whenever you calculate a balancing process. 

 

Figure 102: Execute Consistency Check after Calculation 

Three Restriction Violation Types 
a) Errors in Station Linkage 

This message only appears during an automatic balancing process and if there 
is a clear priority relation with an existing station linkage between the 
processes. This message will appear if the succeeding process has station 
linkage to a lower station number than the preceding process. Station linkage 
for this process will be temporarily deleted for the balancing process, but will 
continue to exist for the process. 

 

Figure 103: Message – Error in Station Linkage 

 

 

444222...      
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Solving the Problem 
During calculation, this message does not allow you to make any corrections. 

 Close the balancing process without saving. 

 Check the station linkage in the Process Properties dialog. 

 Start the balancing process again. 

b) Missing Work Positions 

This message will only appear with a user-defined balancing process if the last 
workplace is still to be assigned work positions – in other words before 
calculation is started. 

Click OK button. The next step is to specify the missing workplaces. 

 

Figure 104: Restriction Violation when Generating a Balancing Process 

c) Station Linkage is Larger than 500 

Up to 500 stations can be generated in Automatic Line Balancing. This 
message will appear if a station linkage larger than 500 is entered in a process 
in the Properties dialog. 

During the calculation process, station linkage will automatically be deleted. 

Solving the Problem 

 Close the balancing process without saving. 

 Check the station linkage in the Process Properties dialog. 

 Start the balancing process again. 

 

Figure 105: Restriction Violation due to too Large a Station Linkage 

7.3 User Defined Attributes 

1) Open ALB in a New Line. Please refer to the Figure 2. 

2) Go to ALB Main Menu > View > Click Process List/ Balancing List/ 
Workplace. 

The user defined attributes are displayed in different columns as Attribute1, 
Attribute_2. 

Restriction violations 

with the balancing 
process  
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Figure 106: User Defined Attributes 

To Create and Configure User Defined Attributes 

3)  Open the ALB Configuration, Right-click DPE project > Extra > Balncing 
ALB Configuration > ALB Customization. The ALB Customization 

dialog box appears. 

 

Figure 107: ALB Customization 

4) Select tab Plan type Forms > Process >  button. 

5) The Attributes Configuration dialog box comes. 

 

Figure 108: Attributes Configuration 

6) Click New/Edit to create\edit your own attributes. All the existing attributes 
under the Column Attribute Name are by default for the process. The 
Configure ALB Attribute dialog box comes. 
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Figure 109: Configure ALB Attribute 

7) Select attribute name from the drop-down list. Select the option Show in 
Dialog and enter other details. 

The value of Name will be used as column name in list view. 

8) Click OK. 
You can see the created attribute in the attribute list in the Attributes 
Configuration dialog box. 

9) After creating user defined attributes, make sure that all created attributes 
created are visible in DPE Configuration (DPE browser and editor). 

 

Figure 110: DPE Configuration 

10) Enter the data for new attribute in all the processes under the work plan.  

 

Figure 111: Entering Data for New Attribute 
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11) Similar configuration settings have to be made for all the user defined 
attributes created and data has to be entered in DPE before ALB is 
opened. 

7.4 Reusing Existing Balancing 

Reuse the existing balancing and save that as a new line for a different 
product variant or for a different TAKT time.  

Reusing Existing Line for another Product Variant 

Assume that data includes two product variants PV1 and PV2. Balancing is 
done for PV1. To reuse the balancing done for PV1 and save the balancing for 
PV2 as Line, perform the following steps: 

1) Open Balancing for product variant PV1. 

2)  Go to Balancing > Product variants > Add product variant 
This assigns all identical processes to the same stations and unbalanced 
the remaining processes. 

3) Go to Balancing > Product variants > Remove product variant to 

remove the product variant PV2. 

4) Go to Project > Save as and save the balancing as Line. 

Reuse Existing Line for different TAKT Times with One Product Variant 

Use the existing balancing i.e. keeping the same process sequence as well 
same station assignment for one or more product variant, when the takt time is 
changed and saved it as a different line. Also if there are some unbalanced 
processes then changing the takt time does not balance the unbalanced 
processes. 

1) Load one product variant in ALB. 

2) Change the process sequence and save the line. 

3) Go to Tools > Options >Setting and un-select the Manage unassigned 
stations automatically check box. 

4) Go to Balancing > Base Data. 

5) Increase the takt time(min) in Parameter for ALB dialog box and click 
OK  

This helps to include other station process in one station and also 
maintains the process sequence and station assignment. 

6) Go to Project > Save as and save the balancing as Line. 

7) Decrease the takt time(min) to overallocate the workspace and click OK. 
ALB does not adjust the over allocated process in different workplace and 
maintain the same process sequence and station assignment 

8) Go to Project > Save as and save the balancing as diffenent Line. 

Reuse Existing Line for different TAKT Times with Two Product Variants 

1) Open ALB with one Product variant and save the line.  

2) Add one more variant. 
It balance all identical process and add remaining process to the 
unbalanced pool. 

3) Go to Tools > Options >Setting and un-select the Manage unassigned 
stations automatically check box. 
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4) Go to Balancing > Base Data. 

5) Increase the takt time(min) in Parameter for ALB dialog box and click 
OK  
This helps to include other station process in one station and also 
maintains the process sequence and station assignment. Also it does not 
balance the unbalanced processes. 

6) Go to Project > Save as and save the balancing as Line. 

7) Decrease the takt time(min) to overallocate the workspace and click OK. 

ALB does not adjust the over allocated process in different workplace and 
maintain the same process sequence and station assignment. Also it does 
not balance the unbalanced processes. 

8) Go to Project > Save as and save the balancing as diffenent Line. 

7.5 Displaying Processes 

In Automatic Line Balancing, processes are displayed in the Automatic 
Balancing view according to their significance in relation to the planning. As a 
basic rule, the following applies to all types of display: A process is always 
marked by the process number. 

Understanding the Display of Processes and their Meanings 
In Automatic Line Balancing, processes are classified according to their usage. 
The different process usage types are as follows: 

Process for Two Workplaces 
If a process is displayed in a grey rectangle with a designation in black, this 
process can be executed at two workplaces at least. 

 

Figure 112: Process Display – for at Least 2 Workplaces 

Displaying Processes for Special Equipment Parts 
If the weighting of a process is less than 100%, ALB automatically assumes 
that this process is to be used for special equipment parts. These processes 
are marked by a red box in the job view. 

 

Figure 113: Process Display – Processes for SA Codes 

Process with Station Linkage 
Processes that can only be executed at one or at specific stations, are marked 
by a rhomb. 

 

Figure 114: Process Display – Processes with Station Linkage 

Process for a Workplace 
Processes which have to be executed at one workplace only are displayed in 
the workplace color. Hence, you will already see whether a workplace can be 
assigned this process as soon as you move a process. 
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Figure 115: Process Display – for one Workplace only 

Processes for Automatic Stations 
Processes for automatic stations are displayed in a rounded rectangle.  

 

Figure 116: Process Display for Automatic Station 

7.6 Restriction Violations during Manual Editing 

You can edit a balancing process manually in the Automatic Balancing view. In 
manual editing, this generally means that you manually assign the processes 
to other stations or workplaces subsequently in the Automatic Balancing view 
after the balancing process has already been calculated. In Automatic Line 
Balancing, these actions are automatically checked. A message will appear if 
restriction violations appear during manual editing. 

Coping with Restriction Violations 
After moving a process, Automatic Line Balancing checks whether a restriction 
violation occurs in the new assignment. 

If no violations are detected, Automatic Line Balancing will newly plan the 
stations concerned. The new station assignments and the associated changes 
in utilization will immediately be calculated and displayed graphically. In 
addition, Automatic Line Balancing ensures that the material is always directly 
assigned to the workplace where the corresponding process is to be executed. 
Material can be supplied either to the right or to the left of the station for 
processes executed in the central area of the station. A change of the process 
station assignment can thus lead to changes in material supply. 

Potential Restriction Violation Types 
An error message containing a description on the cause of error will appear if 
there are restriction violations during manual editing of the balancing process. 
There are several different restriction violation types in Automatic Line 
Balancing. 

Read these messages carefully and use this information for your work. An 
error message may indicate several restriction violations simultaneously. If you 
confirm a message by clicking Yes, the process will be moved. Please refer to 
the Figure 117. 
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Figure 117: Overview – Four Restriction Violations 

Wrong Area Message 
This message will appear if a process has been determined for another work 
area in the Properties dialog. 

 
 

Figure 118: Restriction – Wrong Area Message 

Priority Relation Corrupted Message 
This message will appear if, during movement of a process, a priority relation 
is violated. In the Process Graph, the process priority relations are generated 
by the process structure. 

Editing restriction 
violations. 

Editing restriction 

violations  
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Figure 119: Restriction – Priority Graph Relation Violated Message  

Corrupted Priority Relation in a Workplace Message 
This message will appear if a priority relation to a further process within a 
workplace is violated while moving a process within the same workplace. 

 

Figure 120: Restriction - Priority Relation within a Workplace Violated – Message 

Station Linkage Violated Message 
This message will appear if a station linkage is violated during the movement 
of a process. The process station linkages are specified in the Properties 

dialog. 

 

Figure 121: Restriction – Station Linkage Violated Message 
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Wrong Station Type Message 
This message will appear if a station is to be assigned a process that cannot 
be executed at the corresponding station during movement of a process; for 
example, if an automatic station is assigned a manual process. 

 

Figure 122: Restriction – Wrong Station Type Message  

Material cannot be Placed Message 
This message will appear if there is not enough space for material supply after 
movement of a process. 

 

Figure 123: Restriction – Material cannot be Placed 

Station Height is not Observed Message 
This message will appear if the station height defined in the process Properties 
dialog is not observed while moving the process. Please refer to the Moving 
Processes – when Station Height is defined Differently. 
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Figure 124: Restrictions - the Process is Assigned to a Wrong Station Height 

Moving an Operation having Process Assembly Process Link 
It is not possible to move an operation having the Process Assembly 
Process link. A warning message appears if an assembly operation having 

this relation is moved. 

Configure “proc_assembly_proc” Relation in Configuration Tool 

1) Open configuration tool (ctrl +G). 

2) Open Process Component (Ergocompprocessdefault) and expand node 
“Parent Child Relations”.  
Two new relations ergocompprocessdefault::proc_assembly_proc and 
ergocompprocessdefault::proc_assembly_proc_reverse exist.  

3) Expand ergocompprocessdefault::process_mustprecede_process under 
“Parent Child Relations”. Copy ergoexplorer-projects, ergoexplorer-
projectlibrary & graph-processes and paste it on 
ergocompprocessdefault::proc_assembly_proc. 

4) Similarly, again expand 
ergocompprocessdefault::process_mustprecede_process. copy 
ergoexplorer-projects & ergoexplorer-projectlibrary and Paste it on 
ergocompprocessdefault::proc_assembly_proc_reverse. 
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Figure 125: Configure Process Assembly Process Link 

Assign proc_assembly_proc” Relation to the Operation 

5) Open a project, create a workplan and under workplan create operation 
and AssemblyOperation. 

 

Figure 126: Project Structure 

6) Drag and drop OP4 on ASM2 and select the new relation Process 
Assembly Process. 

 

Figure 127: Relate Message 
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Change ALB Customization to Load Multiple Types of Assembly 
Operations 

7) Change process type value as AssemblyOperation or Operation in ALB 
Customization dialog box. 
Processes whose type name is AssemblyOperation are loaded. If you 

specify Operation then only Operations will be loaded. To load both 
“AssemblyOperation” and Non “AssemblyOperation”, change the process 
type attribute as identifieralb and give value as alb. 

 

Figure 128: ALB Customization Changes 

8) In System Library, open all those operation type that need to be loaded 
and set identifieralb as alb. 

 

Figure 129: Set Identifier ALB 

Move Process 

9) Move Operation OP1 after Assembly Operation ASM1.  

A warning message appears informing that it is not possible to move the 
operation as there exist a relation Process Assembly Process. 

 

Figure 130: Process Movement Constraint 
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7.7 Manual Editing of Automatic Balancing 

New workplaces can be assigned processes in the Automatic Balancing view. 
The aim of this procedure is to optimize the calculated balancing process. 
Processes are always moved by drag and drop in Automatic Line Balancing. 

Note 

If the material supply area of a station is blocked during manual editing, this 
station will not be deleted automatically. 

The same applies if the following option is enabled: Empty stations will 
automatically be deleted if the automatically manage unassigned stations 

function is enabled in the settings dialog (Please refer to the Figure 43.) 
Optimising the balancing process. 

To manually edit the Automatic Balancing view, you can also use the Windows 
technique in the Window menu in Automatic Line Balancing. 

1) Select side by side in the Window menu to display the Priority Graph and 

Automatic Balancing view side by side on the screen. 

2) If you select a process in automatic balancing, this process will also be 
selected in the Priority Graph view. 

3) You can maximize or minimize the Priority Graph and Automatic Balancing 
views. 

Process Performance Data 

4) In one of the two views, move the left mouse button to a process to display 
the most important process performance data for a process. 

 

Figure 131: Displaying Performance Data for Process 

Material Supply Performance Data 

5) Move the left mouse button to a bin on the material supply area and 
double-click it to view the performance data. Please refer to the Figure 
132. 
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Figure 132: Displaying Material for a Process 

Process Properties Dialog 
Data are entered in the Properties dialog while generating the process 
structure in the Process Engineer. 

This dialog will specify the following criteria: 

 The body field will specify where the process is to be executed on the 

vehicle. 

 The value-added field will specify the valued-added share of a process. 

 The station linkage field specifies whether or not a process is to be 

permanently linked to one station or several stations. 

Process properties cannot be edited in the Automatic Balancing view. 

1) To open the process Properties menu, double-click a process in the 

Automatic Balancing view. 

2) Operating equipment as well as bins for material supply can be assigned 
processes. You can edit these in the corresponding dialogs. 

Material Supply – Operating Equipment 

3) Click one of the two tabs – Material supply/operating equipment to open a 
properties dialog (Material supply/Operating equipment) to open a 
Properties dialog. If material or operating equipment is already assigned, 
double-click the window line displayed. Please refer to the Figure 133. 
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Figure 133: Process Properties Dialog 

Displaying User Defined Attributes in the Properties Dialog 
With the aid of user defined attributes, the user can display additional useful 
attributes in the properties dialog of the process. These attributes can contain 
additional information for the process, in this example for instance, the base 
time, Author, and classification attributes are visible. These attributes are for 
information purposes only. 

For more information about the configuration attributes, please refer to the 
Administration Manual. 

file:///C:/Documents%20and%20Settings/OUM/Application%20Data/Microsoft/Word/Administration.pdf
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Figure 134: User Defined Attributes 

Showing Station Properties 
The properties of a station can be shown. In the Properties dialog the station 
type can be re-determined as well. In addition, there is the possibility to 
change the working height (station height) of the body in the station from low to 
high. The working height of the body determines in which position the 
processes are executed at the body. 

Opening the Station Properties Dialog 

1) Double-click station field to open the Properties dialog. Please refer to the 

Figure 136. 

 

Figure 135: Open the Properties Dialog by Double-Clicking  

 

Figure 136: Properties Dialog for a Station 

2) Define the Station Type and Height. 
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During Automatic Line Balancing each station is assigned the Station type 
and Station height of the first process assigned to the station. For instance, if 

the first process assigned is performed manually and the station height is set 
to high, the station is assigned to the Station type manual and the Station 
height high. Both attributes, station type and station height are defined in the 

properties dialog of a process. 

The same applies to manual editing of stations. For instance, if you manually 
add a station and assign the first process manually to the new station, the 
station will likewise be assigned the two attributes of the process assigned. 

The attributes defined in the properties dialog of a process are not changed 
when the Station height or Station type are altered. The attributes of a 

process remain unchanged, even if a manual process should be assigned to 
an automatic station. 

3) To change the station type, click one of the two fields – 
automatic/manual. Upon opening of the properties dialog, the station type 

assigned to this station during line balancing is displayed. 

4) To change the station height of the vehicle, click one of the fields. Upon 
opening of the properties dialog, the station height assigned to this station 
during line balancing is displayed. Please refer to the Figure 136 and Table 2. 

Violation of Restriction - Assigning Processes Manually to a 

Station 
If you try to assign a process to a station that has different attributes than the 
process, a warning message will be displayed that a violation of restrictions will 
occur. You may then decide if you wish to assign the process to the station 
anyway. Such violations are also displayed upon a consistency check. Again 
the following applies: the attributes of a process are not changed. 

Moving Processes 
Processes are manually moved by drag and drop. The left upper corner of 

the process plays an important role in moving a process. 

When moving a process which is to be inserted directly in front of another 
process, the left upper corner of the process you want to move must be placed 
on the other process. 

The Automatic Line Balancing plans the processes according to the relations 
set in the priority graph and distributes these processes to stations and 
workplaces. The sequence thus determined always results in the processes 
being created in a sequence set in the balancing process. 

If you now move a process, for example one of from a previous station to a 
subsequent station, this process is inserted into the station at the beginning of 
the already present processes. This principle is also used in the other way 
around; if a process from a subsequent station is moved to a previous station 
this process is inserted at the end of the already present processes of the 
station. 

The directions in which the processes are moved therefore play an important 
role. This principle is nullified if you place a process which is to be moved on 
another process with the left upper corner. 

How to Ensure that you do it Correctly 
You want to insert the process in front of the other: 

1) Select the process you want to move. 

2) Ensure that the left upper corner is placed on the process before which 
this process is to be inserted. 
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Figure 137: Moving Processes Manually – Placing in Front 

 

Moving Processes – when Station Height is defined Differently 
When the following preconditions are met, you can move processes without 
receiving the message wrong height: Please refer to the Station Height is not 

Observed. 

The station height for the respective processes and stations are defined in the 
Properties dialog. Processes with defined station heights can easily be moved 

according to the schematic shown in the Table 2. 

Table 2 shows the possible assignments of processes to stations with working 
heights that you can assign to the stations without a violation of restriction 
occurring. 

 You can, for example, move processes of which the working height is 
defined as low to stations of which the working height is defined as very 

low, low, and medium. 

 However processes of which the working height is very low can be moved 

only to stations of which the working height is defined as low or very low.  

Assignment of Processes with Defined Working Heights to 

Stations 

Table 2: Schematic – Assigning Processes to Stations 

Stations Very Low Low Medium High Very High 

Processes      

Very low X X    

Low X X X   

Medium  X X X  

High   X X X 

Very high    X X 

Showing Processes 
In the Automatic Balancing view, you can highlight the dependencies between 
processes and assigned bins graphically. 

Graphically Highlighting Processes 
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1) Move the mouse pointer slightly over the bin. The assigned process will 
be selected and highlighted. Please refer to the Figure 138. 

 

Figure 138: Highlighting Processes 

Highlighting Bins 
Move the mouse pointer slightly over the process. The assigned bin will be 
highlighted. Please refer to the Figure 139. 

 

Figure 139: Highlighting Bins by Colors 

7.8 PMS Features 

7.8.1 Parallel Stations 

Parallel Stations are indicated using the nameshort (or any other attribute 
mapped to that meaning in the ALB configuration). The same value list stored 
in the sortindex attribute of the PC relation to the line. A non-parallel station 
has an whole-numbered value, whereas a parallel station has a fractional 
portion. Examples: Station 1 is non-parallel, Station 2.1 has parallel stations. 
Station 2.2 is the first parallel station of station 2.1. 

The first of parallel stations is positioned as usual in the line. The next parallel 
stations are positioned in the 3D space right to the first parallel station. 
Processes, shelves, and part bins are linked to each one of parallel stations as 
with normal stations. When saving, ALB keeps the positions of the existing part 
bins and shelves. When saving a new parallel station for the first time, the 
relative positions of part bins and shelves are taken from the first station. 
When part bins are assigned during work in ALB, ALB position these 
resources at an initial position in the material are. 

The takt time is calculated by multiplying the takt time by the number of parallel 
stations. 

To create parallel stations, first duplicate a station in the manufacturing 
concept. 

To Create Duplicate Stations: 
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1) Open contextual menu by right-clicking the New Test Station and select 
Split. The Split Symbol dialog appears. 

2) Enter the number of duplicate stations to be created in Quantity. 

3) Press OK, connect the stations and move to appropriate places, the result 

looks like this in MC. 

 

Figure 140: Duplicate Stations 

To Create Parallel Stations: 

1) Create a new ALB line and name it as Parallel Station. 

2) Right-click new created station and select Application < Create Children 
on ALB Line. 

3) Enter station number to be created in Quantity field in Create Multiple 
Children dialog. 

4) Right-click new created station and start ALB via Balancing < Open ALB 
Balancing. 

5) Select a workplan which should be balanced. 

6) Enter takt time and balance the processes automatically in Product 
Variant Properties dialog. 

7) Right-click station in ALB and use command Parallel stations from the 
contextual menu, or use Station properties dialog. Enter number of 
parallel stations in Parallel Stations dialog. 

The yellow station triangle in the 2D view becomes orange and number of 
parallel stations created is written as [ ] in the triangle. 

When the dialog creates parallel stations, the name of the original station is 
used as base name and a number is appended with a dot to the base name. 

View Duplicate Stations 

 Balancing 2D: When the corresponding line is opened in ALB, parallel 

stations are marked by an orange triangle (normally the triangle below 
each station is yellow) in the Balancing 2D View. When moving a process 
from one station to the other, ALB needs to care for the length of the 

process, as this is changing dependant on the takt time of the station.  

 Bar Chart: The respective takt time is shown in the bar chart. The scale 
(on the left) is used for each station and each PV. There is separate line for 

the takt limit in each station. 

 Balancing List: The entry for the Workplace displays the actual takt time 

of the station. 
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 Workplace View: The header shows the actual takt time of the station. 

7.8.2 Layout Planning: Takt Time per Variant 

You can balance the same variant with different takt times and see the result in 
one view. You can also find the best fitting takt time. Two variants can be 
balanced at the same time, each with a different takt time. 

1) Create a new line. 

2) Right click on the new line and select Application < Create Children on 
ALB Line 

3) Enter station number to be created in Quantity field in Create Multiple 
Children dialog. 

4) Open the balancing on this line; choose process graph. The Product 
Variant Properties dialog appear, via Balancing < Product Variants < 
Properties. 

 

Figure 141: Product Variant Properties Dialog 

5) Enter takt time for the loaded product variant. 

6) Click vary takt time to enter a new takt time. 

7) Click Balancing < Base Data to show the parameters. The Parameters 
for Automatic Balancing dialog appears (two fields are disabled in PMS 

mode: max. capacity and drift bound are not applicable in the PMS 
context). The takt time is same as entered in Parameters for Automatic 
Balancing dialog. 

8) Run the automatic algorithm 

9) Save the balancing 

Display of Takt time 
 2D View: The length of the station represents the takt time. The lengths of 

the processes have to be scaled correctly to the takt time of the according 

product variant. 

 Resource Bar Graph and Bar Graph: The takt line (red for active variant, 

grey for inactive variants) must be according to the given takt time. 

 Balancing List View: Check the utilization of work contents and the 

working units. 

To Add Product Variant 

1) Open the balancing 

2) Click Balancing < Product Variant < Add Product Variant. 

3) Choose product variant in Load Product Variant dialog 
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4) In the Product Variants Properties dialog, check that the takt time is set 

to the takt time of the main variant by default. Distribute the weight evenly 
(sum 100%) and click OK. The dialog asking for automatic balancing the 
new PV appears. 

5) Click Yes to continue with automatic balancing the new PV. 

6) The added variant is balanced automatically: all identical processes 
known by ALB from the first PV are balanced at the respective position 
(identical to the first PV). All newly introduced processes stay in the list of 
unbalanced processes. The following dialog shows the result. 

 

Figure 142: Result Dialog 

7) Check if the processes of the added product variant are balanced 
correctly. That means, that the identical processes have to be balanced to 
the same workplaces, and all other processes have to be put to the 
unbalanced processes pool. 

8) Assign all other processes to workplaces of your choice. 

9) Save the balancing. 

7.8.3 Layout Planning: Use Template Processes 

You can create non-value adding process inside ALB. You can select 
processes from a process standard library, where some basic process types 
are defined. For example, these basic types could be Walking or Cleaning. 

When you want to create a non-value adding process in ALB, select a process 
from the library. Then insert the process with drag and drop in the workplace. 
A new process is created inside ALB as a copy of the Standard Process. The 
Standard Process remains in the Process Library and can be instantiated 
another time. To check the process properties, open the properties dialog by 
double clicking the process in the library view. 

Structure of the standard process library 

In this library, there can be stucture elements, for example to have all walking 
processes below a main node “Walking”. 

There are some rules how the standard library must be build:  

 All elements beyond the main library node, which have the same plantype 

as defined for Standard Processes, are read. 

 Elements, which have children, are recognized as structure elements. 

 Elements, which have no children, are recognized as Standard Processes. 

To Insert a Standard Process from the Standard Process Library 

In ALB, you can access the Standard Process Library, after pressing the 
button Standard Processes in the Process List: 
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Figure 143: Standard Process Library 

If you needs additional information you can double-click the process to see the 
properties dialog. You can select a Standard Process from this list and insert it 
with drag and drop into a workplace in the Balancing List. 

Note 

The process is not removed from the Library, a copy of the process is created 
in ALB. When storing the balancing to the Hub, a link is created from the 
Process in the Library to the respective resource. 

The standard processes that are inserted into a balancing from the process 
library must be copied into the project and linked to the according workplace 
(like all other processes are). TSAs are also created for these processes. The 
standard processes get a special flag, so that ALB can detect these processes 
as standard processes when a balancing is loaded. This is the identifier “PS” 
on the attribute “internalbalancingdata”. 

There is a check box in ALB configuration dialog to enable or disable Standard 
Processes feature. Please refer to Figure 43. 

CUSTOMIZATION 
The plantypes for the Standard Processes and the Standard Process Library 
must be defined in the E5 library in the ALB plantypeset. 

1) A new plantype for the Standard Process Library must be created (i.e 
Standard Process Library derived from OrgProcess). 

 

Figure 144: Plantype for the Standard Process Library 

2) The child process is specified. 

In the ALB Customization dialogue there is a new entry for the Standard 
Process Library. The behaviour of this entry is identical to the already existing 
entries. 
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7.8.4 Multiple Activity Chart: One Worker Working in 
different Workplaces 

Earlier there was a 1:1 relation between workplace and worker (In the 
exceptional case of a multicycle workplace this was n:1). Now a worker can 
work on two different workplaces/stations. You can assign active resources to 
the stations inside ALB and can also create and delete active resources inside 
ALB. 

If ALB is used in the context of the Standardization Scripts, then the PMS 
mode of ALB should only be set, e.g. the script to create valid station 
structures for ALB is mandatory for the workflow in PMS mode. 

If the PMS mode is not set, then ALB is automatically in FAL mode. 

To Create a New Balancing 

1) Right-click the resource structure and create a new line. 

2) Right click new created ALB line and click Application < Create Children 
on ALB Line. Enter details in Create Multiple Children dialog box. 

3) The script creates the stations together with one worker and one machine. 
The created structure below the line looks like this: 

 

Figure 145: New Created Stations 

3) Open ALB on the line. Check in the 2D Balancing View, all work 
contents are shown. The active resource type (Machine or Worker), time, and 
name of the active resource are displayed in each work contents. For all 
stations there is one worker and one machine. 
The usage of the script to create the resource structure is mandatory. If you 
create a faulty resource structure then ALB provides necessary information 
and informs what was wrong when you started. 

Assignment of Active Resources to Stations 

1) Click Balancing < Worker/Macine Assignment.  
The Working Unit Assignment dialog box appears. 
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Figure 146: Working Unit Assignment Dialog 

When the dialog is opened on the left side there are the active resources 
available, on the right side there are the stations with the current assignments 
listed. You can use drag and drop to connect active resources to stations. 

2) Select the active resource and click Delete button to delete an active 

resource. 
If the selected active resource is still assigned to a station then the active 
resource is not deleted. You would get a message to remove the 
assignments first. 

3) Click New to create new active resource. In the opening dialog you can 

select, which kind of active resources should be created as well as its 
name. 
It is not possible to create an active resource with a name, which is 
already used for another active resource. 

Connect/Disconnect active resource to station: An active resource can be 
connected to a station via drag and drop. The active resource can be dropped 
on a station or on a place within a station: 

 Select an active resource and drag it to the desired place in the station. If 

there is already an active resource, it is replaced without further notice. 

 Select one active resource and drag it to the desired station on the right 
area. The active resource is added to the first unassigned place. If there 
are no unassigned places, there is a message that the assignment would 

not take place. 

To disconnect an active resource, select it and click Delete in the station‟s 
button area. When the dialog is left with Ok, active resources which are not 

connected to any station are deleted. 

4) Select an active resource in the Workers and Machines List and click Edit 

to rename the selected active resource. 
You cannot change the Type. You cannot choose a name, which is 

already used for another active resource. 
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In the resource bar graph view and see multiple assignment of active 
resources to stations. The worker 1 is assigned to 2 Stations (Station 1 left and 
Station 2 left). 

If you delete a worker and machine from station, the work content and 
machine assigned to the deleted worker, is not present anymore. The process 
from that work content has been moved to the unbalanced processes list. 

Parallel Stations 

Parallel stations require the same number of active resources. The dialog 
cannot be left with OK, if there are parallel stations which differ in the number 

or the places of assignment of active resources.  

ALB Customization 

The Plantype “Machine” is added to the ALB Customization. Remove the 
ispms attribute from the balancing. Now you are in FAL mode. Start the 
balancing from a line or create a line yourself and start ALB from there. The 
menu entry for the assignment of active resources to stations is not there. 

Note 

Each of the two modes in which ALB can be run - mode FAL and mode PMS - 
is based on a specific DPE data model. As a consequence, a balancing which 
was created for PMS mode cannot be loaded in FAL mode and vice versa. 

DPE Datamodel for PMS 

The resource structure for the work content located under the Stations is 
changed for the DPE Data Model for PMS. In the new model, machine is 
introduced as a working Unit like a Worker. Worker and Machine are direct 
children of the Station. A Station can have machines and/or workers as 
children. Operations (Processes) are assigned to the Worker/Machine by 
Relations of  type “proc_runningon_plant”. Additionally, all Processes which 
are assigned to a Worker or a Machine in a Station, have to be linked to the 
Station by “proc-runningon_plant” relations. 

The names of the workers and machines used for one balancing have to be 
unique. This is verified when loading the balancing: If this restriction is broken, 
the load would not succeed. 

Machine and Worker have a red frame and are managed by ALB. 

The Behavior for a Worker as well as TSA‟s is not part of the Data Model any 
more. Data structures for material area, shelves, and part bins are identical in 
both PMS and FAL model. 

DPE data models comparison for the FAL and PMS modes: 

 In PMS mode no need to load/save Workplaces (they are created internally 
in ALB). As children of a Station you have to load its Working Units, 
Workers, and/or Machines. 
Additionally we need to load the Relations of type “proc_runningon_plant” 
which link the Working Units with the related Operations. 

 In FAL mode this would represent a Station with Worplaces and Workers 
with the related Relations. So in this case we have to load/save extra 
entities of type Workplace. 

 In PMS mode, additionally we have to load the Relations of type 
“proc_runningon_plant” which link the Operations to the Station to which 

they are assigned. 
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There is minor degradation in performance for loading/saving of the data which 
are organized under Stations 

Limitations 

 It is not to assign a worker or a machine twice to the same station. 

 When the balancing is started on a line in PMS mode, the resource 
structure must have been created by the CS script. Changes to the 
resource structure must be made from within ALB. If external changes are 

made, ALB is not guaranteed to start. 

 In PMS mode the feature multicycle in ALB is deactivated. 

 The names of the active resources must be unique within one balancing – 
that means all active resources below the line, on which ALB is opened.  

 In parallel stations the Working Unit Assignment dialog box can only be 
left with OK, if corresponding parallel stations have the same number of 

active resources assigned to the same places.  

7.8.5 Multiple Activity Chart: Worker Bar Chart View 

This helps to assign the worker or machine to several workplaces. The 
Resource View provides information on active resources. It presents the 
processes according to resources assigned to work contents. Thus it give 
quick information how the process are shared on different resources and their 
utilization. 

To View the Resource View 

You can open the Resource View by selecting the Resource View entry from 
the balancing menu View < Bar Chart. The Resource View opens and shows 

the processes according to the active resources.The view is a read-only view. 

The Resource View provide information on workers and machines, called 
active resources. It present the processes according to resources assigned to 
work contents. Thus it give quick information how the process are shared on 
different resources and their utilization. 

The labels below the Bar chart show useful information like utilization for the 
active resource. 

 Active Resource Grouping: Resources are interacting, if they are assigned 
to the same station (they are working together in the same station). If one 
active resource is assigned to more than one station, all resources of all 
these stations are interacting. Resources, that do have interaction, are 
shown directly side by side. Between those groups of resources there is be 

a bold separating vertical line. 

 Takt Time: Takt time is shown for each active resource and for each 
product variant. If an active resource is assigned to two stations of different 
takt time (e.g. to one single station and one of two parallel stations) the 

minimum takt time is taken into account for the active resource.  

Cross Highlighting in the Resource View 

When you selects a process in any view of the application, that process (if 
balanced) is highlighted in the Resource View. When you selects a process in 
balancing 2D view, active the contextual menu and select entry “Highlight 
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Process In All Windows, that process (if balanced) is highlighted in the 
Resource View and balancing 2D view. 

Note 

The cross highlight functionality is triggered in different ways in views that 
support drag and drop and views that do not support it. That is because of the 
automated scrolling in other windows that is done when cross highlight is 
triggered. In the Resource View and BarChart drag and drop is not possible. 
Due to this cross highlight is triggered by clicking on a process. In other views 
cross highlighting has to be triggered over the contextual menu entry “Highlight 
Process In All Windows”. 

7.8.6 Variant Matrix: Load Processes for Product Variants 

1) The planning mode can be set over a variable named “isvm” of type 
balancing in E5-Configuration. There are two planning modes available: 

 isvm = false or not defined: Represents the old planning mode with 

workplans. (Default) 

 isvm = true: Represents the new planning mode with variant matrices. 

2) Open project library with calculation models defined or create new 

calculation models with unique Model Numbers/Identifiers. 

3) Assign calculation models to workplan. 

4) Open variant matrix and on the workplan and select processes that should 

be weighted by the calculation models. 

5) Create a new line and start ALB on it. 

6) Select workplan with assigned calculation models. 

7) Configure balancing. Save generated balancing and click View < 

precedence graph. 

8) Select the calculation models. All calculation models that are shown in 

variant matrix are loaded as product variants. 

To Add a Product Variant 

1) Open the ALB 

2) Create calculation models. 

3) Assign calculation models to workplan. 

4) Open variant matrix and on the workplan and select processes that should 

be weighted by the calculation models. 

5) Open saved balancing and Click Balancing < Product Variant < Add 

Product Variant. The Load product Variant dialog appears. 

6) Select a product variant and click OK. 

7) Click OK in the Product Variant Properties dialog. The product variant is 

loaded in the existing balancing. 
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To Remove a Product Variant 

1) Open Balanicng and click View < precedence graph. 

2) Select the product variant and click Balancing < Product Variant < 

Remove Product Variant. 

3) Click Remove in the Remove Product Variant dialog. 

The product variant is removed from the existing balancing. 

To switch from variant matrix planning mode to work plan planning mode 

1) Set planning mode to Workplans (delete isvm attribute from Balancing 

Type). 

2) Open existing balancing (planning mode “Use variant matrix”).  

3) Create a new balancing based on a work plan. 
The existing balancing could not be opened because no product variant is 

available. 

7.8.7 Variant Matrix: Honor Process Sequence 

The order of processes (sorted process also) is correctly transferred to ALB 
from DPE. The processes can be sorted according to their order in the variant 
matrix. The attribute for the sorting order can be configured in the ALB 
Customization dialog. The default attribute is sortindex. 

When selecting processes (single selection or multiple selections) the sum of 
the process times is displayed in the status bar of that view. By selecting the 
first process and the using Shift+Cursor-Down keys, you can select processes 
that fit into the takt time. You can do a drag and drop of the selected processes 
in the first workplace. You can repeat the selection procedure and balance the 
processes to the second workplace. You can continue until all processes are 
balanced. 

The process behaviour applies to all three modes of the process list: All 
Processes, Balanced Processes, Unbalanced Processes. However, the 
intended workflow only makes use of the list of unbalanced processes. 

 When no process is selected in the process list, the overall sums are 

shown in the status bar of that view. 

 When at least one process is selected in the process list, the sum of the 

selected processes is shown in the status bar of that view. 

 A double click on any of the column headers in the process list sorts the 

respective column. 

 A second double click on the same column sort the list in the reverse order.  

7.9 Planning of Material Supply Area 

A process can be assigned assembly parts. During the balancing process, the 
material planning module calculates the required space for the material supply 
area. 

Automatic Line Balancing first checks which charge carrier has been assigned 
the part. The second step is to check the number of parts contained in that 
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charge carrier. In the third step, the bin size, the maximum stack and line up 
heights are then determined and transferred to the Material Supply Area 

dialog. Please refer to the Figure 147. 

 

Figure 147: Material Supply Dialog 

Determining Required Space 
After specification of the arrangement and number of bins in the Material 
Supply dialog, Automatic Line Balancing determines the required space along 

the assembly line. Only values not exceeding the length of a station are 
accepted. The required space represents the return value of the material 
planning module as an attribute of the assembly process. 

7.9.1 Creating Logistics Data 

Every customer should be able to get a customized product. The variety of 
colors from which customers can choose for the variants, however, makes it 
necessary for logistics planning to focus on actual needs. 

Identical parts for the same product can be used and planned in various 
colors, for example, if one customer wants a black steering wheel, and another 
customer wants a gray steering wheel in the vehicle. 

This requirement is planned in the logistics data. The parts and bins are 
supplied on the line according to the planned color variants. Using the logistics 
data Automatic Line Balancing determines the number of bins and the space 
required on the material supply area. The bins marked using the logistics data 
are displayed in yellow in the balancing process. 

The logistics data can be enabled only if both attributes for the color code and 
the bin principle are enabled in the configuration. Both attributes are 
generated on relations: 

 Attribute color code: color code 
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 Attribute bin principle: bin principle 

Set the logistics data for material planning in the properties dialog of the 
relation that links the part to the bin. To enter logistics data, the part must have 
first been linked with a parts bin, only then are the attributes for logistics data 
available. 

After linking the part with a parts bin, open the dialog to the relation. Enter the 
logistics data on the appropriate page, in Figure 148 it is the ALB Logistics 

page. Please refer to the Figure 148. 

The standard relations are generated according to the following schema. 
Please refer to the Figure 194. 

1) Select a process from the PPR Navigator Process View. All linked part 
bins are displayed in the list view under the tab Product is supplied by 
resource. 

2) Open the properties dialog by double clicking on the line for the part bins 
(in the example, the line for bins). 

 

Figure 148: Open the Properties Dialog via Relation - Logistics Data 

3) Enter the logistics data accessed in material planning in the properties 
dialog. 

4) The tab which contains the fields for logistics planning can be freely 
configured. We consider it sensible to set up a separate page for the 
logistics data in order to ensure a unique allocation of data. 

For more information please refer to the Administration Manual. 

5) Click tab for logistics data, in the example the tab logistics planning and 

enter the data in the fields. 

 

Figure 149: Properties Dialog of the Relation – Logistics Data  

Planning the Logistics Data 
The relation Part-part bins determines the demand for parts and part bins. 

Please refer to the Figure 149. 

file:///C:/Documents%20and%20Settings/OUM/Application%20Data/Microsoft/Word/Administration.pdf
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Note 

The logistics data must always be supplied for the balancing product, i.e. these 
data are then processed in the balancing process itself. 

If you make changes to the logistics data, you will always be asked whether 
the material planning should be executed according to the changed logitics 
data when opening the balancing process. 

To Plan the Logistics Data 

1) If you confirm the message with Yes, the material planning will be 

executed according to the changed logistics data. 

2) If you confirm the message with No, the material planning will be executed 

according to the calculation mode previously set in the material supply 
dialog. 

 

Figure 150: Execute Calculation according to the Changed Logistics Data  

3) Enable Additional Charge Part field only if product variants for this 
relation (process, part, and bins) are already in the plan. 

Planning Additional Parts 
A part is called an additional part if variants of this part are not unlocked in the 
plan or material requirements planning. 

By activating Additional Charge Part field you can supply the currently 

planned additional part with the information that variants are available for this 
part in the planning. The prospective demand for parts bins for the additional 
parts is taken into account and planned in the balancing process via the part 
labeled as an additional part. 

These additional parts are considered product variants (in the Figure 151, 
Variants A to D); they are available as constructive variants, but they have not 
been unlocked for requirements planning. 

This marking as an additional part is used exclusively for information purposes, 
indicating that the currently planned part can be replaced by the variants at a 
later point in time. 

The number of parts bins unlocked for the part in the properties dialog of the 
relation is planned in the balancing process. When the variants marked as 
additional parts are unlocked for planning, the parts bins are planned using the 
defaults of the individual variants, which as a rule replace the currently planned 
parts bin requirement via the additional part. 
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Figure 151: Requirements Planning for Allowance Parts Schema  

4) Enable Leading Part field to mark this product variant as the lead part. 

Planning the Lead Part 
If you enable Leading Part field, this product variant is marked as the lead 

part. The number of part bins and the required space is determined for this 
product variant. 

Enable this field only if the part bins are to be supplied on the line according to 
the type of delivery just in sequence (JIS). Several product variants are 
supplied in one part bin on the line in this type of delivery (JIS). 

 

Figure 152: Schema for Type of Delivery Just in Sequence 

5) Enter the type of delivery in Default supply form. 

Standard Type of Delivery: This field is used for information about the 
principle guiding the supply of parts (product variants) on the line. Input in this 
field is not necessarily required, and you can spell the delivery type. For 
example, JIT could stand for the type of delivery just in time. 
6) Enter the planning part families in Part family number. 

Planning Parts Families: Set the parts family for the part in this field. 
7) Enter the planning color code in Color Code. 

Planning Color Code: Set the color for the part in this field. 
8) Enter the number of bins for parts in Number of containers per part. 

Planning the Number of Bins for Parts 
Set the number of part bins required for this color variant of the part in this 
field. 
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9) Enter the part bins in Container principle. 

Planning the Bin Principle: Set how many part bins are sequentially 
supplied for a product variant on the material supply area with the bin principle. 
When the required surface area is being determined, started sequences of a 
product variant are not filled with other part bins of a different product variant. 

Please refer to the Figure 149. 

 

Figure 153: Planning Bin Principle Schema 

7.9.2 Editing the Material Supply Dialog 

As an alternative to the material supply area determined as previously 
described, the material supply area can be edited manually in the material 
supply area dialog in the balancing process. 

You can further optimize the material supply by varying the physical 
arrangement of bins. Variation is achieved by stacking, lining up or rotating.  

The required surface area is determined on the basis of the available data in 
the first calculation of the balancing process: 

 The required space for part bins for which no logistics data are available is 

determined on the basis of a fixed defined area. 

 The required space for part bins for which logistics data are available is 

determined on the basis of the defined logistics data. 

The Four Calculation Modes: 
Four calculation modes for calculating the required surface area in the 
balancing process are available in the material supply dialog. Only one of the 
four calculation modes can be used at any one time. 

 The procedures for stacking and lining up bins can be found in the chapter: 

Executing Calculation according to Assembly (1) 

 Planning the required surface area according to the bin principle: Please 

refer to the: Executing Calculation according to Assembly (2) 

 Planning the required surface area with logistics data: Please refer to the: 

Execute Calculation according to Logistics Data 

 Planning the required surface area for a fixed surface: Please refer to the 

Executing Calculation according to a Fixed Surface 

Opening the Material Supply Dialog 
There are several ways to open the material supply dialog: 

Double Clicking on the Part Bin 
 The quickest way to open the dialog is directly via the part bin. 

1) Either double click or use the contextual menu. 
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Figure 154: Opening the Material Supply Dialog – Directly on the Part Bin 

Via the Shelf Properties Dialog 

 It is somewhat more difficult if the part bins have been placed in a shelf.  

2) First open the properties dialog of the respective shelf. Either double 
click in the shelf or use the contextual menu. 

 

Figure 155: Opening the Dialog for Shelf 

3) All part bins placed in the shelf are displayed in the dialog.  

 

Figure 156: Shelf Properties Dialog 

4) Open the material supply dialog either by double clicking or by using the 
contextual menu (properties) of the selected part. Part 1 in the example. 

Via the Shelf Properties Process 

5) Double-click the process in the Automatic Balancing view. The Properties 
dialog will be opened. 
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Figure 157: Opening Material Supply - Process Dialog 

1) Then click Material supply in the dialog. 

 

Figure 158: Material Supply Button 

2) Double-click the material line in the window. The Material Supply dialog will 
be opened for editing. Please refer to the Figure 158. 

Material Supply Dialog 
The properties dialog is divided into two main areas: 

 In the display area showing the data of the relat ion (process, part, part 

bins). 

 In the calculation mode with the results display, in which the four 
calculation modes can be selected, to optimize the required surface area 

manually. 
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Figure 159: Material Supply Properties Dialog 

Display Area in the Material Supply Dialog 
The essential data of the relation are always shown in the display area of the 
dialog. 

 The line for the process contains the process number and the weight with 

which the process is planned. 

 The line for the material contains the part number of the respective part as 
well as how many parts of a variant are to be produced in the process. 

Please refer to the Planning the Parts Demand for Processes. 

 The part bins are displayed if logistics data are planned. The data for the 
standard shelf and the possible shelves in which the part bins can be 

placed are displayed along with the dimensions. 

1) Click button for the part bins to see the display for the part bins.  

2) If several part bins are assigned, you have to press this button for every 
one of the four possible calculation modes to display the result for the 
respective part bin. 
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Figure 160: Display Area of Material Supply Properties Dialog 

The Calculation Mode in the Material Supply Dialog 
The four possible calculation types with which the surface area required in the 
balancing process can be determined are available in calculation mode. 

Note 

You can only use one of the four calculation modes for calculating the material 
supply area. 

1) Set a calculation mode by clicking on one of the four tabs.  

2) Click Apply to enable the calculation mode.  

3) The ascertained values displayed in the results area. 

4) Click OK, to enable the settings, and the required surface area is updated 
in the 2D view. 

 

Figure 161: Calculation Mode in the Material Supply Properties Dialog 

 The four calculation modes are described in the following chapters.  

Executing Calculation according to Assembly (1) 
With the calculation mode marked Assembly (1) you can set whether the part 
bins are: 

Stacked, Lined up, Rotated by 90°, Placed with filling level and safety factor. 
Please refer to the Figure 161. 

Stacking and Lining Up Part Bins 
 Set the respective number via the selection list. 



Working with Automatic Line Balancing 110 

Automatic Line Balancing         Version PE 5.21 

 

Figure 162: Stacking and Lining Up Part Bins 

Stacking 
Set whether the bins are to be stacked on the material supply area, i.e. how 
many bins should be placed on top of each other, with Stack. 

 

Figure 163: Stack Bins Schema 

Lining Up 
With line up you can set how many part bins can be lined up behind one 

another in a row. 

 

Figure 164: Line-Up of Bins Schema 

Rotated by 90° 
Enable this field to rotate the part bin by 90°. 

 

Figure 165: Rotate Part Bin by 90° 

Filling and Safety Factor 
Filling Interval 
In the Filling field (Vhcl) you specify the number of assembly cycles that need 
to be completed before bringing a new bin to the line. Using this interval 
(delivery and pickup of bins) the number of parts to be supplied is also 
optimized in the bins. The safety factor can be said to have a buffer function 
for problems that might occur during the delivery of parts. These parameters 
for the safety factor are normally set by the logistics department of a company 
per default and checked permanently. 

 

Figure 166: Setting Filling 

In the Filling field, enter the number of vehicles for which the material supply is 
to be calculated. The Automatic Line Balancing then calculates the number 

of bins on this basis. The safety factor is an allowance. Experience may be 
considered here. 

Planning the Parts Demand for Processes 
In ALB, there are two possible ways to enter the parts required for a process: 

 Enter an amount in the properties dialog (reference model) of a part, by 
opening the relation between a process and a product, 
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 Or just link the same part, according to the amount needed, individually 
with a process (structural model). A further demand entry is not required. 

ALB determines the demand for parts (piece count of one per part) 
according to the amount of parts that are linked with a process. 

Please set up the method you have chosen for planning in the demand, in the 
Settings dialog which can be found under the menu Extra < Options.  

2) If you activate the Calculate the number of parts by the number of part 
relations at a process option, all identical parts must be linked 

individually with a process - structural model. 

3) By deactivating the Calculate the number of parts by the number of 
part relations at a process option, all parts can be linked with a process 

at the same time – reference model. 

 

Figure 167: Choosing the Type of Link 

Planning the Parts Demand in the Properties Dialog - Reference 
Model 
If you base your planning of parts on the reference model, the same part will 
only have to be linked with the process once. The required parts needed for a 
process, can be entered in the properties dialog. 

1) To enter the parts needed for a process, you must always open the 
properties dialog of the process on the relation. This is the only method 
that will enable you to enter the parts demand in the properties dialog.  

 

Figure 168: Opening the Properties Dialog at the Relation 

2) In the properties dialog, under the ALB tab, enter the demand in the field 
quantity  – in the example 10 parts are to be used in this process. 

 

Figure 169: Entering the Parts Demand 

3) Open the Material Supply dialog in the job view of the process. The 
demand is displayed in Parts/Process and is used in the balancing 

process. 
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Figure 170: Parts Demand in the Material Supply Dialog 

Executing Calculation according to Assembly (2) 
With the calculation mode marked Assembly (2) you can set whether the part 
bins are placed according to 

 The bin principle 

 Number of bins per part 

 Rotation by 90 Grad 

For a description of the bin principle and number of bins per part, Please refer 
to the Figure 153. For a description of rotated by 90° Please refer to the Figure 
165. 

 

Figure 171: Assembly Calculation Type (2) 

Assembly 2 supports flexible planning of part bin groups. In case material area 
width is very less such that containers cannot be placed one behind another, 
the arrangement will differ and containers will be adjusted accordingly. In case 
of rotation, again the containers will be rotated and the arrangement will vary 
depending upon the space availability of material area.  

Execute Calculation according to Logistics Data 
The calculation mode according to logistics data can be executed only if you 
have generated the relation logistics data in the properties dialog. Please refer 
to the Creating Logistics Data. 

1) The result is always displayed for the selected part bins.  
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Figure 172: Logistics Calculation Mode 

Executing Calculation according to a Fixed Surface 
The calculation mode for a fixed surface can be determined, for example, to 
display the required surface area for a special conveyor device or a pre-
assembly set up in the material supply area. If charge carrier data are not yet 
known in particular parts or if it seems too complex to enter them exactly, you 
can also make use of this generalization to reserve space in the material 
supply area. Please refer to the Figure 269. 

 

Figure 173: Calculation Mode for Fixed Surfaces 

Displaying Operating Equipment 

1) Click the Operating Equipment button in the Process Properties dialog to 

display assigned operating equipment. Please refer to the Figure 174. 
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Figure 174: Displaying Operating Equipment 

7.10 Planning the Parts bins and Processes for 
Production Lines 

If processes and parts bins should be planned in for use with particular 
production lines exclusively, each should be marked accordingly. A process 
graph (which is the basis for the balancing of processes) must be created for 
each production line, in order to makes the planning of the material supply 
possible. 

This requires that the relevant preparatory measures be taken in the Process 
Engineer, before the balancing of a production line in ALB. 

Preparatory Measures in the Process Engineer 

The planning of a process is made possible with the aid of a process graph. 
This graph includes the full sum of processes and variants needed to produce 
the final product. So these process graphs can include processes that are 
used exclusively for a single production line, as well as processes that are 
independent of any particular production line and can be used with a variety of 
different production lines. 

The planning for the parts bin, which is also used for particular production 
lines, runs parallel to this planning method. 

The planning process for the parts bin is carried out by linking processes with 
products, and the products in turn with the appropriate parts bin.  

The processes and parts bin are marked using the Production line attribute. 

The Production Line attribute in the properties dialog must be displayed 

according to the parts bin and processes. 
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For more information on how to create user defined attributes, please refer to 
the Administration Manual. 

The creating of process graphs, the linking between process, products and 
parts bins and finally, marking via the Production Line attribute, are all 

measures to be taken before the balancing process. 

7.10.1 Production Line Attributes in Processes 

The attribute for the production line (Production Line) must be displayed in the 
properties dialog of a process:  

If you enter the production line in the properties dialog of a process, this 
process will only be used in that production line (only be planned in this 
process graph). The string value of your choice can be selected as the value 
for the production line - for example the value 10 in the example. 

 

Figure 175: Production Line Attributes in Processes 

7.10.2 Production Line Attributes in Part Bins 

To enter logistics data for a parts bin, one must open the properties dialog by 
way of the relation between the Part and Parts bin. 

In other words, the part must be linked with a parts bin in order to enter 
logistics data. The logistics data page is only available when for one, the link 
has been made, and second the properties dialog is opened by way of the 
relation. Just as with processes, you are free to choose the string value for the 
production line – in the example the value 10. 

After linking, open the properties dialog by way of the relation. Enter the 
logistics data on the appropriate page, in the picture it is the ALB Logistic 

page. Please refer to the Creating Logistics Data. 

file:///C:/Documents%20and%20Settings/OUM/Application%20Data/Microsoft/Word/Administration.pdf
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Figure 176: Production Line Attribute for a Parts Bin 

7.10.3 Material Supply for a Marked Parts Bin 

Once again, the making of process graphs, the marking of processes and 
parts bins with the aid of the Production Line attribute, and the linking of the 

process with the parts bin and parts, are all preparatory measures for the 
balancing process. 

To plan a product line with all variants included, it is advisable to develop a 
process graph which is valid for the entire product line. This will enable you to 
create a second process graph which is only valid for a single production line 
from the first. This production line is only used for balancing processes which 
are used in specific variants. 

The following scheme shows the planning for parts delivery, using a process 
graph for a specific production line. Please refer to the Determining the 
Material Supply. 

 

Figure 177: Scheme – Material Supply for a Production Line 

Legend 
P = process 

Line = process and parts bin which are marked with the Production Line 
attribute – e. g. P1- Line 10 or TB1 – Line 10 

Part = supply of parts that are in parts bins on the production line – e. g. Part 1 

TB = parts bins carrying the parts to be delivered to the production line – e. g. 
TB1 
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X0= these are unmarked processes and parts bins, which are not fixed to a 
particular production line – e. g. P – X0 and TB – X0 

7.10.4 Determining the Material Supply 

The scheme shows how the material supply is to be planned, for the 
production line 10 in the example. The process graph that is laid down as a 
basis for the balancing process of the production line 10 can only contain 
processes which are unmarked or have been marked for l ine 10, using the 
Production Line attribute. All other processes, to put it simple, are not 

welcome in these process graphs. 

 

Figure 178: Intersection Scheme 

Calculating the Part Bins 
The parts bins are calculated using a simple mathematical method, as the 
Intersection scheme shows on the following page: 

The basis for the calculation is created by the links between processes, parts 
and parts bins. 

 All of the processes that are marked for line 10, and those found in the 
intersection are used for the calculation: Intersection based processes 

must be present in the process graph of the production line. 

 The parts bins are determined via the links for processes to products. The 
parts bins being calculated are the ones marked for the production line 10 
using the Production Line attribute. In addition to these, parts bins that 

have not been marked for a production line, but are still linked with 
processes that are planned in the process graph of the production line 10 

are recognized – these processes are made up from the Intersection. 

 The parts bins without markings are calculated out of the intersection. The 
intersection only contains processes which are not assigned to a 
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production line, but are still planned in the process graph of production line 

10. 

Note 

Processes without markings can only be used with parts bins which are also 
unmarked. 

From a practical standpoint this means:  that when planning in processes 
which are valid for all production lines, you make sure that when the link is 
made between parts bins and products, that also parts bins without markings 
are planned in. 

7.10.5 Rotate Part Bins by 90o 

You can rotate the part bins by 90o in the Material Area and Station. 

To Rotate part bins by 90o in the Material Area 

1. Open ALB in a Line. 

2. Right click left material area of station 1 in the ALB Balancing view. 

3. Click Rotate Part Bins by 90° in the contextual menu. 

 

Figure 179: Rotate all the Part Bins in Material Area by 90° 

To Rotate part bins by 90o in Station 

4. Double click Station 1 to view the Properties dialog box. 

5. Select option Rotate all Part Bins by 90°. 

 

Figure 180: Rotate all the Part Bins in Station by 90° 

7.11 Planning Shelves for Material Supply 

Small parts which, for example, are processed on assembly lines are usually 
kept on the lines directly in the bins on the shelves. This reduces transit 
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distances between for example, central storage areas or suppliers. The small 
parts can, for example, be supplied for the individual work places on the 
shelves, sorted according to their variants, and the amount can be adapted to 
the demand. 

 

Figure 181: Planning Shelves 

What is the objective of this? What goals are pursued in the balancing 
process? 

 One of the many possible answers could be: to increase transparency and 

reduce false requirements. 

In version PE 5.13 the shelf and loading unit requirement (for example. bins, 
boxes) for parts can be calculated in the balancing process. 

7.11.1 Prerequisites for Planning Shelves and Loading Units 

Creating Templates 
The shelves are created in templates. You may be familiar with templates from 
word processing, for example. Templates are created in the plantype set you 
are using for the project in the system library. The template itself contains so-
called shelf libraries to which the shelves are assigned. There is no limit to the 
number of shelf libraries which can be generated in a template. 

The number of shelves is unlimited, and it should always be set to the 
respective number needed. The number of templates you can use is also 
unlimited. 

Note 

Self libraries are thus used to plan the corresponding shelves for the balancing 
process. If you generate only one shelf library, these shelves will automatically 
be used for the balancing process. If there are further shelf libraries available, 
you can select the corresponding shelf library in a dialog. 
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Figure 182: Example of a Template with Two Shelf Libraries 

For more information please refer to the chapter Generating templates in the 
System Library Manual. 

The dialog Load shelves is opened 

 Only if you have generated several shelf libraries for shelves, 

 Otherwise always in the first calculation of a balancing process, 

 When opening a previously calculated balancing process, if you either 
execute a new calculation or manually place a bin into a new shelf. 

 

Figure 183: Select Shelf Library Dialog 

Setting Properties 
The shelf is specified in the properties dialog of the shelf. Apart from the data 
such as the name of the shelf, length, width and height, the shelf type is 
uniquely defined by two figures (number of shelf levels and standard shelf):  

Planning Number of Shelf Levels 
Set the number of levels for the shelf in this field. You can freely select the 
number of levels. You must always enter a number in this field; otherwise 

the shelf cannot be planned. 

Setting the Standard Shelf 

 

file:///C:/Documents%20and%20Settings/OUM/Application%20Data/Microsoft/Word/SystemLibrary.pdf
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Set whether the shelf is defined as the standard shelf in this field. If you do not 
enable this field, the shelf is not taken into account in the automatic 

calculation, and it can then be planned only in manual processing of the 
balancing process. 

Note 

You can define only one shelf as the standard shelf per shelf level. If for 
example you generate several shelves with the same number of levels, the 
shelf which is required most often for material supply is defined as the 
standard shelf. 

 

Figure 184: Example of Shelf Properties Dialog 

7.11.2 Planning the Attributes for the Level Angle and 
Protrude 

Starting with the PE 5.17 release the calculation for the shelf geometry has 
been extended by three attributes: 

 Shelf level angle attribute 

 Shelf level height attribute 

 Shelf level protrude attribute 

In earlier versions of DPE the shelf geometry was calculated using the outside 
measurements. The calculation was based on the values entered into the 
properties dialog of each shelf, namely length, width, height and interior length. 

With the aid of a simple calculation method, the position for each individual 
shelf level could be determined: the shelf height divided by the amount of shelf 
levels equals the position of a shelf level. As long as zero is entered at the 
value for the new attributes, this method can continue to be used. 

The three new attributes enable you to optimize the utilization of a shelf, by 
adjusting the shelf level to the geometry of different loading units.  

 A shelf in ALB can have a maximum of six shelf levels. The shelf level 
angle, shelf level height, and shelf level protrude can be calculated for 
each shelf level. 
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 These attributes are configured by default. The value set for all 18 

attributes is zero. 

 To plan the level angle, shelf level height and the shelf protrude, at least 

one attribute is needed for each shelf. 

 A maximum of 18 attributes are available for planning. 

 The new attributes are only needed for calculations in which a value other 
than zero is entered. If only zero values are entered for the attributes, the 

shelf position is calculated using the original method. 

Using Attributes for the Planning 
You can enter the attribute values in the Shelf Library found in the properties 
dialog of the shelf. 

To open the properties dialog of a shelf, you must first open the template that 
holds the Shelf Library, for example the picture shows, the ALB Shelf 
Template. 

1) Open the Template directory via the System Library in the plantype set. 

2) Select the ALB Shelf Template directory and open the contextual menu 

by right-clicking the mouse. 

3) Select Open Template As Project in the contextual menu. 

 

Figure 185: Open the Properties Dialog for the Shelf 

4) Select the shelf from the shelf library in the open ALB Shelf Template. 

5) Open the contextual menu by right-clicking the mouse and select 
Properties. You can enter the values for the attributes in the properties 
dialog. 

6) Once you have saved the values, the shelf can now be used with these 
values in ALB. 

Shelf Level Angle 
The shelf level angle is always entered in degree. This angle enables you to 
plan the positioning for a shelf level – the angle can be entered as plus or 
minus values. Please refer to the Figure 186. 

Shelf Level Height 
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The shelf level height can be entered in meters, centimeters or millimeters. 
The shelf level height is where the shelf level bottom edge and the inside wall 
of the shelf intersect, and is measured from the base of the bottom shelf level 
(zero level). Please refer to the Figure 186. 

Shelf Level Protrude 
The shelf level protrude can be entered in meters, centimeters or millimeters. 
The shelf level protrude enables the measuring of the distance of the end of 
the protruding shelf level to the shelf front. Please refer to the Figure 186. 

The Geometrical Scheme for Attributes 
The following scheme shows the geometrical position for measuring and 
calculation of the shelf level angle, level height, shelf level protrude, and width 
attributes. 

 

Figure 186: Scheme – New Attributes for the Dimensions of a Shelf 

Shelf Length 
The following scheme shows the dimensions for the length and inner length of 
a shelf. These values are added to the calculation and are entered in the 
properties dialog. Please refer to the Figure 184. 
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Figure 187: Scheme - Length and Inside length of a Shelf 

Entering Values for Attributes 
As was mentioned earlier, the values are entered via the properties dialog in to 
the shelf library of the shelf. The default setting zero is given for the values. 
The following examples show the possibilities for shelves. Please refer to the 
Figure 185. 

Examples Using the Value Zero 
The example shown here is a shelf with two shelf levels. The positioning for 
this shelf has been carried out using the old calculation method. All of the 
attributes hold the zero value. 
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Figure 188: Values with a Zero Setting 

The shelf level position is calculated using the old method: the shelf height 
divided by the number of shelf levels (two shelf levels in the example) equals 
the position for a shelf level. 

The picture shows the result: 

 

Figure 189: Calculating the Position of the Shelf Levels using the Zero Value 

Example Using Attribute Values 
In this example of a shelf with six shelf levels the values for the shelf level 
angle, shelf level height and shelf overhang are already set. The amount of 
attributes needed can be increased or decreased, depending on the amount of 
shelf levels. 

The positioning for the shelf level in this example is calculated with the aid of 
the attribute values. 
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Figure 190: Values for the Attributes are Preset 

The picture shows the result: 

 

Figure 191: Shelf Levels that have been Calculated with the aid of Attribute 
Values 

Example of a Negative Shelf Level Angle 
To plan the shelf level with a negative shelf level angle, the planned angular 
measure of 360° must be reduced: In the example, a negative angle of five 
degrees has been planned for the shelf level six. 

In the example 355° is entered for the  Shelflevelangle 6 attribute. Depending 

on the planned negative angular measure, the value is reduced or increased – 
for minus ten degrees for example, 350° etc. 
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Figure 192: A Negative Shelf Level Angle 

The picture shows the result: 

Shelf level six – in the example the shelf level on top – has a negative angle. 

 

Figure 193: Picture containing a Negative Shelf Level 

Planning Loading Units (bins) for Parts 
Structures (process, resource and product structures) for the balancing 
process are shown in the PPR Navigator. The structure for the loading units is 
generated in the PPR Navigator in the resource structure. 

In order to make it possible for the loading units (bins) to be planned in the 
balancing process, the loading units are linked to parts (relation resource 
supplies product). The parts are also linked to the processes (relation first 
processes product) which are supplied in the loading units on the line. 

In this way it comes full circle: 

 

Figure 194: Linking Process, Part, and Loading Unit Schema 
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 The stations are determined via the process structure in the balancing 

process. 

 All data for optimally planning shelves and loading units for the parts 
supply are available via the link between the processes and products 

(parts), which in turn are linked to the resource structure of the loading unit.  

 

Figure 195: Example of a Resource Structure for Loading Units 

For more information, please refer to the PPR Navigator Manual. 

Setting Properties 
The loading unit is specified in the properties dialog of a loading unit. Apart 
from the data such as the name of the loading unit, length, width and height, 
the type of loading unit is uniquely defined by two figures (possible shelves 
and standard shelf). 

 

Figure 196: Example of Loading Unit Properties Dialog (bin) 

Setting Possible Shelves 

Note 

The selection of the possible shelf levels must be set in advance in the 
configuration. 

In order to configure the possible shelf levels, Please refer to the chapter 
Configuring Automatic Line Balancing in the Administration Manual. 

file:///C:/Documents%20and%20Settings/OUM/Application%20Data/Microsoft/Word/PPRNavigator.pdf
file:///C:/Documents%20and%20Settings/OUM/Application%20Data/Microsoft/Word/Administration.pdf
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Figure 197: Possible Shelf Levels 

Set the possible shelf types in this field (shelves with set number of levels). In 
manual balancing process editing you can you can place additional loading 
units with this entry – apart from the standard shelf there are also defined shelf 
levels available for planning. You must always enter a value in this field. 

A loading unit can be placed in a shelf if the dimensions of the loading unit and 
shelf correspond. 

 If, for example, you select 3, this means that the loading unit can be 

manually placed only on shelves with three levels.  

 If you select 3-4, this means that the loading unit can be manually placed 

on shelves with three or four levels, etc. 

Setting the Standard Shelf 
Set the shelf type in which the loading unit is to be placed in this field. The 
loading unit is placed in this set shelf type with an automatic calculation of the 
balancing process. 

You must always make an entry in this field. 

 This entry must be unique; you cannot specify more than one level. 

 If, for example, you enter 3, the loading unit is placed in a shelf with three 

levels in the automatic calculation. 

7.11.3 Editing Shelves and Loading Units in the Balancing 
Process 

In the first calculation of a balancing process, the shelves and loading units are 
allocated to the workplaces according to the determined demand and are 
displayed in the job coordination view. 

The shelf libraries are not automatically loaded when a previously calculated 
balancing process is opened. The shelf libraries are available only when they 
are needed, i.e. if you start a new calculation after opening the balancing 
process, replace a shelf, or manually place a bin in a shelf. 

Shelves and Loading Units (part bins) can be Manually Edited in 
the Balancing Process: 

 You can remove shelves  

 Replace one shelf with another 

 Place a loading unit on a new shelf 

 Open the properties dialog of loading units  

 For a description of further functions: See the chapter on 

 You can execute the corresponding functions via either of the contextual 
menus, shelf or loading unit. Please refer to the Figure 199 and Figure 
202. 
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Figure 198: Job Coordination View – Shelves, Loading Units in the Station 

Executing Context Functions for Shelves 

 

Figure 199: Shelf Contextual Menu 

Replacing Shelves 
When replacing a shelf it is important to note whether the shelf is empty or 
already full of bins. You can simply replace an empty bin with another. If there 

are bins in the shelf, check first to see on which shelf type the bins are to be 
stored before replacing the shelf. 

 

Figure 200: Replacing Shelves 

 You can obtain this information either in the properties dialog of the part 

bin or via the Material supply dialog. 

1) Select the shelf to be replaced and open the contextual menu. All part bins 
of this shelf are displayed in the properties dialog. The Material supply 
dialog can be opened by double clicking on a part bin.  

2) in order to replace the shelf with another, click on Replace with other 
shelf. 

3) All shelves are displayed with data on the size and shelf levels in the 
dialog Replace shelf. 

4) Select the shelf and click the OK button to confirm. 
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Figure 201: Exchange Shelf Dialog 

Removing Shelves 
You can easily remove shelves from the Material supply area. Shelves with 
part bins on them are removed and the bins are placed in the space cleared on 
the floor. 

5) Select Remove shelf in the contextual menu of the selected shelf. Please 

refer to the Figure 199. 

Executing Context Functions for Loading Units (bins) 
Displaying Graphics 
A graphic of a certain part can be displayed only if it was generated with other 
software; CATIA, for example. 

 

Figure 202: Loading Unit Contextual Menu 

Placing Free Bin into a New Shelf 

1) Select the bin and open the contextual menu. 

2) Click On new shelf to place a free bin in a shelf. This context function is 
available for bins only if levels for the standard shelf and the possible 
shelf levels have been defined in the properties dialog. 

3) All shelves are displayed with data on the size and shelf levels in the New 
shelf dialog. In addition, the possible shelf types for this bin are displayed.  

4) Select the shelf and confirm with the OK button. Please refer to the Figure 

208. 
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Figure 203: New Shelf Dialog 

Removing bins from Shelves 
The contextual menu for bins placed in a shelf can be called by 

1) Opening the properties dialog of the respective shelf. Either double-click or 
use the contextual menu to open the Properties dialog. 

2) All bins in the shelf are shown in the dialog. Select the bin to be removed 
from the shelf and open the contextual menu. 

3) Click on Remove from shelf. The bin is removed from the shelf and 

placed on the floor of the material supply area, depending on the process 
it has been assigned. 

 

Figure 204: Shelf Properties Dialog - Contextual Menu for Bin 

7.11.4 Manually Placing Part Bins in the Shelf 

You can place part bins in the shelf by mouse click. 

1) Select the part bin on the material supply area and move it to the shelf.  

 

Figure 205: Placing Bins in the Shelf by Mouse Click 

2) Release the mouse button in the shelf, in the Move bin dialog click In 
shelf. The bin is only placed in the shelf of the shelf levels correspond. 

Please refer to the Figure 208. 
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Figure 206: Placing Bins in the Shelf 

3) You can place the bin in a new place with Move; i.e. the bin is placed on 

the floor and the shelf is moved to the right. 

7.11.5 Messages in Shelf Planning 

New Shelf is too Small 
This message appears, if you replace a shelf with another and there are bins 
in the shelf which cannot be placed on the new shelf. 

You can replace the shelf manually by confirming the message with Yes; the 

shelf is then replaced. 

 

Figure 207: Bin does not fit on the New Shelf 

Bin does not fit on shelf 
This message appears if you try to place a bin in a shelf and the shelf levels 
do not correspond. 

 

Figure 208: Shelf Levels do not Correspond 

Shelf Settings are Inconsistent with Bin 
This message appears if the shelf settings are not clearly defined for the bin – 
for example, if no values have been entered for Possible shelves. The 
message is displayed when the balancing process is opened. 

 

Figure 209: Shelf Data Incomplete 

7.11.6 Editing Name of Shelf 

1) Open ALB on a Line. 
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Figure 210: Edit Shelf Name 

2) Right click shelf and select Properties in the ALB Balancing View. 

3) Edit name and number of shelf. 
Give unique name for shelf. 

4) Click OK. 
Changed name and number are retained in 2D View, Properties dialog 

box and as tool tip. 

The name and number attribute of shelf can be configured in E5. The 
maximum character length for Name and Number permitted is 1000. There is 
also length attribute and by default this is set to 64. 

7.11.7 Reordering of Part Bins in Shelf 

1) Open balancing, and launch the shelf properties dialog box.  

 

Figure 211: Shelf Properties Dialog Box 

The dialog box include headers with Levels (Level 2, Level 3...) to distinguish 
between the available levels and to categorize the containers accordingly. The 
number of levels shown in this list view is the number of levels in Shelf as 
defined in Shelf Library. The available space for a Level is shown in the Italics 
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format in the “Length X Depth” column to have an idea whether a particular 
container can fit into this level. 

2) Drag a container from any one level to another level where enough space 
is not available. 

The container is moved from source level to target level with its level now 
changed to that of target level. The available spaces for both the source and 
target levels are updated accordingly.  

The target level header is turned orange. 

 

Figure 212: Target Level Color Changes 

These are the levels where part bins are added beyond a levels capacity to 
hold them. 

The dialog cannot be closed until there remains even a single inconsistent 
level (header in orange color). If you close the dialog that has inconsistent 
level t then the following message comes. 

 

Figure 213: Inconsistent Level Message 

3) Right-click a part bin from any of the level and from its contextual menu 
select Move to <Level>. 

   

Figure 214: Contextual Menu “Move To” 

The container is moved from source level to target level with its level now 
changed to that of target level. The available spaces for both the source and 
target levels are updated accordingly.  The following behaviors are possible: 

 If space is available then the container will be placed in the level and 
the header color of that level will remain intact. 

 If space is not available, then also the container will be moved to the 
level and the header color will change from light grey to Orange making 
it an inconsistent level. 

4) Click Close to save the changes and close the dialog box. 

Persistency 
The containers would be stored with their changed levels and their sequence 
inside levels would be persistent too. The sequence is stored on an attribute 
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“internalbalancing” of the default relation 
“albspec_partsbin_positioned_in_shelf” between part bin and shelf.  

The window is resizable which automatically resizes list view too. The 
properties window size, list view window size, and the columns width inside list 
view will be persistent. 

Running the Automatic Balancing Algorithm for the whole 

Balancing 
When automatic balancing algorithm runs, the part bin sequence inside shelf 
would be according to this algorithm. Shelves would be filled automatically as 
with the existing ALB functionality. The appearance however include headers 
and available spaces to clearly distinguish the part bins of different levels. 

Running the Automatic Balancing Algorithm for a Product Variant 

just added to Balancing 
When a new product variant is added to the existing balancing, the part bins of 
this new PV are added inside shelves according to the automatic balancing 
algorithm. Shelves would be filled with these new part bins automatically. 
However, the new part bins would be added at the end of each level if space is 
available so as not to destroy any existing manually created sequence. 

Manual Re-balancing of Processes 
A process moved to another station would take away its part bins from shelves 
too. The following changes take place: 

 The remaining part bins from the level from which the part bins are 
removed would be moved left to cover the space available in that level. 
However there would be no change amongst the sequence of these 
remaining part bins within the level.   

This automatic re-arrangement of part bins is restricted within levels and there 
would be no adjustments across levels. 

 The part bins would be moved to outside corner of the station where 
the processes are moved. 

Removal of part bin group from Shelf 
When a part bin group is removed from shelf, it would not be moved in the 
respective container area but is placed in outside corner of this container area 
with regard to “Free Placement of Part Bins in Material Area”, otherwise it get 
placed according to the default behavior. Removing part bin groups from shelf 
would have the following impacts: 

 Available space in the particular level from which it is removed would 
be updated. 

 No automatic adjustments of other part bins across levels or 
sequentially within a level takes place. 

 If the removed part bin groups level is inconsistent and if there is some 
available space after removal, the level header color changes from 
orange to default light grey. 

Moving a Container inside Shelf 
A container dragged and dropped on a shelf is placed inside shelf at a valid 
position in a level where space is available.  This newly added container is 
placed in the level in last position so as not to destroy any existing manually 
created sequence. Filling shall be executed from bottom level to top most 
level. 

Re-Arranging Material Area 
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There is no impact on part bin planning inside a shelf.  

Replacing with a New Shelf 
During replace with a new shelf, part bin planning inside the shelf is copied 
from target to source only if they have same levels. Otherwise, part bin 
planning would be destroyed and recalculated.  

Limitation 
During replacment with a new shelf, part bin planning inside the shelf is copied 
from target to source only if they have same levels. Otherwise, part bin 
planning would be recalculated.  

7.12 Planning and Displaying Product Variants 

Product variants of a type series are largely manufactured with the same parts 
at the same workplaces on an assembly line. Product variants of ALB planning 
include limousines, convertibles and coupes. This series of examples could go 
on forever. 

What does the balancing process of product variants, which is available in 
version 5.13 of Process Engineer, do? 

The same parts for several product variants are manufactured with the same 
processes. In the balancing process it is assumed that the processes for the 
same parts will be executed by the same employee. One process graph is 
generated for every product variant; all processes required for the manufacture 
of product variants are planned in this process graph. An unlimited number of 
product variants can be calculated in the balancing process. 

It is furthermore assumed that a high number of processes of the same type 
are used for the manufacture of product variants in all process graphs, thus 
forming dependencies between the process graphs.  

In order to show these dependencies, you can mark the same-type processes: 

 either via relations 

 or via BOM entries  

Marking processes of the same type forms the basis of the balancing process 
of several product variants, which are calculated and displayed according to 
weight accordingly. The processes of the same type must first be marked in 
the PPR-Navigator between the individual process structures of the respective 
process graphs of the product variants. Processes marked as the same type 
are marked by the blue line link. 
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Figure 215: Processes of the Same Type in the Precedence Graph 

7.12.1 Marking Processes of the Same Type via Relations 

Processes of the same type are marked in the process graphs of the individual 
product variants via the relation Same process. These processes can be 
further edited independently in the respective process graphs – a change in a 
process (for example. the process time) is not automatically implemented in 

the process linked via this relation. Proceed as follows: 

1) Select the process from the PPR Navigator process structure. In example, 
a process of product variant B is selected (process structure for the 

process graph of product variant B). 

2) Drag this process to a process in the process graphs of another product 
variant. In example, a process of product variant A is selected (process 
structure for the process graph of product variant A). 

3) Release the mouse at this process. In the Linked operation... dialog select 
the relation Same process. 

4) Click  OK button to confirm. Both processes are marked as processes of 

the same type. Please refer to the Figure 216. 

 

Figure 216: Marking Processes of the same Type via Relation 

Blue line link 
marks processes 

of the same type in 
the precedence 
graph.  

Marking 
processes of the 
same type via 

relation. 
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7.12.2 Marking Processes of the same Type via BOM Entries 

Processes of the same type marked via BOM entries are real references of the 
processes. Any change to a process (for example. the process time) is 
automatically made in the process linked via the BOM entry. Proceed as 

follows: 

1) Select a process from the PPR Navigator process structure. In example, a 
process of product variant B is selected (process structure for the 

process graph of product variant B). 

2) Always drag this process to the hierarchy level of the process graph. In 
the example product variant A is selected. 

3) Release the mouse button. In the Relate Workplan To Operation dialog 
select the BOM entry. 

4) Click the OK button to confirm. The process is added to this process graph 

as a reference. Please refer to the Figure 217. 

 

Figure 217: Marking Processes of the same Type via BOM Entry 

7.12.3 Editing Product Variants in the Balancing Process 

A fundamental principle for making product variant planning as transparent as 
possible is followed in the balancing process display of several product 
variants of a type series. You can balance as many variants as you wish. 
Whenever doing this, however, you must always keep one thing in mind; an 
optimal balancing process is possible only for the main variants ascertained in 
the initial creation or recalculation of a balancing process. 

The additional stations and workplaces are determined for all added product 
variants, but the stations are always added as the end of a line.  

The "main variant" as a rule refers to the variant manufactured most 
frequently. Main variants and additional variants can be balanced according to 
weight and scheduling. The variants you want to view can be displayed 

Marking processes 
of the same type via 
BOM entry. 

Optimization, 
transparent display 
and flexible editing 

of product variants. 
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together or separately in the job coordination view – viewing one variant 
corresponds to the balancing process for a product. 

You can edit only the processes and stations of active variants. Processes for 
inactive variants are displayed in gray. All menu functions, however, are 
available for editing. Added variants in this way can later be manually 
optimized. 

Product variants can be removed from the balancing process if, for example, 
the process graph of the product variant has to be revised or the product 
variant is to be replaced by another. You can as previously for example, print 
out the results of this balancing process or display them in a group view. 

 

Figure 218: Supply Product Variants for the Balancing Process Schema 

7.12.4 Product Variants Menu 

The basic settings for the balancing process of the product variants are made 
in the menu Product variants. You can set which variants are to be calculated 
and displayed in the balancing process using three menu points. 

The process graph of the main variant is planned for the first calculation of a 
balancing process. This variant is available in the balancing process after the 
calculation is complete. Of course this variant is simultaneously the main and 
active variant. All other variants are subsequently added to the balancing 
process. 

 

Figure 219: Product Variants Menu 

Adding and Weighing Variants 
The variants for which the balancing process was generated is displayed in the 
Properties dialog. The weight is of course one hundred percent on the first 
balancing process. 

Product variants 

for the balancing 
process schema.  
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Figure 220: Properties Dialog with a Variant 

1) In the Product variant menu select the menu item Add product variants 

in order to add variants. The process graphs of the possible product 
variants are displayed in the upper window of the dialog. Please refer to 
the Figure 219 and Figure 221. 

 

Figure 221: Add Product Variants Dialog 

2) Select the variant in the upper window. The variants must be added 
individually. Confirm the selection by clicking OK. 

3) The Product variant settings dialog is then opened. The added variant is 

displayed. The main and active variant are also displayed. 

4) Specify the weight. The weight of all variants must always add up to one 
hundred percent. Tip the corresponding percent values into the fields 
under Weight. 

5) You can set the main variant only in this dialog. You can set the active 
variant in this dialog as well as in the selection menu of the job 
coordination view. The active variant is always the variant you can edit.  

6) To edit the variant, click in the corresponding fields under Main / active 
variant. 

7) Confirm the entries with OK. The calculation is executed. 

 

Initial situation after 
the first balancing 

process – planned 
variant is the same 
as the main and 

active variant. 
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Figure 222: Weighing in the Dialog 

3) After the calculation the Consistency Check dialog opens; it shows you 
possible errors which you can then correct. Please refer to the Figure 223. 

 

Figure 223: Planning Errors are Immediately Displayed in the Dialog 

4) Close the dialog by clicking Close. 

7.13 Displaying Product Variants in Balancing List View 
and Process List View 

You can make a comparison of the balanced processes between active variant 
and the other product variants. The Balancing List View and Process List 
View are enhanced to: 

 display one column for each product variant in Balancing List View and 
Process List View. Column for active product variant is displayed as 
Active.  

 display “X” against each process of active variant in column of active 

product variant and against each process in column corresponding to the 
inactive product variant if an identical process exists to this process in that 
inactive product variant. 

This enhancement is applicable to Workplace list view and for ALB in both FAL 
and PMS modes. 
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1) Consider the following Project structure. 

 

Figure 224: Display Product Variants in Balancing: Project Structure  

There are three workplans: Product Variant 1, Product Variant 2, and Product 
Variant 3.  

 Product Variant 1 is having 6 processes: proc1, proc2, proc3, proc 4, 
proc5, and proc6. 

 Product Variant 2 is having 6 processes: proc 4, proc5, proc6, proc7, 
proc8, and proc9. 

 Product Variant 3 is having 9 processes: proc1, proc2, proc3, proc7, proc8, 
proc9, proc10, proc11, and proc12. 

 Proc4, proc5 , and proc6 are common between Product Variant 1 and 
Product Variant 2. 

 Proc7, proc8, and proc9 are common between Product Variant 2, and 
Product Variant 3. 

 Proc1, proc2, and proc3 are common between Product Variant 3 and 
Product Variant 1. 

2) Open ALB on Product Variant 3 and add product variants “Product Variant 
1” and “Product Variant 2”, but active product variant is “Product Variant 3”.  

 

Figure 225: Product Variant Properties 
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3) Open the Balancing List View. 

 

Figure 226: Changes in Balancing List View 

The changes in Balancing List View are: 

 Three columns are added in the Balancing List View, one for active 

product variant “Product Variant 3 (Active)” and other two for inactive 
product variants (Product Variant 1 and Product Variant 2). 

 “X” is shown against all processes in the column “Product Variant 3 
(Active)”. 

 As Proc1, Proc2, and Proc3 are common in the Product Variant 3 and 
Product Variant 1, there is one „X‟ mark against them in their respective 
rows under “Product Variant 1” column. 

 Proc7, Proc8, and Proc9 are common in the Product Variant 3 and Product 
Variant 2, so there is one „X‟ mark against them in their respective rows 
under “Product Variant 2” column. 

4) Open Process List View. 

 

Figure 227: Changes in Process List View 

 Three columns are added in the Process List View, one for active product 
variant “Product Variant 3 (Active)” and other two for inactive product 
variants (Product Variant 1 and Product Variant 2). 

 “X” is shown against all processes in column “Product Variant 3”.  

 As Proc1, Proc2, and Proc3 are common in Product Variant 3 and Product 
Variant 1, so there is one „X‟ mark in against them in their respective rows 
under “Product Variant 1” column. 

 Proc7, Proc8, and Proc9 are common in Product Variant 3 and Product 
Variant 2, so there is one „X‟ mark against them in their respective rows 
under “Product Variant 2” column. 

If Balancing List View and Process List View are visible, the columns for 

“product variants” is updated in the following cases: 
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 When a different Product Variant is made Active. 

 When a common process (a process which is common in active variant 
and inactive variant) is removed in 2D View, Balancing List View or 
Process List View. 

 When a common process is moved from one workplace to another in 2D 
View, Balancing List View or Process List View. 

 When a product variant is added or removed. 

7.14 Planning the Logistics for Parts Delivery 

As of the DPE 5.17 release the calculation for parts delivery has been 
extended by two options, which can be used when planning several product 
variants. This makes a total of three options that aid in making the planning of 
logistics possible. 

Up till now, the number of parts bins needed for each process was calculated 
and the common result was too high. This in turn meant a considerable 
amount of space would be needed for these parts bins on the line. 

To prevent the calculating of duplicate parts bins from identical processes and 
parts, into the number of parts bins needed for the planning of product 
variants, you have the possibility of directing the calculation by way of 
processes or identical parts using the new options. 

This chapter will provide you with a general overview of how this works: 

 Using the Using Options option 

 Using the Do not handle Duplicate Partbins  option. 

 Using the No duplicate Partbins for Same Processes option. 

 Using the No duplicate Partbins for Same Parts option. 

7.14.1 Using Options 

The options for calculating the number of parts bins can be set in the ALB-
configuration. As long as you do not change and save the option for a 
balancing process, the option setting made in the ALB-configuration is valid for 
all newly created balancing processes. 

Also see the corresponding chapter in the Administration Manual. 

After starting the ALB, the configuration setting can be changed for a user via 
the Parameter for Automatic Balancing dialog. 

1) To open this dialog, select the Station data menu item in the Automatic 

Balancing menu. 

2) Under Logistics Planning select the option that you want to use for 

calculating the number of parts bins. 

3) Once you have confirmed your selection with OK, the calculation will 

automatically be carried out. To make the option setting permanently valid 
for the balancing process, save the option settings for this balancing 
process. 

file:///C:/Documents%20and%20Settings/OUM/Application%20Data/Microsoft/Word/Administration.pdf
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Figure 228: Options for the Number of Parts Bins 

Using the Options for Parts Delivery 

 

Figure 229: Logistics Planning 

 Option one, the same planning as before: 

Duplicate bins are not handled – Planning the same way as before for parts 

delivery means, an appropriate parts bin is made available and calculated in 
for each and every process of a product variant. Please refer to the Creating 
Logistics Data. Please refer to the Figure 228. 

 Option two, no duplicate parts bins for the same processes 

With the help of this option, the number of parts bins for the process of the 
main variant is first calculated. Next, depending on the supply turnover ratio of 
a process on line, they are made available for the planning of identical 
processes, which are in turn used for different product variants. 

 Option three, no duplicate parts bins for the same parts 

The third option enables you to calculate the number of parts bins for the 
planning of identical parts on the basis of a unique parts number. Use this 
option when planning identical parts that are used in different product variants, 
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or occur repeatedly in a single variant. In this case a different parts number is 
given for the same part, depending on the usage. 

The calculating of the number of parts bins takes place when, parts are linked 
with a process by way of a relation, over which the parts for delivery are 
calculated and depending on the material supply, made available on the line.  

Example 

Two identical parts are used for the assembly of product C, the parts W1 and 
W2. Every identical part should receive a different parts number.  

Product C is to be balanced:  

 W1 is linked via relation 1 with process 1  

 W2 is linked via relation 2 with process 2 

Process 1 and process 2 are both linked with product C.  

 Both processes, which are linked with the product C via relations 1 and 2, 
are recognized during the balancing process for product C. If you activate 
the no duplicate parts bins for the same parts option, the parts are 
supplied for the process first used in the balancing process. All other 
processes linked with this part, are to be disregarded for the material 

supply planning. 

When the disregard option is activated, the supplying of materials happens 

separately for all identical parts linked with processes – such as both of the 
processes 1 and 2 in the example. 

Open the balancing, set the planning mode. The Enhanced logistics planning 
mode is set in the base data of ALB: 

No duplicate Part Bins for Same Parts inside a Station: Same as “No 

duplicate Part Bins for Same Parts”, but the scope of the parts is only inside 
the station. If this option is selected the algorithm does not search for same 
parts in the complete line, but only inside a station instead.  

No duplicate Part Bins for Same Parts inside a Material Area: In this mode, 

the scope of the same parts is only inside the material area. That means, if 
there are two same parts inside a material area, they share one part bin 
together. 

In the following examples, only the two new modes are considered. 

Situation 1: Moving a container from one material area to another 
Mode: No duplicate part bins for same parts inside a station 

 The container is moved to another station: If the moved part has a 

same part in the origin station, a new part bin is placed for the left same 
part(s). The same is valid for the destination station: If there is a same part 
for the moved part in the destination station, the moved part bin is not 
visible in the destination station, because the already existing part bin is 

used for this part. 

 The container is moved inside the station: The number of part bins 

cannot be updated. 

Mode: No duplicate part bins for same parts inside a material area 

 The container is moved to another material area: If the moved part has 

same part in the origin material area, a new part bin is placed for the left 
same part(s). The same is valid for the destination material area: If there is 

Planning for 

Identical Parts. 
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a same part for the moved part in the destination material area, the moved 
part bin is not visible in the destination material area, because the already 
existing part bin is used for this part. It does not matter if the destination 
material is in the same  

 The container is moved inside the material area: The number of part 

bins cannot be updated. 

Situation 2: Moving a process from one workplace to another 
(within a station) 

Mode: No duplicate part bins for same parts inside a station:  

The number of part bins cannot be updated. 

Mode: No duplicate part bins for same parts inside a material area 

If the process is moved to a workplace that uses the same material area, the 
number of part bins cannot be updated. If the process is moved to a workplace 
that uses another material area, these checks are done: 

 A new part bin is placed in the original material area, if the moved part bins 

contains any parts that have a same part in the original container area. 

 The moved parts use the already existing part bin, if moved part bins 

contain any parts that have a same part in the destination material area.  

Situation 3: Moving a process from one station to another 
Mode: No duplicate part bins for same parts inside a station 

 A new part bin is placed in the original station, if the moved part bins 

contains any parts that have a same part in the original station. 

 The moved parts use the already existing part bin, if moved part bins 

contain any parts that have a same part in the destination station.  

Mode: No duplicate part bins for same parts inside a material area 

 A new part bin is placed in the original container area, if the moved part 
bins contains any parts that have a same part in the original container 

area. 

 The moved parts use the already existing part bin, if moved part bins 

contain any parts that have a same part in the destination container area.  

7.14.2 Using the No duplicate Part bins for Same Processes 
Option 

The same part can be used in different product variants. To plan the same part 
for product variants (for the assembling of a part, for example), a process must 
be planned for each product variant in order to edit the part. So in other words, 
this means identical processes for each product variant. 

These processes can be marked as identical in ALB. The marking can be 
carried out over relations or bill of materials entries as well. Please refer to the 
Marking Processes of the same Type via BOM Entries. 

 The number of parts bins can be planned on the basis of a process 
exclusively for processes that are marked as identical processes with the 
aid of the No duplicate Part Bins for Same Process option. 
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The principle behind calculating the number of parts bins is based on simple 
arithmetic: 

 During the planning of identical processes for main and active variants of a 
product, the calculating of the number of parts bins for the process (the 
product variant marked as the main variant) generally takes place with the 

first use in the balancing process. 

 The space required and number of bins will be calculated accordingly. If 
you change the main variant, the calculation is carried out based on the 
same scheme. The only difference of course is that it is for the identical 
process, which is the newly marked main variant for the planned product 

variants. 

The Exception Often Proves the Rule 
A possible exception to this principle is, when an identical process is not 

planned in to balancing process using the main variant – for example with 
three possible product variants, process P1 only appears in the second and 
third variant of the balancing process. 

The first variant is marked as the main variant, and is not used in the process 
P1. In cases such as this, the number of parts bins for process P1 is planned 
more or less on the principle of contingency. Normally, the number of parts 
bins for the process, that was planned in first is calculated (process P1 in the 
example). 

7.14.3 Planning the Number of Part Bins in the Job View 

To edit the delivery of parts in the job view, use the Parameter for Automatic 
Balancing dialog and the properties dialog of an identical process. 

Using Dialogs 
The following sections will inform you of the possible ways to use dialogs. 

Think of a balancing process in which two product variants are to be planned.  
The basis for the product variants are the process graphs (priority graph) 
Workplan 10 and Workplan 1. The product variant that is to be planned on the 
basis of Workplan 10 is also the main variant and active variant.  

 

Figure 230: Examples of Product Variants 

To provide more of a vivid display of the results, the first step should be to 
adjust the Do not handle Duplicate Part Bins option in the station data. 

You'll recall that the parts bins for each process are planned using this setting 
– this is basically the same as the only possible method used in earlier 
versions in ALB, for planning the number of parts bins. 

Process 12 is marked as the identical process in both variants. 
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In review: Processes for the active variant are always displayed in the color of 
the workspace; all other processes are displayed in grey. 

In the example the process 12 is pictured twice: The process shown in yellow 
is the process for the active variant and, at the same time the process for the 
main variant. 

The following picture shows that with this option parts bins are calculated for 
both processes (main- and active variant). 

 

Figure 231: Parts Bins are Supplied for both Processes 

For the next step, change the option for calculating the number of parts bins to 
No duplicate Part Bins for Same Processes. Please refer to the Using 

Options. 

1) Open the Parameter for Automatic Balancing dialog. 

2) Then select the No duplicate Part Bins for Same Processes option. 

3) Confirm your selection by pressing OK and then close the dialog. 

The calculation for the number of parts bins is carried out immediately, as the 
following picture shows: 
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Figure 232: Calculate the Number of Parts Bins according to the Process of the  
Main Variant 

Changing the Parts Delivery for an Identical Process 
The foregoing example showed how, the number of parts bins can be 
calculated by changing the option in the station data. Changing the option in 
the station data always affects the entire balancing process, for all identical 
processes. 

This next step will explain how to change the delivery of parts for a single 
process. 

For some parts it makes sense to have the parts available in different areas for 
individual delivery to each process, even when this process is marked as 
identical. 

So that you do not rearrange the option for parts delivery of the entire 
balancing process, you can change the parts delivery for single processes via 
the properties dialog. 

In our example the parts delivery for the Process 12 is to be changed again. 

The change is always made using the process of the active variant and never 
the main variant in the case of identical processes. 

To free the parts delivery from the process of the main variant, deactivate the 
Use material planning from main process field. The Main process for 
material planning field cannot be edited. 

When this field is activated, the parts delivery is carried out according to the 
option settings in the station data. 

Neither of the two fields can be edited in the case of an identical process for 
the main variant. 
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Figure 233: Process Properties Dialog for the Active Variant 

The result is that the number of parts bins is planned in for both processes 
(main- and active variant). 

 

Figure 234: Planning for an Identical Process is Changed 

7.14.4 Using the No duplicate Part bins for Same Parts 
Option 

A second way to avoid identical parts bins that belong to the same part from 
appearing in duplicate on the line, is by identifying each part with a unique 
parts number. The same part can be used in different product variants or 
several times in a single product variant, for example. 
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The only stipulation for using the No duplicate Partbins for Same Parts 

option for planning is, is that you give the same part a different parts number, 
according to its usage. 

The balancing process for the product variant is carried out as usual, via the 
process planning of the process graph being used. To calculate the number of 
parts bins, link the parts to a process by way of a relation. 

Result of the Planning 
The result of planning with the assistance of this option is shown in both of the 
following pictures: 

Initial Situation 
The first picture shows planning with the Do not handle Duplicate Part Bins 
option. The parts bins for the same part are supplied for the station, according 
to the link with a process. 

 

Figure 235: All of the Parts Bins are Planned In 

The Option is Used 

1) Once again, open the Parameter for Automatic Balancing dialog to plan 
the number of parts bins using the No duplicate Part Bins for Same 
Parts option. 

2) Then select the No duplicate Part Bins for Same Parts option. 

3) Confirm your selection by pressing OK and then close the dialog. Please 

refer to the Using Options. 

The calculation for the number of parts bins is carried out immediately, as the 
following picture shows. Please refer to the Figure 235. 
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Figure 236: The Option has Optimized the Number of Parts Bins 

7.14.5 Editing Product Variants in Job Coordination 

You can edit the enabled product variants in the Job coordination view. You 
can also have a variety of options for displaying the ascertained results. The 
following examples follow the most common case in practice - all processes 
are displayed according to weight. There are two further selection menus for 
editing the product variants: 

 You can set which balancing process of a product variant is displayed 
using the buttons PV's together and PV's separated. When viewed 

together, all variants are shown. 

 All added variants are displayed in the selection window All models – all 

variants (active and inactive processes) are shown in the Job coordination 
window if All models is set. In this selection window you can also select a 

product variant to be individually displayed. This variant is then the active 

product variant.  

 The active variant is always displayed in the status line. The job data are 

displayed according to the selection.  

  The job data of all added variants (active and inactive variants) are 
ascertained and displayed if All models is set. 

 Only these job data are displayed for a select variant. (Please refer to the 

Figure 63). 

Showing Balancing Process Results 
The following settings, for example PV's together or PV's separated, Please 
refer to the Balancing view in ALB. 

In order to display the results of only one variant, set PV’s separated. 

1) In order to display the results of all variants, set PV’s together. In this 

mode always all processes will be displayed, independent on which 
product variant is chosen. 
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2) In order to display the processes of all variants (active and inactive 
variants), set All models. The active variant remains unchanged with this 

setting. 

3) In order to display the processes of only one variant, set the variant. If you 
want to display only the processes of one product variant, the mode PV's 
separated must be set. 

 This variant is the active variant, and you can edit its processes. 

Displaying a Variant (Product Variant Separated) 
In the example, the  active product variant is product variant A. 

 Button PV’s separated is enabled. 

 All models are enabled. 

 The processes of the inactive product variant B are displayed in light 
gray – for example, process 21. The processes of the active variant A are 

displayed in the colors set at the workplace. 

 The calculated time (processes per workplace) is calculated only for this 

variant. 

 The job data of all variants are displayed (in the example, of variants A and 

B). 

 

Figure 237: Job View for a Product Variant 

Displaying all Variants (Product Variants Together) 
In the example, the product variant A is active and B is inactive. 

 Button PV‟s together is enabled. 

 All models are enabled. 

What results are yielded with this setting? 
 The calculated time (processes per workplace) is calculated for both 

variants. 

 The job data of all variants are displayed (in the example, of variants A and 

B). 
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 The display of the processes for both variants corresponds to the weight of 

the variants and processes as well as the existing precedence relations.  

 Inactive processes are displayed in light gray. 

 

Figure 238: Job View for Two Product Variants 

Display for One Variant (Two Displays) 
The display of variant B is shown in both of the following examples.  

Example One: 
Only the processes of variant B are displayed in the job view. 

 Button PV‟s separated is enabled. 

 Product variant B is enabled. 

 

Figure 239: Display of the Processes for One Variant 

Example Two: 
The processes of variant B and variant A are displayed in the job view. 

Calculated values always refer to the active variant (in the example, variant B), 
such as the activity period or utilization. 
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Variant B stays the active variant in this example. 

Note 

If you want to set a different variant as the active variant, you have to directly 
select this variant. Switching to  All models affects only the display of the 
variants in the job coordination view. 

Button PV‟s separated is enabled. 

 All models are enabled. 

 Inactive processes are displayed in light gray. 

 

Figure 240: Display of the Processes with Inactive Variants 

7.14.6 Removing Product Variants, Opening the Properties 
Dialog 

You can remove product variants from the balancing process and replace 
them with new variants. 

As the word remove indicates these variants are only removed from the 

balancing process and not deleted. You can use these variants for another 
balancing process at any time. Variants are usually deleted in the PPR-
Navigator. 

1) To do this, click on Remove product variants in the Product variants menu. 
Please refer to the Figure 219. 

2) In the Remove product variant dialog, select the variant (in the example, 
product variant B). 

 

Figure 241: Remove Product Variant Dialog 
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3) Then click Remove. Messages corresponding to the balancing process 

setting (for example. the variant to be removed is the active variant) are 
displayed. Please refer to the Messages for Product Variant Planning. 

Opening the Properties Dialog 
The variant that was removed is no longer displayed in the Properties dialog 
or in the selection window under All models. 

Click Properties... in the Product variants menu,  Please refer to the Figure 
219, to open the Product Variant Properties dialog box. 

 

Figure 242: Product Variant Properties dialog box 

7.14.7 Messages for Product Variant Planning 

Balancing process messages have a variety of purposes and they suggest a 
sensible action on your part. Just as is the case with other processes in the 
editing of a balancing process, you can be informed of a certain circumstance 
when planning several product variants. 

The basic messages are explained briefly below: 

Product Variant Enabled 
Whenever product variants are removed this message appears if the variant to 
be removed was previously set as the active variant. 

 

Figure 243: Variant Enabled Message 

Weight 100 Percent 
This message appears when the sum of the weight in the Properties dialog of 
the product variants is larger or smaller than one hundred percent. The weight 
values must be corrected so that they add up to one hundred percent.  

 

Figure 244: Sum of the Weight is one Hundred Percent 

Moving Processes of the Same Type 
This message appears whenever you want to move a process of the same 
type to another workplace in manual balancing process editing. 
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Figure 245: Moving Processes of the same Type 

7.14.8 Displaying Lines in Part Bin Group Visualization 

Earlier, part bin group is shown as one single part bin in 2D Balancing View, 
though it consists of several part bins. 

 

Figure 246: Former Behavior for Part Bins 

In above image, PBG „LP001‟ consists of two part bins placed side by side. 
PBG „LP001‟ in grey colour consists of two part bins placed one behind other. 
PBG „New Plant‟ consists of a total of 4 part bins 2 placed side by side and 2 
placed behind each other. 

 

Figure 247: Dotted Lines in Part Bins 

Starting R21, additional dashed lines are displayed in the visualization of part 
bin group for all single part bins of the part bin group. It helps to see the 
number of part bins in that part bin group. The text is placed at the top in case 
of part bin groups in right material area and at the bottom in case of left 
material area. The text is created for the complete part bin group and not for 
individual part bins. 

The visualization of Part bin groups need to be updated whenever there are 
changes in Line up and filling in case of Assembly1, Container principle and 
number of containers along line in case of Assembly 2 and Logistics. These 
can be changed through the Properties command, Recalculate Balancing, 
and Rotate Part bin by 900. Also update visualization of Part bin groups for 

cases like moving process from one material area to another material area, 
from one station to another station; moving part bin group from one material 
area to another material area, from one station to another station, from one 
material area to shelfl, removes the part bin from shelf, Re-Arrange the 
Material Area, save and reopen the line, and moving and switching part bins.  
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Assembly 1: Different cases are: 

Case 1: Two containers placed one behind another for Stack 1, Line up 2, Part 

per Container 1 and Filling 1. 

 

Figure 248: Assembly 1: Case 1 

Case 2: Four containers placed side by side for Stack 1, Line up as 2, Part per 

Container 1, and Filling 4. 

 

Figure 249: Assembly 1: Case 2 

Case 3: Two containers placed one behind another for Stack 1, Line up as 2, 

Parts per Container as 4,and Filling 4. 

 

Figure 250: Assembly 1: Case 3 

Case 4: Two containers placed one behind another for Stack 2, Line up as 3 

and total resultant number of parts as 1, the below arrangement is resulted by 
default (even though so many containers are not required).  

 

Figure 251: Assembly 1: Case 4A 

The total number of parts can be calculated depending upon Filling and Parts 
per container. These total parts are then accommodated into this arrangement. 
If all can be accommodated, then there is no change in arrangement. If all 
cannot be accommodated (even a single part remains), a similar arrangement 
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(stack 2 and line up 3) is replicated to manage the remaining parts as shown 
below: 

 

Figure 252; Assembly 1: Case 4B  

Assembly 2:  

 

Figure 253: Assembly 2 

Container principle describes how many part bins can be placed one behind 
each other and Number of containers is the total number of containers in the 

part bin group. 

Case 1: Two containers placed one behind another for Container Principle 2 

and number of containers 2  

 

Figure 254: Assembly 2: Case 1 

Case 2: Four containers placed side by side for Container Principle 2 and 

number of containers 4 

 

Figure 255: Assembly 2: Case 2 

Logistics: Same as Assembly 2. 
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Fixed Surface: No change.  

Shelf: No change. 

7.15 Using Graphic Layout for ALB 

The stations, material provision areas and loading units of a workload 
balancing are shown graphically in the layout with the help of the layout 
display.  The layout is created automatically if you create a new workload 
balancing for a line. You can then edit a layout. 

The setup of the performance view in the Automatic Line Balancing is divided 
into graphic and logistic elements: 

 Graphic elements of the performance view are stations, material provision 

areas, and loading units such as parts bins, shelves, and palettes.  

 Logistic elements of the performance views are processes and 

workplaces. 

The graphic elements of the performance view can be displayed and edited in 
the layout. One possible way of editing in the layout is to reposition graphic 
elements: moving material provision areas and stations takes effect only in the 
layout. If, however, loading units are repositioned, this also takes effect on the 
performance view in the ALB. 

 

Figure 256: Display of the Performance View in the ALB 

Set Layout for Parts Bin and Shelves 
The system elements for the parts bins and shelves are created in the system 
library. In order to correctly position the graphic of parts bins or shelves in the 
layout of the workload balancing, the zero point must be set for the graphic as 
follows: 

 The X and Y axes must be positioned in the middle of the parts bin and 

the base of the parts bin must be on the zero point of the Z axis. 

For more information, please refer to the System Library Manual. 

file:///C:/Documents%20and%20Settings/OUM/Application%20Data/Microsoft/Word/SystemLibrary.pdf
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7.15.1 Fixing the Layout 

You can fix a layout if the graphic elements of the performance view are no 
longer to be changed in the ALB. Once you have fixed a layout, the graphic 
elements positioned in the layout are one hundred percent identical to the 
planned stations and loading units of the performance view: layout and 
performance view therefore have the same status.  

 If the field is activated, the graphic elements of the performance view such 
as parts bins, shelves, or stations can no longer be changed in the 

performance view in the ALB. 

 Whenever a process with a fixed layout is moved, the bin is not moved 

along with the process. 

1) The field can be activated in the properties dialog of the line. 

 

Figure 257: ALB Layout Fixed Field 

2) The field is also available in the Basic Data dialog when a workload 
balancing is open. 

 

Figure 258: Layout 

If you have opened the workload balancing and deactivate the field, all stations 
are again available for editing. After saving the changes you can again fix the 
basic data in the Basic Data dialog. The saved changes of the workload 
balancing are executed in the layout. 

7.15.2 Editing Graphics in the Layout 

The graphic elements of the performance view are shown in the layout. 
Loading units are displayed as graphic elements only if they were planned 
concretely with a set number of loading units. A loading unit identified as a 
fixed area in the ALB is not recognized or displayed as a graphic element. The 
loading unit that has been reserved as a fixed surface in the ALB, can be 
identified and displayed using a so-called dummy-bin as a graphic element. 

Open Edit Graphic 

1) In order to open the layout for editing, switch to the resource view. 

2) Select Edit Graphic in the contextual menu. 
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Figure 259: Open Edit Graphic  

For more information on the editing of graphic layouts, please refer to the 
Graphic Tools Manual. 

Views in the Layout 
The layout can be displayed in various ways. Three important views for the 
display are described below. 

The views can be set via the tool bar whenever a graphic is open. 

 

Figure 260: Toolbar 

 

Figure 261: Example of a Layout with Graphic Display – Volume Display 

 

Figure 262: Example of a Layout with a Graphic Display – Wire Model 

Display in the top view. The top view is very well suited for the re-positioning of 
loading units. 

file:///C:/Documents%20and%20Settings/OUM/Application%20Data/Microsoft/Word/GraphicTools.pdf
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Figure 263: Example of a Layout with a Graphic Display – Top View 

Edit Loading Units 
You can move and delete loading units in the material provision area. 

For example, in order to move or delete a loading unit, select the loading unit 
in the graphic. In order to move a loading unit, keep the control key pressed 
while moving. 

 

Figure 264: Example of a Select Loading Unit that is being Moved  

Note 

When deleting shelves, the parts bins are not deleted along with them. The 
parts bins are set to the position of the shelf after the shelf is deleted.  

Rules for Moving Loading Units 
 Loading units and shelves should be moved only within a material 

provision area. 

 If several loading units are defined for the supply of a part on the line, the 
complete group must always be moved (Container bunch). 

If several bins are defined for the delivery of a product (Container bunch), all 
the part bins must be moved as a group. This process is shown in the table. 

Table 3: Example of Moving Several Bins for a Product  

Description 
Parts bins re-positioning a product via the 

layout 

The six parts bins for the material 
provision of a product on the line 
are shown in the performance view 
as a block. 
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Description 
Parts bins re-positioning a product via the 

layout 

After saving the layout and re-
opening the ALB, the six parts bins 
are re-positioned in the 
performance view. 

 

If a product is provided in several 
bins on the line, all of the bins must 
be moved as a group -- in the 
example, the six selected orange 
parts bins. 

You should move bins only in the 
station with which the parts bins are 
linked in a fixed manner via the 
relation. 

Wire model display mode  

After saving the layout and re-
opening the ALB, the six parts bins 
are re-positioned in the 
performance view. 

 

Editing Stations and Material Provision Areas 
Stations and left and right material provision areas can be re-arranged in the 
layout. These changes are not executed in the layout in the performance view 
in the ALB. 

Note 

Stations should not be deleted in the layout. 

 

Figure 265: Moving Entire Stations with Material Provision Areas 
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Figure 266: Moving a Material Area 

Typical Messages after Editing in the Layout 
The messages refer to editing steps taken in the layout upon opening the 
Automatic Line Balancing. 

This message appears whenever you move loading units such as parts bins 
and shelves in the layout. 

 

Figure 267: Message Loading units Moved 

This message appears whenever you move a parts bin with which a product is 
provided from a group of parts bins in the layout. Please refer to the Table 3. 

 

Figure 268: Message Parts Bin Moved from a Group 

Show the Fixed Surface in the Graphic 
To show the fixed surface in Layout, the ALB Dummy Partsbin attribute must 
be configured for the Dummy Container plantype in ALB-configuration. 

For more information on ALB-configuration, Please refer to the Administration 
Manual. 

The fixed surface is displayed as a two-dimensional box in the layout, 
according to the planned dimensions for the fixed surface in the material 

file:///C:/Documents%20and%20Settings/OUM/Application%20Data/Microsoft/Word/Administration.pdf
file:///C:/Documents%20and%20Settings/OUM/Application%20Data/Microsoft/Word/Administration.pdf
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supply dialog – the fixed surface in our example amounts to one square meter. 
Please refer to the Executing Calculation according to a Fixed Surface. 

 

Figure 269: The Fixed Surface in the Layout 

7.16 Show Graphic of Parts 

From Release PE 5.17 on you can view graphics of parts. This function is only 
available if you have installed a script. 

For further information concerning this script, please refer to the Scripting 
Manual. 

1) In order to view the graphic of a part, in the performance view open the 
properties dialog of a process by double-clicking. 

2) Under the Material Supply tab, open the contextual menu on a part. 

3) Then select the menu item Show Graphic. 

 

Figure 270: Show Graphic for Parts 

Process Engineer opens with the graphic window. 

file:///C:/Documents%20and%20Settings/OUM/Application%20Data/Microsoft/Word/Scripting.pdf
file:///C:/Documents%20and%20Settings/OUM/Application%20Data/Microsoft/Word/Scripting.pdf
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Figure 271: Graphic Window with Part 

7.16.1 Planning Alternative Processes in the Process Graph 

Identical products are planned on the basis of the same process graph.  The 
customer can choose the equipment for example, for a vehicle. The same 
vehicle with glass sliding roof is delivered for a customer, and for another 
customer the sliding roof is made of metal. The processes for this production 
are as a rule the same. The alternative processes are marked with the relation 
Is alternative in the process graph. Depending on the equipment the product 

is supposed to have, the respective alternative process is planned in the 
balancing process. 

 The processes marked as alternative processes mutually exclude each 
other. Thus only the respective process for the particular equipment feature 
is planned. 

 Alternative processes are displayed in the hundred-percent display only 

if the process is marked as Max. Car in the properties dialog of the 
alternative process. Please refer to the Figure 35. 

The following prerequisites apply to the 100% display of alternative processes: 

 If several alternative processes are marked as Max. Car, the alternative 
process that has the greatest process time is displayed in the 100% 

display. 

 The point in time at which the respective processes are planned is 

determined using frequency. 

Generating Alternative Processes in the Process Graph 
You can generate alternative processes for the same process graph either 
directly in the process structure of the variants in the PPR-Navigator or in the 
open process graph. The procedure is the same for both possibilities. 

Example of Link in the PPR-Navigator 

1) Select the process in the process structure of the variant.  

2) Drag the process to the alternative process. Then select the relation is 
alternative in the dialog. Select the same relation in the selection window 
of the relations in the process graph before linking. 

3) Confirm the selection in the dialog with OK. 
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Figure 272: Alternative Processes in the PPR-Navigator 

7.17 Contextual Functions in Automatic Balancing 

The contextual menu functions for automatic balancing are available 
corresponding to the design. In the contextual menu, you can add new stations 
and delete them or edit a workplace. 

This chapter will provide you with an overview of the context functions in the 
Automatic Balancing view. 

Opening Contextual  Menu 
Contextual menus are accessed using the right mouse button. There are 
always two different contextual menus in Automatic Line Balancing: the 
Material Supply and the Workplace menu. 

 

Figure 273: Workplace Contextual Menu 

1) Move the left mouse button to the workplace. Then press the right 
mouse button. 

2) The contextual menu will be opened with the enabled functions. 
Whether or not a function is enabled in the contextual menu depends on the 
function you want to execute and the function you have already executed.  

Contextual  Menu for the Workplace 
The table (Please refer to the Table 4) provides an overview of the procedures 
during which the Functions of the Workplace contextual menu are active. 
Please refer to the Figure 273. 

 

 

 

 

 

Example of 
opening a 
contextual 

menu.  
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Table 4: Overview - Table for Active Context Functions - Workplace 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A
d

ding, deleting stations 
The function Add station allows you to add a new station in the Performance 

Management display adaptation. 

A station is always added before the station from which you opened the 
contextual menu. 

1) Click on the station before which you wish to add the new station.  

The function Delete station allows you to delete only stations with no 

processes or containers assigned to. Please refer to the Figure 273. 

Locking station range, releasing workplace 
The function Lock station range allows locking exclusively vacant 

workplaces. It is not possible to lock an entire station in one go.  

The function Release workplace allows releasing locked workplaces. Please 

refer to the Figure 273. 

Setting up drift range, releasing workplace 
The function Release drift range allows to lock work areas from other 

workplaces. 

This function is used when the computed processes to be handled by a 
workplace for some product variants cannot be completed in the allocated takt 
time and the processes thus must be processed in at least two stations for 
these product variants. This function ensures that no other process can be 
worked on during this phase at the workplace identified as a drift range.  

The function Release workplace allows re-releasing the drift range. Please 

refer to the Figure 273. 

Rename workplace 
You can name every workplace individually with the Rename workplace 
function, for example, instead of the car body position; you can select a name 
for the activity of the workplace. 

Active Context Functions Descriptions 

Add station This function is always active. 

Delete station 
This function is active only when no processes are assigned to the 
station. 

Lock station range 
This function is active only when no processes are assigned to this 
workplace. 

Set up drift range 
This function is active only when no processes are assigned to this 
workplace. 

Release workplace 

This function is active only when a workplace is either locked (Lock 

station range) or a drift range is set up. This function is used to 
reset the locking of a workplace. 

Suppress multi-sequence 

This function is active only when a workplace is a multi-cycle 
machine. This function allows you to suppress a  multi-cycle 
machine. 

Restore multi-sequence 
This function is active only when a workplace  is a multi-cycle 

machine. This function allows you to restore a multi-sequence. 

Edit workplace This function is always active. 

Show process paths 
This function is active only when processes are assigned to this 
workplace. 

Rename Workplace 
This function is always active, except there are workplaces for 
which identical body position have been defined. 
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1) Click on the workplace you want to rename. Then open the contextual 
menu and select Rename workplace. 

 The old name will be shown in the dialog. Type in the new name and 
confirm the entry by clicking OK. The new name is immediately displayed 

at the workplace. 

The functions listed below are described in the following chapters: 

 Please refer to the Workplace View. 

 Please refer to the Editing MultiCycles and Suppressing MultiCycles, 
Restoring MultiCycles. 

 Please refer to the Show Process Path. 

Show Process Path 
Two options for material supply need to be considered when simulating the 
process path between workplace and parts bin: 

 An employee fetches the needed parts for each process in work from the 

parts bin separately. Please refer to the Figure 277. 

 An employee fetches 
the parts for processes in work from the marked parts bin. Please refer to 

the Figure 276. 

Configure the setting in the properties dialog of a parts bin.  

In the Automatic Line Balancing walkways are simulated and shown only for 
one workplace.  

 Walkways can only be simulated if a workplace has been assigned 
processes as well. 

 The process of a simulation can be interrupted at any time (press Stop or 
Break). Please refer to the Simulating Process Paths. 

Marking the Process Path in the Properties Dialog for Material 
Supply 
In properties dialog of a parts bin, mark the parts delivery to the workplace: 

 If the option Part must be fetched from container is active, the parts for 

each process from the linked container are marked separately by an 
individual process path, as before. Therefore, the parts for these processes 

need to be fetched separately. 

 If this option is not activated, the process paths of the employee are 

considered and parts will only be supplied from marked parts bins. 

You can open properties dialog also directly in the simulation window Process 
Paths and modify the marking. 
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Figure 274: Option – Supply Needed Material 

Two examples for determining the process paths will point out the two different 
options for parts supply. Please refer to the Simulating Process Paths. 

The first picture mirrors the situation, where a worker fetches parts for each 
process separately. 

 

Figure 275: Option is Activated for all Parts Bins 

The second picture mirrors the situation, where the option is activated only for 
particular parts bins. This option allows cutting down on process paths. 
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The sequence of process paths is marked in the picture. In this example, parts 
are first supplied for process 3, then for process 5. 

After process 5 has been completed, our worker returns to container 7 
(position 3) and brings the parts to the starting point of process 3. 

The material supply for parts from parts bin seven comes mainly from the 

parts bin, which offers the shortest process path to the workplace. The other 
two parts bins numbered 7 could contain parts, which are not regularly 
required for process 3, but only for specific versions. By putting a mark in the 
properties dialog for Material Supply, you can optimize the process paths. 

Note 

Using this option you can for example, fetch a number of parts in one process 
path. 

 

Figure 276: Option is not Activated in all Parts Bins 

Process Paths of Employee – Parts Bin 
The walkways of an employee for the parts transport are calculated as follows: 

 The position of a container is fixed for the calculation between the route of 
a container and the body point. Whereby the centre of the side of the 
container that is turned towards the conveyor is always used for 
calculation. 
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Figure 277: Example for Simulating or Showing Walkways 

 The containers are viewed individually and the walkways between the 

containers are also taken into consideration when calculating. 

 The sum of the walkways is shown in meters. The actual walkways are 
displayed with arrows. The arrowhead shows the direction of the walkways: 

between the processes and away from or towards the material containers. 

 This display shows the current information on the simulation of the process 
paths and the process to be executed at that point in time. In the example, 
the last process has been executed and the return to the material container 
is shown in order to be able to start the work process at this workplace 

again. 

Starting Show Walkways 
Before you show the walkways of a workplace, make sure once again whether 
processes have also been assigned to this workplace. 

1) Left-click on the workplace for which you want to show and simulate the 
walkways. 

2) Right-click to open the contextual menu. 

3) Click Show properties in the contextual menu to open the simulation 
window. 

All work places will be displayed in the simulation window. In the Workplace 
entry only the workplace is shown where the simulation window has been 
opened. 

In the selection list all workplaces of a station are displayed, including the 
workplaces to which no processes are assigned. Using the selection list you 
can select another workplace of this station for the simulation.  Please refer to 
the Figure 278. 

 

Figure 278: Selection List – Workplaces of a Station 
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Simulating Process Paths 
In order to simulate the process paths, use the four icons in the simulation bar. 
You can run the simulation for the selected workplace all at once or in single 
steps. 

 

Figure 279: Icons for the Simulation - Simulation Bar 

1) In order to run the simulation all at once, click on the icon on the left in the 
in the simulation bar. 

2) In order to run the simulation in single steps, click on the icon on the right 
in the simulation bar. 

 The Break and Stop functions, for example, can be used to get a precise 
overview of the current situation of the simulation. Using these two 
functions you can interrupt or restart the simulation at any time without 

closing the simulation window. 

3) In order to interrupt the running of a simulation and then to continue at the 
same point again, click on the Pause icon. Then click on one of the two 
icons for Start in order to run the simulation again. 

4) In order to interrupt the running of a simulation and to start the simulation 
at the beginning again, click Stop icon. Then click on one of the two icons 
for Start, in order to start the simulation again. You can use the Stop 

function, for example, to select another workplace of the station for the 
simulation. 

5) You can use a tool tip to show the process path in meters. To do this, click 
on one of the lines of the process paths displayed. 

Contextual Menus for Material Supply 
Automatic Line Balancing provides two contextual menus for material supply: 

 The contextual menu for the material supply area, allowing to lock and 

release the material supply area of a station. 

 For processing of the material containers, such as pallets, shelves or 

crates. 

Unlock or Lock Material Supply Area 
To lock the material supply area you have two options: 

 For free material supply areas 

 For occupied material supply areas 

There are four menu items in the contextual menu for locking/unlocking of 
material supply areas: 

 

Figure 280: Menu Items in the Contextual Menu for Locking/Unlocking of 
Material Supply Areas 

 Lock all 
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 Unlock 

 Unlock all 

 Locked areas 

Contextual  Menu for Free Material Supply Areas 
If you open the contextual menu on a free material supply area, you can 
initially choose from two menu items: Lock all and Locked areas…: 

 Using the menu item Lock all, locks the complete material supply area. 

This menu item is only active on a free material supply area. 

 Using the menu item Locked Areas…, locks single areas of a material 

supply area. Please refer to the Figure 281. 

1) In order to lock a material supply area, open the contextual menu on the 
material supply area. 

2) Select the menu item Lock all. This locks the complete material supply 

area. 

 

Figure 281: Contextual Menu for Material Supply Area 

3) In order to unlock the locked material supply area, either select the 
menu item unlock or unlock all. 

Contextual  Menu for Occupied Material Supply Areas 
If you open the contextual menu on an occupied material supply area, only the 
menu item locked areas… will initially be available. As mentioned earlier, 

using this menu item, locks individual areas of a material supply area – for 
both occupied and free material supply areas. Please refer to the Error! 
Reference source not found.. 

 

Figure 282: Contextual Menu for Occupied Areas 

You can define areas you want to lock in the dialog Locked Areas for Station.  

4) Open the contextual menu and select the menu item Locked areas…. 

By using Lock all, the complete material supply area of a station is locked. 

Click Unlock all; all locked areas will unlock. 

5) Confirm the selection with OK. 

These areas are marked as locked in the material supply area. 
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Figure 283: Individual Areas Locked 

Unlock Locked Areas Separately 

6) To unlock locked areas separately, select the locked area and open the 
contextual menu. 

7) Select the menu item Unlock. If all locked areas are to be unlocked, select 
the menu item Unlock all. 

 

Figure 284: Unlock Individual Locked Areas 

Creating and Managing Locked Areas 
1) Open the ALB Configuration, Right-click DPE project > Extra > Balncing 

ALB Configuration > ALB Customization. The ALB Customization 
dialog box appears. 

2) Specify plantype for the Locked area. 
This newly created plan-type would have a parent-child relation with the 
container area. Once locked areas are created on ALB and saved, these 
objects should appear in PPR tree as children of container area just like part 
bins and shelves. 

 

Figure 285: Plantype for the Locked Area 

If the resource plan-type is not defined with the plan type-set, then a message 
comes informing that the Locked area must have a proper plan type defined.  

3) Open contextual menu on the material supply area and select Locked 
Areas. 
The following dialog box comes. 
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Figure 286: Dialog Locked Areas 

StartX is the start X position in the container area. 100 in above figure indicate 
that the locked area start from the 100 on X axis. 

StartY is the start Y position in the container area. 100 in above figure indicate 
that the locked area start from 100 in Y axis. 

Length indicates how long the locked area is going to be. 4000 indicates it start 
at (100,100) coordinate in container area and will have a length of 4000. 

Width indicates how wide the locked area is going to be.7000 indicates it start 
at (100,100) coordinate in container area and will have a width of 7000.  

Name column takes the name to be given to a locked area. The maximum 
character length for Name is 1000. There is also length attribute and by default 
this is set to 64.  If the length more than 64 is required, then it needs to be 
configured using “length” attribute. 

With the above settings, the result in the 2D view of balancing looks as shown 
below: 

 

 

Figure 287: Result in the 2D View of Balancing 

4) Save this balancing with above settings, then in PPR tree the locked area 
object (“Pillar”) appears as a child of container area. 
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Figure 288: Locked Area Object in PPR Tree  

Behavior of Locked Area in Container Area 
The locked area is not moveable in balancing 2D view and cannot be placed or 
moved to outside corner with regard to the Free Placement of Part Bins. 

New locked areas can be created by filling more entries in the list view in the 
locked area dialog box. The positions and dimensions can be changed for a 
locked area from the respective locked area dialog box. Remove the 
coordinates in locked area dialog box that would remove the locked area in 
that container area. For editing a locked area, you can go to locked area dialog 
box and change the dimensions or location to see the change. 

The Snap functionality with regard to “Free placement of part bins” works with 
Locked areas. The part bins and shelves could be snapped with locked areas.  

Collision Detection while Creating Locked Area 
There should be check for collision on creation of locked area. Two scenarios 
exist: 

If there is no collision with any of the existing objects in container area, the 
locked area should be created on the desired place and the locked area dialog 
box get closed. 

If there is collision with any of the existing objects in the container area, then 
the locked area wouldnot be created and a message comes informing about 
the colliding object. In this case, the locked area dialog remains open. 
Information about colliding object contains the name and number of part 
bin/shelf/locked area and name/ number of parts/shelf if it collides with part bin 
or shelf or locked area. 

Persistency of Locked Area 
The locked area object should be persisted in PPR tree as a child of container 
area just like a part bin or a shelf with a parent-child relation. The information 
about the length and width is stored on “Length” and “Width” attributes of 
locked area object .The positioning of locked area with respect to container 
area is stored on the graphic info object on the parent-child relation of 
container area and locked area. The “name” attribute on locked area object 
stores the name of the locked area. While loading, this locked area object 
below container area in PPR tree is loaded to recreate locked area. 

Macros for Container Area and Locked Area 
The already existing macro “alb_materialarea_default.makro_es” takes care 
for both container area and the locked area graphical representation inside 
DPE. Two new macros, “alb_materialarea_default_new.makro_es” for 
container area and “alb_lockedarea_default.makro_es” for Locked area, are 
available and used by ALB for graphic representation of these objects in DPE 
by default. 

These new macro‟s are assigned to all newly created locked areas by ALB. 
The existing locked area macros should not be altered. There is also the 
possibility to change these macro‟s from DPE. 
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Deletion and Creation of Locked Areas outside of ALB 
Creation of locked area objects in PPR tree manually outside of ALB is 
possible and ALB consider those objects on load routine and display them in 
2D view. On loading, there is no check whether a locked area was created 
manually or by ALB. There is a check whether the locked area fits into this 
particular container area. If it does not fits or is exceeding the container area 
bounds, then this locked area should not be considered / created inside ALB. 

Deleting the locked area outside of ALB from PPR tree does not have any 
impact on re-load of balancing. The load does not check for locked area 
objects which are deleted outside of ALB. Whatever locked area objects are 
found under the container area object are considered and shown. 

Limitation 
Previous locked area information is converted and saved according to the new 
storage model. All reports which take into account the old storage format of 
locked area‟s for displaying their results are affected as the data in old format 
would be deleted. These reports need to be adapted according to the new 
model of storage. 

7.17.1 Positioning Material Containers 

Material containers are always linked to a process. The processes are 
executed at a body point. To optimize the walkways that an employee has to 
cover between the material containers and the body point, you can exactly 
position the containers on the material supply area in the Automatic Line 
Balancing. The material supply areas are always located on the right and left 
hand side of the stations. 

 Containers can directly be moved and positioned per mouse click or using 

the contextual menu functions. 

During balancing the Automatic Line Balancing places the containers in the 
same process sequence as they are assigned to the workplaces. 

Containers placed in such a way are not fixed to the material supply area of 
the corresponding station. This means, for example, that if you move a 
process to another workplace on the other side of the conveyor or to another 
station, the container is automatically moved as well and is placed according to 
the process sequence at the new workplace. 

Using this method, for example, you cannot control whether the containers 
have been placed in an optimal way compared to the process. Using the 
context functions you can exactly determine the placement of containers. 

 

Figure 289: Contextual Menu - Positioning Material Containers 

 Fixed Side means: You have fixed a container to one side of the two 

material supply areas of a station.  

 Fixed Position means: You have fixed a container to one side of the two 
material supply areas of a station and you have positioned it at exactly one 

place. 
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 If you now move a container process with a fixed assignment to another 
workplace, you can determine beforehand whether this container should 
be placed at a new workplace of the process or whether it should remain at 
the old place. Please refer to the Figure 296. 

Fixed Containers are Highlighted 
Containers with either a fixed position or a fixed side on the material supply 
area are highlighted. 

 Containers without fixation are not highlighted with a colored frame. 

Please refer to the Figure 290. 

 Containers that have a fixed side are highlighted with a yellow frame. 

Please refer to the Figure 291. 

 Containers that have a fixed position are highlighted with a red frame. 

Please refer to the Figure 292. 

 

Figure 290: Container with no Fixation – not Highlighted 

 

Figure 291: Container with a Fixed Side – Yellow Frame 

 

Figure 292: Container with a Fixed Position – Red Frame 

Placement of Containers by Mouse-Click 
If you place a container by mouse-click, the container is always assigned a 
fixed position on the material supply area. While doing so it is not important 
whether a container is repositioned by mouse-click on the same material 
supply area or on another material supply area. The container can be 
positioned directly by mouse-click between two containers, for example. 

Note 

When moving a container always remembers that the process assigned to the 
container is still executed on the same body point.  
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Figure 293: Positioning a Container by Mouse-Click on the Other Side 

Proceed as follows: 

1) Left-click on the container that you want to move. 

2) Drag the container with the mouse to the new position. Release the mouse 
button. The container is positioned and is always marked with a red frame. 
In the example the container has been positioned on the other side.  

3) Right-click the repositioned container once again; a checkmark is set next 
to the Fixed Position function to show the fixed position. 

4) If you disable the Fixed Position context function, the fixed position is 

disabled and the container is moved from the Automatic Line Balancing to 
the old place again. 

Context Functions for the Placement of Containers 
During the planning process of the material supply for a conveyor you should 
take the following aspects into consideration: 

 Parts that are used for multiple processes and have to be supplied to 
almost all stations of a conveyor. For these parts it is recommended not to 
fix the containers to a material supply area. When moving a process, only 
then do you have the guarantee that a container is also supplied for this 
process. 

 Parts that are only used for certain processes and only have to be supplied 
to these stations, as in the case of frequently changing product variants, for 
example. For these parts it is recommended to fix the containers to a 
material supply area. Only then are you able to control whether the 
container is to be replaced while moving the process and whether, for 
example, the walkways are still optimally specified for the employee when 

executing the process. Please refer to the Figure 295. 

Using the context functions you can determine whether a container is to be 
fixed to a side or only to one side of the conveyor. With the Switch to other 
Side function you can move the container to one of the two sides. Using the 
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Properties function you can view the properties of a container, but you cannot 

edit them. 

 

Figure 294: Open Container Contextual Menu 

Proceed as follows 

 

Figure 295: Overview Context Functions – Container 

 Opening contextual menu: Left-click on a container and then right-click to 

open the contextual menu. 

 Determining Fixed Side: Click Fixed Side. The container is fixed on this 

side of the material supply area. When moving the corresponding process, 
the fixation is taken into consideration and the user is asked whether he 

wants to maintain the fixation. 

 Determining Fixed Position: Click Fixed Position. The container is fixed 

on this side of the material supply area and is positioned exactly at this 
place. When moving the corresponding process, the fixation is taken into 
consideration and the user is asked whether he wants to maintain the 
fixation. 

 Switching to other Side: Click Switch to other Side. The container is 
positioned on the other corresponding side of the conveyor. The container 

is thereby fixed on this side of the material supply area. 

 Opening Properties: Click Properties. The container Properties dialog 

will be opened. The Properties dialog cannot be edited in this mode. 

 When moving a process you can decide whether a container with a fixed 
assignment to a material supply area should be repositioned. An existing 
fixed assignment for containers is disabled after moving. The containers 
are placed according to the process sequence at the new place on the 

material supply area. 
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Figure 296: Prompt when Moving a Process 

7.17.2 Changing Side for Containers using the Process 
Contextual Menu 

Using the contextual menu of an assigned process, containers can also be 
directly placed on the other side. As a rule only one of the two context 
functions is enabled: The case when containers are assigned to a process that 
has been placed on both sides of the station on the material supply area is 
considered an exception. 

 

Figure 297: Overview of Process Context Functions  

For containers that are fixed to a material supply area, the same criteria are to 
be considered as for the container contextual menu functions (Fixed Side, 
Fixed Position). Please refer to the Positioning Material Containers. 

For containers with a fixed assignment (Fixed Side/Fixed Position) you have to 
first confirm the change of sides of a container. Using the following prompt you 
can confirm whether a fixed container should really be moved to the other side. 

 

Figure 298: Prompt – Move Fixed Container to the other Side 

Proceed as follows 

Containers that have been placed to another side using this function are then 
fixed to this side. A fixed position occupied beforehand is deactivated.  

If you additionally want to assign a fixed position to the container, use the 
mouse to position the container at this specific place after the change.  

If the container should remain in a fixed position at the same place after the 
change, use the contextual menu to position the container. 
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Figure 299: Open Process Contextual Menu 

1) Left-click  the process to open the contextual menu and then right-click. 

2) Click one of the two possible entries. Please refer to the Figure 299. 

7.17.3 Editing MultiCycles 

The calculated balancing process will only include MultiCycles, however, if the 
average default time of one or several processes exceeds the difference 
between takt time and way time. 

You can generate MultiCycles manually by moving processes using Drag and 
Drop until the sum of default times and all idle times exceeds the takt time. 

 

Figure 300: Display of a MultiCycle 

MultiCycle Options 

 

Figure 301: MultiCycle Options 

 MultiCycles can only be generated with an unassigned successor station. 

 MultiCycles will automatically be generated by the program if the Manage 
Unassigned Stations function is enabled in the Extras/Options menu. This 

means that if a succeeding station is assigned in Automatic Line 
Balancing, the program will automatically generate an unassigned station. 

 If the Manage Unassigned Stations Automatically function is not 
enabled, MultiCycles can only be generated if succeeding workplaces are 

not assigned and the station type (automatic/manual) is suitable. 
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 You can quickly solve this problem, however, by manually inserting an 

extra unassigned station. 

Suppressing MultiCycles, Restoring MultiCycles 
Using these two context functions, you can suppress and restore a MultiCycle. 
Please refer to the Figure 273. 

 

Figure 302: Display of Suppressed MultiCycle 

7.17.4 Adding or Deleting a Station 

When a station is deleted or added somewhere in the line, ALB checks for the 
locked areas in succeeding stations. If there are locked areas in succeeding 
stations then a confirmation message appears. The confirmation message 
does not appear: 

 if a station is added or deleted at the end; and also when there are no 
locked areas in the current or succeeding stations. 

 on Recalculating the balancing 

1) Go to Tools > Options > Settings and un-select the Manage unassigned 
Stations automatically check box. 

2) Right-click a station and select Insert Station or Delete Station. 

The following message apperas in case of locked areas. 

 

Figure 303: Add or Delete a Station 

By default, No is selected. 

3) Select Yes to add or delete a station. 

7.17.5 Displaying Maximum Car Time in Balancing List and 
Process List 

The Max Car is the maximum car working time appearing in one workplace. 
The Max Car can be a different calculation model in different workplaces. 
Earlier the Max Car time is displayed in the Balancing List and Workplace View 
under the Max Process Time column. Starting from R21, the Balancing List 
View and Workplace View are enhanced to display the Sum Max Car 
Process Time in Max Car column. The Process List View is also enhanced 
to diaplay Sum Max Car Process Time in the status bar. The Sum Max Car 
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Process Time is updated on selecting and un-selecting the Max. Car check 

box for a process. 

The Sum Max Car Process time field in the status bar of the Process List 
View displays the corresponding sum value of all the maximum car process. 

 

Figure 304: Sum Max Car Process time field in the status bar of the Process List 

View 

 

Figure 305: Max Car Column in Balancing List View 

The Sum of Max Car Process time is displayed under the column Max Car in 
the Workplace View. 

 

Figure 306: Max Car Column in Workplace List View 

Behavior of Max Car with the Alternative Processes 

The alternative processes are used to get the maximum un-weighted time 
between the alternative processes which are set with the Max Car flag and are 

balanced in the same workplace. 

In the process graph shown below, there are three processes and each of 
them has two alternative processes. 
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Figure 307: Behavior of Max Car with the Alternative Processes 

 Op 1 has Op 1 Alternative 1 and Op 1 Alternative 2 as alternative 
processes. 

 Op 2 has Op 2 Alternative 1 and Op 2 Alternative 2 as alternative 
processes. 

 Op 3 has Op 3 Alternative 1 and Op 3 Alternative 2 as alternative 
processes. 

All the Processes are set with Max Car flag. 

Case 1: Open a balancing and Op 1, Op 2, and Op 3 are balanced. The 
remaining alternative processes are un-balanced. 

The regular processes are balanced and the alternative processes are 
unbalanced, the process time of regular processes is taken for the Max Car 
Sum Calculation. 

Case 2: Op 1, Op 2, Op 3, Op 1 Alternative 1 and Op 1 Alternative 2 are 
balanced. Op 1, Op 1 Alternative 1, and Op 1 Alternative 2 are balanced in the 
same workplace. The remaining processes are un-balanced. 

The alternative processes are balanced in the same workplace; the maximum 
time of these alternative processes is taken for the Max Car Sum Calculation. 

Case 3: Op 1, Op 2, Op 3, Op 1 Alternative 1 and Op 1 Alternative 2 are 
balanced. Op 1, Op 1 Alternative 1 and Op 1 Alternative 2 are balanced in the 
different workplace. The remaining processes are un-balanced. 

All the alternative processes are balanced across the different workplaces, the 
process times of all processes is taken for the Max Car Sum Calculation. 

Case 4: All the processes are balanced and the alternative processes are 
balanced in the same workplace 

The alternative processes are balanced in the same workplace; the maximum 
value of these alternative processes in the same workplace is taken for the 
Max Car Sum Calculation. 

Case 5: All the processes are balanced and the alternative processes are 
balanced across different workplace. 

The alternative processes are balanced in the different workplaces; the 
maximum process time could not be taken for sum. The process time of all the 
alternative processes is taken for the Max Car Sum Calculation in the 
Process List View. 

The alternative processes are present in the different workplaces; the process 
time of all the processes in the workplace is taken for the Max Car Sum 
Calculation in the Balancing List View. 
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The alternative processes are not present in the same workplace. The process 
time of all processes in the workplace is taken for the Max Car Sum 
Calculation in the Workplace List View.  
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8. Advanced Features of Automatic Line 
Balancing 

The result of Automatic line balancing is saved in the database. The database 
thus incorporates a function for provision of data. V5 and E5 applications may 

access the data saved in the database and process further the results of 
Automatic line balancing. 

8.1 Planning Resource-Related Processes 

TSA processes are resource-related processes. In V5 only processes of this 
type can be displayed and used for resources. 

What is the purpose of TSA processes? 

During Automatic line balancing, the stations and workplaces for processes 
are found on the basis of a process plan (precedence graph). In V5 the results 
found can be represented by means of Behavior processes and TSA 
processes. TSA processes created by the Automatic line balancing are copies 
of actual processes which are automatically generated during balancing. 
Behavior processes are needed in V5 for representation of TSA processes for 
resources with workplaces. 

ALB is a workflow-based balancing module: stations and workplaces are found 
on the basis of a process plan (precedence graph), which is set up in E5. The 
process plan thus determines the planning of processes. 

To guarantee the consistency of the balancing results, changes in the process 
data of processes belonging to a process plan that has been used for 
balancing can only be made in E5. Such changes only are considered for 
balancing. 

Note 

If you change the TSA data, such as times, in V5, the changed data will not be 
considered in the Automatic line balancing. Such changes are irreversibly lost 
in the next Automatic line balancing for the process plan. 

Initial Situation: Process Plan with Processes 
The basis for Automatic line balancing is the processes of a process plan; the 
stations and workplaces for it are found. 

Note 

TSA processes are copies of the actual processes; they are created during 
Automatic line balancing to allow display of these processes in V5 for the 
resources (stations) with workplaces found. ALB links these TSAs to 
behaviors, according to the BiW data model. 
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Figure 308: Process Plan with Processes 

Automatic Line Balancing Result Displayed in E5 PPR Navigator: 
The respective workplaces and stations for line 007, as shown in the tree 
structure in the PPR Navigator, have been created in this example. The TSA 
processes are displayed at the individual workplaces in the tree structure, 
under the Behavior processes (New DNBBehavior), such as the TSA 
processes Proc 19, Proc 2, and Proc 20 for Workplace 2, right. 

Processes are performed by machines and workers. ALB determines the 
required number of workers and assigns these workers to the workplaces of 
the stations. The workers found are linked to the workplace and all TSA 
processes of this workplace, as is evident from the tree structure here shown. 
Workers are found only for workplaces to which processes have been 
assigned. 

In PPR Navigator, the result of the Automatic line balancing is shown with the 
Behavior processes and the TSA processes. 

 

Figure 309: Result of Automatic Line Balancing in PPR Navigator 

Results of Automatic Line Balancing in V5 are Displayed in the 

PPR Tree 
As in the PPR Navigator, after opening of the project in V5, you can display the 
results in the PPR tree. The structure corresponds to the tree structure in PPR 
Navigator. 
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The result of Automatic line balancing for Line 007 is displayed in the PPR 

tree in V5: 

 

Figure 310: Displaying the Result of Automatic Line Balancing in V5 

Note 

If you change the position of load carriers in the layout of the V5 application, 
such changes are considered during Automatic line balancing. 

8.1.1 Supplying Data for Provision of Part Bins 

Suppose, for instance, that you want to know which parts are in part bins at 
which workplace. To get this information, ALB creates a logical part bin. 
Logical part bins are placeholders used to get data concerning part bin usage. 

With the aid of logical part bins data concerning part bin usage is saved during 
Automatic line balancing and can then be displayed in E5 and V5 in the 

properties dialog of the logical part bin. 

Having created a Balancing in ALB, the stations, workplaces and material 
areas with part bins and logical part bins are shown in the PPR Navigator.  

The figure shows a Balancing created in ALB including stations, workplaces 
and material areas. As is seen in the picture, the logical part bins and the load 
carriers (e. g. a palette) are linked to the tree structure of the material area by 
means of a parent child relation. 
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Figure 311: Tree Structure of a Work Load Balancing in the PPR Navigator 

Load carriers as well as part bins are linked to the material area by means of a 
logical part bin. Logical part bin contains textual information about the part that 
is hold in the part bin and the processes that are using this part bin. 

The following R18 Data model shows the relationships Station < Workplace < 
Material Area < Shelf < Logical part bin < Part bin. 

 

Figure 312: R18 Data Model, Section Station – Part Bin 

8.1.2 Showing Part Bins in V5 DPM 

ALB link the part bins under the material area objects of a station and to the 
shelves. by a parent child relation. This helps to show the layout of the line 
correctly in Process Engineer and in V5 DPM. 

Part bins are linked as children to the material area and to the shelves. The 
layout of the line is displayed correctly in V5 DPM 
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Figure 313: Data Model with Parent Child Relations between Material 
Area/Shelves and Part Bins 

Displaying Part Bin Usage in E5 and V5 
In E5 as well as in V5, part bin usage is displayed by means of the properties 

dialog of the logical part bin. 

The data for part bin usage must be determined beforehand in the ALB 
configuration. In the present example, the usage data is displayed under the 
part bin usage tab. 

For more information on configuration of the part bin usage data please refer 
to the Administration Manual. 

In addition to the usage data shown in the present example, you may configure 
further attributes: 

 For example, the list of part bin identification numbers 

Displaying Data 
The Part Name and Part Number fields display the name and the number of 
the part that is provided in this part bin. In the List of Processes field, all 
processes are displayed which are linked to this part and the part bin.  

1) To display the part bin usage data, open the contextual menu on the 
logical part bin. 

2) Select the respective tab; in the present example it is “Part Bin Usage” in 
the properties dialog. 

3) The usage data is displayed depending on the attributes configured.  

 

Figure 314: Displaying Part bin Usage Data 

file:///C:/Documents%20and%20Settings/OUM/Application%20Data/Microsoft/Word/Administration.pdf
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8.1.3 Free Placement of Part Bins 

Now, ALB supports placing of part bins in several rows and you can do the 
following: 

1) Place Part Bins in second and subsequent rows or outside corner 

2) Rearrange Part Bins of a material when too many changes are done. 

3) Mark in consistent material areas for clear reporting 

4) Snap of Part bins for easy placement 

Place Part Bins in Outside Corner or Second Row 
You can place the part bins in outside corner or second and subsequent rows 
when opening a new or old balancing, when moving processes within and 
across stations, and when moving part bins within and across stations and it 
does not destroy the previous planning. Shelves can be placed similarly. There 
is one outside corner for every material area which mean a total of two outside 
corners for every station. This holds all the un-positioned part bins and 
shelves. 

Note 

Outside corner containers (as are seen in APB 2D view) will be visible in DPE 
3D graphic view outside the station coordinates just like they are visible in ALB 
2D view. Containers which are in different pages in outside corner inside ALB 
will appear overlapping in graphic view. Changing positions of such containers 
inside graphic view will not be entertained on subsequent ALB load. ALB will 
still keep the old positions and would continue to show them in outside corner.  

The following settings in Parameter for Automatic Balancing (Figure 22) 

dialog to enable to place the part bins in outside corner or second or more 
rows. The following settings are applicable for a line i.e. each line can have 
different values for these options. 

 Free Placement of Part Bins: Select this checkbox to enable free 

placement of part bins. By default this is unchecked. 

If a saved balancing with new material planning is opened and if this option is 
unchecked, the new planning done in all the material areas will be destroyed 
and material planning according to old approach will take place. 

 No. of Rows per Material Area 

You can mention number of rows in this field. The least would be one row. ALB 
can create as many rows as possible but if no more space is available in the 
container area then it will place them in outside corner. 

 Walkway between Rows 

You can enters the desired space here between any of the two rows. 

Note 

If setting for No. of Rows per Material Area and Walkway between Rows is 
changed for an existing balancing, the planning in all the material areas will not 
be destroyed. These settings will be used when you manually start the 
rearrangement of material area using command Rearrange Material Area or 
does an automatic balancing using Recalculate. 

 Snap part bins when at distance [m] 
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A container say A when dragged close to another container say B, such that 
the distance between them is below the mentioned distance in this setting, 
then the container A will be snapped to container B. 

 Mark Inconsistent Material Area 

Select this checkbox to mark the inconsistent material areas of the balancing 
with selected color. 

Figure 315 shows the part bins when you select mode Subsequent rows and 

opens a new balancing and chooses automatic balancing algorithm. 

Let the selected rows be 2. So there will be two rows maximum per container 
area. 

While Automatic balancing runs (opening a new balancing), if there is no 
space in the first row after part bin 3 in the right side material area, the part 
bins are placed in second row in this case. After second row is exhausted and 
since the settings had only two rows specified, there will be no more rows 
whether or not there is availability of space in container area and the rest of 
the part bins will be placed in outside corner.  

Outside Corner holds excess part bin groups of a container areas of a station 
and every container area will have one of its own as shown above. This 
scenario only show the excess part bins from the right container area. So 
basically a particular outside corner holds un-positioned part bins of this 
container area. 

When No. of rows per material area selected is 1, there would be no second 

or more rows and all the subsequent part bin groups which cannot be placed in 
the first row will be directly placed in outside corner as shown in Figure 316. 

 

Figure 315: Part Bins with Subsequent row s mode 

When No. of rows per material area selected is 2, the part bins will be placed 

in first row and then in second row if second row is possible and those which 
cannot be accommodated in both rows will go to outside corner. 
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Figure 316: Part Bins in Outside Corner 

The above figures, display part bins only in outside corner of right side 
container area. Similarly there is outside corner for left side container area.  

Outside Corner 
This is a mere place holder to keep un-positioned part bins of a material area. 

The width and length of outside corner on the screen will not exceed width and 
length of material area and will be same as that of material area. 

There will be direction arrows in the outside corner when all the part bins or 
shelves cannot be shown in the outside corner due to space constraint. 

Twelve part bins are to be shown in the outside corner but the space is only for 
the first 9 as shown: 

 

Figure 317: Direction Arrows in the Outside Corner 

There will be one right side arrow in outside corner to see the ones that are not 
visible. When clicked the result is like this: there will be a left side arrow to go 
to see the previous part bins. 

 

Figure 318: Right Side Arrow in Outside Corner 
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The arrows in the outside corner serve the purpose of showing the part bins or 
shelves which cannot be accommodated all at the same time and are not 
visible. When clicked on arrows the part bins and shelves which are not shown 
will be shown in respective directions. 

If a part bin or a shelf is removed from outside corner, then remaining right 
side part bins or shelves will automatically be shifted left thus filling its space. 

Drag and drop functionality willl not work as was working in container area. 
When a container is dragged and dropped from one location to outside corner , 
then the container is placed in the last. 

Position in outside corner and all the part bins will be shifted to fill the empty 
space. Outside corner will have the same depth and width as that of its 
material area and there is no user interface to change the length and width of 
outside corner. 

Outside cornert will be created with the same width and length of its container 
area and shall only hold the excess containers. On close of balancing, all 
outside corners will be destroyed and on reopening will be again created to 
hold the containers. 

Changes in Contextual menu’s: 

 Part bin Contextual Menu: The options Fixed Side, Fixed Position, and 
Switch to other side are removed in the event of free placement of part 

bins (Figure 154). 

 Shelf Contextual Menu: The options Fixed Side, Fixed Position, and 
Switch to other side are removed in the event of free placement of part 

bins (Figure 155). 

Note 

There will be no red border any more for a displaced part bins as there is free 
placement and there is no Fixed position. 

Placing of part bins in outside corner takes into account the following 
scenarios: 

Moving a process from one workplace to another (within a station)  
If the process is moved to a workplace that uses the same material area, the 
associated part bin groups will not be updated. 

For destination material area: If the process is moved to a workplace that 

uses another material area belonging to the same station, then the part bins 
will be placed in the outside corner of destination material area. 

Regarding Shelf‟s creation or usage in outside corner in this moving process, 
depending upon the Manage Shelves Automatically settings (Right click on 
Project in DPE >Extra > Balancing ALB Configuration > General Settings >  
Balancing > Manage Shelves Automatically), there will be two different 

behaviors: 

 If Manage Shelves Automatically is unchecked, the part bins will not be 

moved into any shelf automatically nor will there be a new shelf created 
automatically. 

 If Manage Shelves Automatically is checked, a fitting new shelf will be 
created in outside corner of destination material area or an existing shelf in 
the outside corner of destination material area will be used and the part 

bins will be placed inside automatically. 
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For source material area:If the part bins are moved from material area, then 

empty space will get created and there will be no automatic adjustments of 
part bins. If part bins are removed from the outside corner, then the remaining 
part bins will automatically adjust themselves thus filling the space left by the 
moved part bins. 

Regarding Shelf‟s deletion or usage in this moving process, depending upon 
the settings Manage Shelves Automatically there will be two different 

behaviours: 

 If Manage Shelves Automatically is checked, the empty shelves will be 

deleted automatically from the material area. 

 If Manage Shelves Automatically is unchecked, then all existing shelves 

will remain in material area or outside corner and will not be removed 

automatically even if it is empty. 

Moving a process from one station to another 
If a process is moved from a station to another station then following effects 
take place: 

For destination station: The part bins will be placed in the outside corner of 

destination material area. 

For source station: The related part bins will follow the process and will be 
removed from the source station material area or outside corner. There will be 
no other action in the material area. After this part bins be moved, there will be 
a gap at their location and no other part bin/shelf will be adjusted 
automatically. If the part bins are moved from outside corner then the 
remaining part bins will automatically shift to left thus filling the space of the 
moved part bins. 

Regarding Shelf‟s creation or usage in outside corner in this moving process, 
depending upon the settings Manage Shelves Automatically there will be two 

different behaviors for source/destination stationsas similar to Moving a 
process from one workplace to another. 

Moving a part bin group inside a material area, at a valid position without 
collision 

When a part bin is moved in same material area at a valid position, it will be 
placed inside at the target position if it is not colliding with other part bins or 
shelves or locked areas. There will be an empty space created at its original 
location. There will be no automatic adjustment or re-arrangement of other part 
bins. 

Moving a part bin group inside a material area, colliding with another part 
bin group or shelf or locked area 

When a part bin is moved in same material area at a position where it collides 
with other part bin groups (PBGs) or shelf or locked area, it pops back to its 
original position. 

Moving a part bin group to another material area, at a valid position in 
same/another station 

When a part bin is moved in another material area of the same station, it will 
be placed at the target position if it is not colliding with other part bins and 
shelves of that material area. 

There will be an empty space created at its original location. There will be no 
automatic adjustment or re-arrangement of other part bins in both source 
material area and target material area. 
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Moving a part bin group to another material area, colliding with another 
part bin in same station/another station 

When a part bin is moved in another material area of the same station at a 
position where it collides with other part bins, it pops into the OC of the target 
material area. 

Moving a part bin group in a shelf inside same/another material area 

If a part bin is moved inside a shelf in the same material area, it will be placed 
inside it if enough space is available in shelf to accommodate it. There will 
again be an empty space created at its previous location and there will be no 
automatic adjustment or re-arrangement of remaining part bins. 

If there is not enough room for it in shelf, then it will pop into the OC of target 
material area. 

Adding a product variant to a balancing 

When a product variant is added to an existing balancing and the algorithm is 
chosen, then, the algorithm balances all the processes that already exist in 
balanced product variant. All the new part bins associated with newly added 
product variant will get automatically placed in the outside corner so as not to 
destroy any already planned material area. 

Regarding shelves creation or usage in outside corner, there will be two 
behaviours: 

 If Manage Shelves Automatically is not set, the part bins will not be 

moved into any shelf automatically nor will there be a new shelf created 

automatically. 

 If Manage Shelves Automatically is set, a fitting new shelf will be created 

or an existing shelf will be used and the part bins will be placed inside 

automatically. 

When you use filter to display the variants, part bins which are seen material 
area are filtered. When second variant is added, the part bins will be placed in 
outside corner. If you use filter option before planning these part bins, the 
material area will be shown as empty. 

Loading of Balancing where part bins are added outside of ALB 

When an existing balancing is loaded and one of the balanced processes has 
got a new part or an existing part has got a new part bin, a new part bin will be 
created by ALB and it will be positioned in outside corner of the particular 
material area belonging to process. 

Regarding shelves creation or usage in outside corner, there will be two 
behaviors: 

 If Manage Shelves Automatically is not set, the part bins will not be 

moved into any shelf automatically nor will there be a new shelf created 

automatically. 

 If Manage Shelves Automatically is set, a fitting new shelf will be created 

or an existing shelf will be used and the part bins will be placed inside 

automatically. 

Loading of Balancing where part bins are removed outside of ALB 

When an existing balancing is loaded and one of the balanced processes has 
its associated part-bin group removed, ALB will remove this part bin from 
balancing (from material area or outside corner). If it is removed from material 
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area, there will be an empty space for its position and there will be no 
automatic adjustments or re-arrangement of other part bins. If it is removed 
from outside corner, other part bins will be realigned and re-arranged by ALB 
and there will be no empty spaces. 

Regarding Shelf‟s deletion or usage in outside corner, there will be two 
different behaviours  

 If Manage Shelves Automatically is set, the empty shelves will be deleted 

automatically from the material area. 

 If Manage Shelves Automatically is not set, then all existing shelves will 

remain in material area and will not be removed automatically even if it is 

empty. 

Recalculate of Balancing 

On Recalculate, the base data dialog will pop up subsequently and according 

to the options selected the whole balancing will be automatically balanced by 
ALB. All the previous planning will be lost. All the material areas will be reset 
and re-arranged or re-calculated according to the selected options including 
the outside corners. 

If Free placement of part bins option (Figure 22) is selected then the material 

areas will depict multiple rows planning with outside corner.  

If Free placement of part bins is not selected then old planning will run and 

there will be no multiple rows planning and outside corner. 

Behavior of part bins with Merging 

Different Logistic modes now consider only the container area for material 
planning. With this new enhancement, the logistics mode will continue to run in 
the same way as was running before and the duplicate part bins will be 
merged and shown in the same way.  

The part bins which are assigned to outside corner belong to its corresponding 
container area. The only information missing is the positioning of part bins 
placed in outside corner. For merging of part bins, ALB will see container area 
and outside corner as one entity and all the part bins belonging to either of 
them will be considered as belonging to only container area. Therefore, the 
merge shall take place in outside corner too as if part bins were standing in 
container area.  

There is one change in the behaviour. Previously if a part bin A1 was moved in 
a container area having same part bin A2, one would get invisible (A2) while 
the other will still be shown (A1) depending on a particular merging mode. If 
again this duplicate part bin (A1) is removed from the container area, the 
invisible part bin (A2) gets visible again at the same place where it was before. 
Now with the new enhancement, the part bin A2 would be visible but will be 
moved to outside corner of that container area. 

Save problem in ALB when part bin name includes more than 1000 
characters 

When the balancing is saved in ALB, the information about the parts which are 
merged is saved on the attributes of logical part bins as given below. 

attribute_20 – Names of Merged Parts 

attribute_21 – Part Number of all merged parts  

attribute_22 – Names of Related Processes 
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attribute_23 – IDs of TSAs of Related Processes 

attribute_24 – IDs of all Parts Merged 

attribute_25 – ID of Part Bin 

If the number of part bins which are merged is more, then some strings may 
exceed 1000 characters. 

In this case, you would get the following error message when you try  to save 
the balancing in ALB. 

 

Figure 319: Error Message when String exceeds 1000 Characters 

When you get this error message, please contact IT Oracle DB Administrator 
and request them to increase the Oracle attribute value size to be greater than 
1000 (maximum possible value is 4000). 

The Oracle DB Administrator might need to contact DELMIA Support to obtain 
the right procedure to make the change in setting. 

Considerations regarding Persistency 

Part bins in outside corner will be saved just like part bins in material area and 
there will be no difference apart from their different positioning. One possible 
option for this position might be 0/0/0. 

Removing part bins from Shelf 

When a part bin is removed from a shelf, it will go directly to the outside corner 
of the shelf‟s container area. In this process, if the shelf becomes empty, then 
according to the option Manage Shelves Automatically, the shelf will be 
removed or will be allowed to stay. 

Creating Locked Areas in material area 

The locked areas can only be created at the user defined place if there are no 
containers present there. In a planned material area, if the space is available 
then only the locked area will be created otherwise it will not be created which 
will be followed by a message box saying that it is not possible to create. 
There will be no automatic adjustments of positions of containers while 
creating locked area. 

“Move Containers of the processes to left /right side” contextual menu of 
process 
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On selecting this option in the contextual menu of a process, all the part bins 
and shelves belonging to the process will move to the outside corner of 
destination container area. 

For the source container area, if the containers are moved from container 
area, there will be empty space and no automatic adjustments of remaining 
containers whereas if containers are moved from outside corner, the remaining 
containers will be adjusted automatically by ALB. 

For destination material area, the moved containers will move to outside 
corner. 

Deleting a station 

Deleting of a station require the outside corners belonging to its container 
areas to be empty. 

There should be no element in the outside corner now for delete of station to 
work. 

Part bins and Shelves” in contextual menu of Container area 

Selecting this option pops up a dialog with listing of all the part bins and 
shelves for the container area.  

It will continue to show the information of part bins and shelves from container 
area. Button Outside Corner Information in the dialog to show information of 

part bins and shelves from outside corner of that particular container area. 

 

Figure 320: Listing of all the Part Bins and Shelves for the Container Area  

Clicking button Outside Corner Information change the button text to 
Container area Information. 

Now clicking again will display the part bins and shelves information of 
container area. The same button works for showing information for both 
container area and its outside corner. 

The button Outside Corner Information appear disabled when there will be 

no containers in outside corner. 

Change side of material supply to the right / left ” in contextual menu of 
workplace 

In the contextual menu of workplace, if “change side of material supply to right 
/ left” option is selected, then all the part bins and shelves from the source 
container area and its outside corner associated to processes of the selected 
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workplace  will be shifted to the outside corner of target container area. There 
will be no changes in target container area. 

Cross highlighting of part bins and process 

Cross highlighting will work as was before but with one exception: 

Those part bins or shelves which are present in outside corner but are not 
shown due to space constraint will not be highlighted since they are not visible 
in outside corner for the moment. The part bins or shelf has to be visible either 
in container area or outside corner to be highlighted.  

Opening a new balancing with the new settings 

When opening a new balancing and choosing automatic algorithm with new 
advanced settings for free placement of part bins, ALB will start placing the 
part bins and shelves in the material area. Following are the different 
behaviours: 

 If there is a shelf library selected, then ALB will start placing the shelves in 
material area. If a shelf is too big to be accommodated in the first or 
subsequent rows in material area, then it will be placed in outside corner 

and the planning will continue to place others. 

 If a part bin is too large to fit into the first or subsequent rows in a material 
area, then ALB will place it in the outside corner and continue placing 

others. 

“In new shelf” contextual menu of a part bin 

Following are the behaviours of selecting this option for a part bin in outside 
corner and material area: 

 If part bin is in material area, then selecting this option will create a 
selected shelf in outside corner of this material area and part bin will be 
moved inside this. This will create a empty space in the material area. 
There will be no automatic adjustments of any of the remaining containers 

in material area. 

 If part bin is in outside corner, then the shelf will be created in the outside 
corner there itself at the location of part bin and the part bin will be placed 
inside it. Rest of the containers will be pushed to make space for this new 

shelf. 

Logistic” Part bin group behaviour 

Following are the behaviours possible with Logistic part bin groups:  

 If a planned balancing without logistic part bin groups is reopened with the 
logistic part bin group settings, all the logistic part bin groups will be placed 

in the outside corner so as not to destroy the planning of other part bins. 

 If in a balancing with “Logistic” part bin groups, when only the settings for a 
Logistic part bin is changed, this part bin group will be moved to outside 

corner. No other part bins will be automatically shifted. 

 If a planned balancing is reopened removing the logistic part bin group 
settings, all these logistic part bin groups will be moved to the outside 

corner. No other part bins will be automatically shifted. 

Assembly 1/2 Part bin group behaviour/ Fixed Surface” Part bin group 
behaviour 
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Following are the behaviours possible with “Assembly 1” part bin groups: 

 When a part bin is configured as “Assembly 1” part bin, then this part bin 
group is placed in the outside corner after the changes whether or not it 
takes more space or less space. There will be no automatic adjustments 

for rest of the containers in material area. 

 When only settings are changed of an existing “Assembly 1” part bin 
group, this part bin group will move to outside corner whether or not it 
takes more space or less space. There will be no automatic adjustments 

for rest of the containers in material area. 

Change Length and width of material area 

The planning in all the material areas will be destroyed and again automatic 
planning will take place according to the settings readjusting and realigning all 
the part bins if the material area is reduced. If it is enlarged, the planning will 
not be destroyed. 

Rotate Part Bins by 90 degrees 

When you selects the option Rotate Part Bins by 90 degrees, the planning in 
all the material areas will be destroyed and again automatic planning will take 
place according to the settings readjusting and realigning all the part bins if all 
the part bins are rotated by 90 degrees. If an individual part bin is rotated by 90 
degree, it will be straight away moved to outside corner and it is your 
responsibility to place it in desired position. If you wants to go to previous 
state, use UNDO. 

Re-arranging Material Area 
Material area for the whole line can be Re-arranged from menu Balancing > 
Re-arrange Material Area. 

 

Figure 321: Re-arrange Material Area 

The Left Side option re-arranges all the part bins and shelves in left side 
material areas of all the stations i.e. all the left side material areas of a 
Balancing. Right Side option re-arranges all the part bins and shelves in the 
right side material areas of all the stations. 

This function executes an automatic execution of re-location of all the Part bins 
and shelves inside material area and all the planning inside material area will 
be lost. All the empty spaces in material areas will be adjusted. All the planned 
part bin positions will be lost and all the part bins will be placed according to 
Automatic algorithm. ALB places the PBGs station by station, material area by 
material area, and then one by one rearranges them meaning that PBGs 
remain in their material area. All the available part bins and shelves within a 
material area are arranged according to settings and if more free space is 
available, part bins and shelves from its outside corner are considered for 
placement. 

Part bins from outside corner will also be taken into account and will be placed 
inside material area if place is found. 

An individual material area can be re-arranged in a similar way by selecting 
Re-Arrange Material contextual menu option of material area. 
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Snap Part Bins 
Snap functionality will make placement of part bins more comfortable and you 
have full control over its availability.  

Snap can be enabled and disabled for the whole balancing by checking and 
un-checking this check box. 

Snap for the whole balancing an also be switched on and off from an individual 
container area via its contextual menu:  

 

Figure 322: Snap Part Bins 

Snap works only for container areas and not for outside corner. 

Consider the below scenario: 

When moving a part bin, snap functionality will look for other part bins near 
one of the 4 corners of the moved element and the moved element will be 
positioned at the exact location - point to point. The moved element should be 
within the distance mentioned in the snap distance mentioned in base data.  

Part bin 3 from right side container area is moved to left side container area 
and is dropped near to part bin 2 in left side container area. Let the distance 
between the 2 parts bins be 0.05 m as can be seen in the below figure. The 
snap distance mentioned in the base data is 0.06 m.  

 

Figure 323: Before/After Snap 

Since the distance is well within the mentioned snap distance, the part bin 3 
will be automatically snapped to the side position of part bin 2 and the user can 
easily align up and down the part bin 3 without leaving the mouse. Snap shall 
work in all 4 directions. 

Toggle for snap 

The snap functionality can be toggled while dragging. When dragging a 
container, the simultaneous press of “SHIFT” button will toggle the snap 
functionality for this particular moment. So if snap is on in advanced planning 
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options, then for this drag operation with the “SHIFT” button pressed,  the snap 
will be turned off. The moment the “SHIFT” button is released while on drag, 
the snap behaviour will turn on. So snap can be turned ON and OFF at the 
time of drag also. You can use this functionality to snap only in a target area 
and to avoid snaps at all positions. 

Toggling will work only when the Snap functionality is on in advanced material 
planning. It can only be used to turn off the snap for a particular moment of 
drag. 

Marking Inconsistent Material Areas 
Inconsistent material areas are areas where there are part bins without 
location i.e. the particular outside corner of that material area is not empty.  

These material areas can be marked with different color code than normal one 
and this can be done from base data dialog. 

When you check the option Mark Inconsistent Material Area, a default 
orange color is set in color box. If again a different color selection has to be 
made, the color dialog can be launched by clicking the color box (Figure 22). 

The color of inconsistent material area will change according to the availability 
of part bins in its outside corner.  

In the image below OC of Station 1 has some part bins and hence its material 
area is colored orange. (In this case user has selected Orange as color to 
mark inconsistent material areas.) Material areas whose OCs are empty are 
colored green the default color of material area. 

 

Figure 324: Marking Inconsistent Material Area 

The default color available would be orange with this setting. 
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